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Kata Pengantar 
 
Kurikulum 2013 dirancang untuk memperkuat kompetensi peserta didik dari sisi 
pengetahuan, keterampilan, dan sikap secara utuh. Keutuhan tersebut menjadi 
dasar dalam perumusan kompetensi dasar tiap mata pelajaran, sehingga 
kompetensi dasar tiap mata pelajaran mencakup kompetensi dasar kelompok 
sikap, kompetensi dasar kelompok pengetahuan, dan kompetensi dasar kelompok 
keterampilan. Semua mata pelajaran dirancang mengikuti rumusan tersebut. 

Pembelajaran Dasar-dasar Perbankan untuk Kelas X jenjang SMK Program 
Keahlian Keuangan yang disajikan dalam buku ini juga tunduk pada ketentuan 
tersebut. Dasar-dasar Perbankan bukan berisi materi pembelajaran yang 
dirancang hanya untuk mengasah kompetensi pengetahuan peserta didik. Dasar-
dasar Perbankan adalah mata pelajaran yang membekali peserta didik dengan 
pengetahuan tentang dunia perbankan di Indonesia, keterampilan dalam 
menyajikan pengetahuan yang dikuasainya secara konkret dan abstrak, serta 
dunia perbankan sebagai usaha berdasarkan kepercayaan masyarakat menuntut 
sikap hemat, cermat, disiplin dan jujur. Sehingga dengan belajar dasar-dasar 
perbankan diharapkan terbentuk pola pikir peserta didik yang hemat, cermat, 
disiplin dan jujur. 
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Glosarium 
 
 

Akun (account) Disebut juga rekening atau perkiraan adalah 
formulir untuk mencatat secara indivual tentang 
penambahan atau pengurangan tiap jenis harta, 
kewajiban, dan ekuitas. 

Account  
Receivable (Trade 
Debtor) 

Piutang Dagang, yaitu tagihan kepada para 
pelanggan karena adanya trasaksi penjualan 

Account Payable 
(Trade Creditor) 

Utang Dagang, yaitu kewajiban perusahaan yang 
harus dibayar perusahaan karena danya transaksi 
pembelian. 

Akuntansi Suatu proses yang meliputi kegiatan 
pengidentifikasian, pencatatan, pengikhtisaran dan 
pelaporan data keuangan. 

Aplikasi Komputer 
Akuntansi 

Program terintegrasi yang disusun untuk penerapan 
sistem komputerisasi di bidang akuntansi. 

Asset Aset atau Aktiva, yaitu seluruh kekayaan yang 
dimiliki oleh perusahaan 

Bagan akun (chart 
of account) 

Daftar akun dan nomor kodenya yang 
mengidentifikasi tempatnya dalam buku besar. 

Balance Sheet Neraca, yaitu merupakan salah satu laporan 
keuangan yang memberikan informasi mengenai 
aset, kewajiban dan ekuitas. 

Building Gedung (Bangunan), yaitu salah satu aset tetap 
yang dimiliki oleh perusahaan. 

Buku besar 
(ledger) 

Buku yang berisi akun-akun harta, kewajiban, dan 
ekuitas atau kumpulan dari kartu-kartu akun. 

Cash Flow 
Statement 

Laporan Arus Kas, yaitu salah satu laporan 
keuangan yang memberikan informasi tentang 
aliran kas masuk dan kas keluar dari kegiatan 
operasi, investasi dan pendanaan. 

Cash on Hand Jumlah kas yang dimiliki oleh perusahaan.  

Card File File Kartu, yaitu kartu untuk mencatat informasi 
setiap pelanggan dan pemasok (Customers and 
Suppliers) 

Cheque Book Buku Cek, kumpulan cek yang siap untuk diisi dan 
digunakan untuk pembayaran. 

Current Asset Aktiva Lancar, yaitu kelompok aset yang 
perputarannya dalam jangka pendek (kurang dari 
satu tahun). 
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Current Liabilities Kewajiban Lancar (Utang Lancar), yaitu salah satu 
bentuk kewajiban yang harus dituaikan dalam waktu 
satu tahun atau kurang. 

Command Centre 
Account 

Pusat kendali pada MYOB yang berfungsi untuk 
pembuatan daftar akun,  pencatatan saldo awal 
buku besar, pembuatan jurnal umum, posting dan 
laporan keuangan. 

Command Centre 
Banking 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat penerimaan uang yang bukan bersumber 
dari pelunasan piutang dan pengeluaran cek  yang 
bukan untuk pembayaran utang. 

Command Centre 
Sales 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat, menampilkan/mencetak transaksi 
penjualan, retur penjualan dan pelunasan piutang 
serta menyajikan laporan yang berhubungan 
dengan penjualan, misalnya rekap penjualan per 
item atau per costumer, analisis piutang dan 
sebagainya. 

Command Centre 
Purchases 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat, menampilkan/mencetak transaksi 
pembelian, retur pembelian dan pembayaran utang 
serta menyajikan laporan yang berhubungan 
dengan pembelian, misalnya rekap pembelian per 
item atau per supplier. 

Command Centre 
Inventory 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat item barang yang dibeli untuk dijual, 
penggabungan komponen menjadi satu unit barang 
baru atau sebaliknya, menyajikan laporan yang 
berkaitan dengan persediaan. 

Command Centre 
Card 

Pusat kendali pada MYOB yang berfungsi untuk 
mencatat data pelanggan (customer) dan pemasok 
(supplier) baik yang berkaiatan dengan nama, 
alamat, saldo awal piutang, utang, dan informasi 
lainnya. 

Debit Sisi sebelah kiri suatu akun. 

Deposit paid  Uang Muka atau uang panjar yang dibayarkan 
kepada supplier 

Double entry 
system 

Sistem pencatatan dari efek ganda (dual effect) dari 
tiap transaksi secara tepat. 

Electric Expense Beban Listrik 

Equipment Peralatan, salah satu jenis aset tetap. 

Equity Ekuitas atau modal 

Expenses Beban-beban operasi atau non operasi perusahaan. 
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Fixed Asset Aktiva Tetap, yaitu aset yang umurn pemakaiannya 
lebih dari satu tahun. 

Furniture Meubel, yaitu termasuk salah satu jenis aset tetap 
perusahaan. 

General Ledger Buku Besar, yaitu kumpulan akun-akun. 

General Journal 
Entry 

Formulir  untuk mencatat Jurnal Umum 

Income Penghasilan (Pendapatan) 

Interest Expense Beban Bunga, yaitu beban non operasi perusahaan 

Interest Revenue Pendapatan Bunga, salah satu pendapatan yang 
termasuk dalam non operasi 

Jurnal Buku catatan akuntansi yang digunakan untuk 
mencatat transaksi-transaksi keuangan yang terjadi 
setiap hari. 

Jurnal umum Bentuk jurnal yang paling umum dipakai untuk 
mencatat semua jenis transaksi. 

Kredit (credit) Sisi kanan suatu akun. 

Laporan Keuangan Merupakan ringkasan dari transaksi-transaksi 
keuangan yang terjadi selama satu periode 
akuntansi tertentu 

Liability Kewajiban, yaitu sesuatu yang harus ditunaikan 
perusahaan. 

MYOB Salah satu aplikasi komputer akuntansi yang dibuat 
oleh salah satu perusahaan di Australia yang 
merupakan singkatan dari Mind on Your Own 
Business. 

Neraca saldo (trial 
balance) 

Daftar akun-akun buku-buku dan saldo-saldonya 
pada saat tertentu. 

 

Motor vehicle Kendaraan Bermotor, yaitu salah satu jenis aset 
tetap 

Office supplies Suplies Kantor atau Bahan Habis Pakai (BHP) 

Other Expense Beban lain-lain di luar opersai perusahaan. 

Payroll Check Cek Gaji, yaitu cek yang khusus untuk pembayaran 
gaji. 

Periode Akuntansi Rentangan waktu akuntansi yang dimulai pada saat 
pembuatan neraca awal sampai dengan saat 
pembuatan laporan keuangan, biasanya selama 
satu tahun.  

Perusahaan Jasa Entitas bisnis yang usaha pokoknya memperoleh 
pendapatan dengan memberikan layanan jasa 
kepada pelanggan 
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Posting Prosedur memasukkan/memindahkan data dari 
jurnal ke buku besar. 

Profit and Loss 
Report 

Laporan Laba Rugi, salah satu jenis laporan yang 
memberikan informasi tentang pendapatan 
dibandingkan dengan beban-beban perusahaan. 

Provision for 
doubtful debt 

Cadangan kerugian piutang, dana yang disediakan 
untuk menutup kerugian akibat piutang yang tidak 
tertagih. 

Telephone 
Expense 

Beban Telepon, yaitu pembayaran tagihan rekening 
telkom. 

Transaksi 
Keuangan 

Kegiatan ekonomis yang dilakukan oleh 
perusahaan yang secara financial berdampak pada 
perubahan posisi keuangannya. 

Transaction 
Journal 

Jurnal Transaksi, yaitu catatan hasil pemrosesan 
jurnal transaksi keuangan tertentu. 

Trial Balance Neraca Saldo, yaitu selisih antara jumlah debit dan 
jumlah kredit akun-akun yang ada dalanm buku 
besar. 

Other Income Penghasilan Lain-lain di luar usaha pokok 
perusahaan. 

Rent Expense Beban Sewa, yaitu pembayaran sewa 
gedung/peralatan. 

Retained Earning Laba Ditahan, yaitu sebagian laba yang tidak 
dibagikan kepada pemilik perusahaan. 

Salaries and Wage 
Expenses 

Beban Gaji dan Upah, yaitu pembayaran gaji/upah 
pegawai bulanan. 

Water Expense Beban air, yaitu pembayaran tagihan rekening PAM 
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A. Deskripsi 
 

Perkembangan teknologi komputer telah memicu lembaga bisnis untuk 
menerapkan sistem informasi di segala bidang, termasuk bidang akuntansi. 
Penerapan komputer di bidang akuntansi ini semakin luas berkembang 
dikarenakan banyaknya software aplikasi komputer akuntansi yang tersedia di 
masyarakat. Justru permasalahan pokok yang dihadapi oleh lembaga bisnis 
adalah kurang tersedianya tenaga kerja yang kompeten dalam pengoperasian 
komputerisasi akuntansi. 
 

 
Gambar 1. 1 Operator komputer akuntansi 

Tidak jarang lembaga bisnis harus mengeluarkan biaya pelatihan yang cukup 
besar untuk menyiapkan tenaga operator komputer akuntansi. Sekolah Menengah 
Kejuru-an (SMK) sebagai salah satu lembaga penyedia calon tenaga kerja tingkat 
menengah tanggap terha-dap tuntutan industri. Dalam kurikulum 2013 khususnya 
untuk paket keahlian akuntansi peserta didik dituntut memiliki kemampuan 
menerapkan pengetahuan, keterampilan dan sikap yang konsisten dari waktu ke 
waktu dalam pengoperasian aplikasi komputer akuntansi.  

Sebagian kompetensi dasar dalam mata pelajaran Komputer Akuntansi menuntut 
peserta diklat untuk menguasai kompetensi secara utuh mengoperasikan aplikasi 
komputer akuntansi pada perusahaan dagang. Apakah perusahaan dagang itu? 
Perusahaan dagang adalah perusahaan yang usaha pokoknya memperoleh 
pendapatan/penghasilan dengan membeli barang dagangan dan menjualnya 
kembali tanpa merubah bentuk barang dagangan tersebut. 
Keuntungan menerapkan komputer akuntansi pada perusahaan dagang 
diantaranya adalah mengurangi penggunaan kertas-kertas (paperless) sehingga 
pada gilirannya akan mengurangi beban alat tulis kantor (ATK) atau beban 
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perlengkapan (supplies). Disamping itu keuntungan penerapan komputer di 

bidang akuntansi adalah jaminan untuk kecepatan dan ketepatan. 
 

 
 

Gambar 1. 2 Paperless 

Kecepatan karena sebagian besar pekerjaan akuntansi diambil alih oleh komputer 
dan dikerjakan dengan cepat. 
 

 
 

Gambar 1. 3 Proses komputer akuntansi 

Tugas operator hanyalah sebatas data entri, sementara tugas selanjutnya 
termasuk penyusunan laporan keuangan dikerjakan oleh komputer. Selama data 
yang dientri ke komputer data yang benar maka maka hasilnyapun akan benar 
atau tepat. 

Aktivitas komputer akuntansi perusahaan dagang mengarah pada data entri 
transaksi keuangan yang terjadi pada perusahaan dagang sejak awal periode 
sampai dengan proses penyiapan laporan keuangan pada akhir periode 
akuntansi.  
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Aktivitas ini secara keseluruhan meliputi: 
1. Menyiapkan data awal; 
2. Membuat daftar akun; 
3. Menyesuaikan pajak; 
4. Membuat Buku Pembantu 
5. Meng-entry saldo awal; 
6. Mencatat Transaksi Penjualan; 
7. Mencatat Transaksi Pembelian; 
8. Mencatat Transaksi Kas-Bank; 
9. Mencatat entri penyesuaian; 

10. Menampilkan laporan keuangan. 
11. Membuat backup file. 

 
 

B. Prasyarat  
 
 
Untuk memudahkan peserta didik dalam mempelajari buku ini, maka terlebih 
dahulu dipersyaratkan telah menguasai kompetensi dasar yang ada dalam mata 
pelajaran: 

1. Pengantar Akuntansi dan Keuangan 
2. Akuntansi Perusahaan Jasa. 
3. Komputer Akuntansi (untuk Perusahaan Jasa). 

 

 

C. Petunjuk Penggunaan Buku Siswa 
 
Buku Komputer Akuntansi 2 disusun untuk peserta didik, guna mendukung mata 
pelajaran Komputer Akuntansi di kelas XI semester II pada paket keahlian 
Akuntansi. 

Dalam buku ini terdapat 11 (sebelas) kegiatan belajar. Disarankan kepada peserta 
didik untuk mempelajari buku ini secara urut agar lebih mudah memahaminya.  

Agar aktivitas peserta didik lebih terarah dan lebih lancar dalam pencapaian 
kompetensi maka disarankan untuk mengikuti petunjuk-petunjuk berikut ini: 

1. Bacalah dengan cermat peta kedudukan modul, prasyarat dan pengertian 
dari istilah-istilah penting dalam buku ini. 

2. Untuk setiap kegiatan belajar, bacalah dengan cermat rumusan tujuan 
pembelajaran yang memuat pengetahuan dan kinerja yang diharapkan 
dalam rangka membentuk kompetensi kerja yang akan dicapai melalui 
modul ini.  

3. Pahami dengan baik uraian materi pada setiap kegiatan belajar termasuk 
kasus yang diberikan. Diskusikan dengan sesama peserta didik, uraian atau 
bagian dari kasus yang sulit dipahami. Bila masih ragu, maka tanyakanlah 
pada guru  sampai paham. 
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4. Ikuti langkah-langkah pemecahan kasus seperti yang tertulis di setiap 
kegiatan belajar. Lakukan ini bersama-sama dalam kelompok kecil. Bila 
mengalami kesulitan diskusikan dengan anggota kelompok. Jika masih ragu, 
maka tanyakanlah pada guru  sampai jelas. 

5. Kerjakan tugas-tugas, dan jawablah pertanyaan tes, kemudian cocokkan 
dengan kunci jawaban. Lakukan kegiatan ini sampai peserta didik tuntas 
menguasai hasil belajar yang diharapkan. 

6. Setelah kamu menuntaskan satu kegiatan belajar selanjutnya pelajari 
kegiatan belajar berikutnya secara urut. 

7. Peserta didik tidak dibenarkan melanjutkan pada kegiatan belajar 
berikutnya, bila belum menguasai secara tuntas materi pada kegiatan 
belajar sebelumnya. 

8. Setelah semua kegiatan belajar tuntas dipelajari maka ajukan diri untuk 
melaksanakan evaluasi penyelesaian buku 1. Pelaksanaan evaluasi ini bisa 
dikerjakan secara individu atau klasikal. Jika hasilnya memuaskan dapat 
melanjutkan kegiatan belajar di buku 2. 

 
 

D. Tujuan Akhir 
 
 

Spesifikasi kompetensi yang diharapkan dikuasai setelah menyelesaikan kegiatan 
belajar ini adalah dengan diberikan kasus-kasus akuntansi perusahaan dagang 
peserta didik dapat menyelesaikan proses komputer akuntansi sampai dengan 
akhir periode, sehingga dapat menghasilkan laporan keuangan. 

 

 

E. Kompetensi Inti dan Kompetensi Dasar 
 

Tabel berikut ini menyajikan kompetensi inti dan kompetensi dasar untuk mata 
pelajaran Komputer Akuntansi di  kelas XI. 

KOMPETENSI  INTI KOMPETENSI  DASAR 

1. Menghayati dan 
mengamalkan ajaran agama 
yang dianutnya  

 

1.1 Mensyukuri  karunia Tuhan Yang Maha 
Esa, atas pemberian amanah untuk 
mengelola administrasi keuangan entitas.  

1.2 Mengamalkan ajaran agama dalam 
memanfaatkan ilmu pengetahuan dan 
teknologi untuk menghasilkan informasi 
keuangan yang mudah dipahami, 
relevan, andal dan dapat 
diperbandingkan. 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

2. Menghayati dan 
mengamalkan perilaku jujur, 
disiplin, tanggungjawab, 
peduli (gotong royong, 
kerjasama, toleran, damai), 
santun, responsif dan pro-
aktif dan menunjukkan sikap 
sebagai bagian dari solusi 
atas berbagai permasalahan 
dalam berinteraksi secara 
efektif dengan lingkungan 
sosial dan alam serta dalam 
menempatkan diri sebagai 
cerminan bangsa dalam 
pergaulan dunia 

2.1. Memiliki motivasi internal dan 
menunjukkan rasa ingin tahu dalam 
menemukan dan memahami 
pengetahuan dasar tentang komputer 
akuntansi. 

2.2. Menunjukkan perilaku jujur, disiplin, 
tanggungjawab, santun, responsif dan 
pro-aktif dalam berinteraksi secara efektif 
dalam lingkungan sosial sesuai dengan 
prinsip etika profesi bidang komputer 
akuntansi. 

2.3. Menghargai kerja individu dan kelompok 
serta mempunyai kepedulian yang tinggi 
dalam menjaga keselarasan lingkungan 
sosial, lingkungan kerja dan alam. 

3. Memahami dan menerapkan 
pengetahuan faktual, 
konseptual, dan  prosedural, 
berdasarkan rasa ingin 
tahunya tentang ilmu 
pengetahuan, teknologi, 
seni, budaya, dan humaniora 
dengan wawasan 
kemanusiaan, kebangsaan, 
kenegaraan, dan peradaban 
terkait penyebab fenomena 
dan kejadian dalam bidang 
kerja yang spesifik untuk 
memecahkan masalah.  

 

3.1. Mendeskripsikan spesifikasi sistem 
komputer yang diperlukan untuk 
menginstal program aplikasi komputer 
akuntansi yang dipilih. 

3.2. Mendeskripsikan proses pembuatan file 
data akuntansi baru untuk perusahaan 
jasa   

3.3. Menganalisis susunan daftar akun dan 
hubungan akun (link accounts) untuk 
komputerisasi akuntansi perusahaan 
jasa  

3.4. Mendeskripsikan cara penyesuaian 
pajak pertambahan nilai (PPN) untuk 
perusahaan jasa 

3.5. Mendeskripsikan cara pengisian saldo 
awal akun buku besar perusahaan jasa  

3.6. Menganalisis transaksi-transaksi 
pengeluaran kas/bank pada perusahaan 
jasa dan cara pengentriannya. 

3.7. Menganalisis transaksi-transaksi 
penerimaan kas/bank pada perusahaan 
jasa dan cara pengentriannya. 

3.8. Menjelaskan penyelesaian rekonsiliasi 
bank untuk perusahaan jasa  

3.9. Menganalisis  transaksi umum  termasuk 
transaksi penyesuaian dan cara 
pengentriannya ke dalam buku jurnal 
umum perusahaan jasa 

3.10. Mendeskripsikan cara penyusunan 
laporan keuangan untuk perusahaan 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

jasa  

3.11. Mendeskripsikan cara pembuatan file 
backup untuk perusahaan jasa  

3.12. Mendeskripsikan proses pembuatan file 
data akuntansi baru untuk perusahaan 
dagang  

3.13. Menganalisis susunan daftar akun dan 
hubungan akun (link accounts) untuk 
komputerisasi akuntansi perusahaan 
dagang 

3.14. Mendeskripsikan cara penyesuaian 
pajak pertambahan nilai (PPN) untuk 
perusahaan dagang 

3.15. Mendeskripsikan cara pengisian saldo 
awal akun buku besar perusahaan 
dagang 

3.16. Mendeskripsikan cara  pembuatan kartu 
piutang dan pengisian saldonya untuk 
perusahaan dagang 

3.17. Mendeskripsikan cara  pembuatan kartu 
utang dan pengisian saldonya untuk 
perusahaan dagang 

3.18. Mendeskripsikan cara  pembuatan kartu 
perlengkapan/persediaan dan pengisian 
saldonya untuk perusahaan dagang 

3.19. Mendeskripsikan cara pembuatan kartu 
aktiva tetap dan pengisian saldonya 
untuk perusahaan jasa dan dagang 

3.20. Menganalisis transaksi-transaksi 
pembelian tunai dan pembelian kredit 
pada perusahaan dagang serta cara 
pengentriannya. 

3.21. Menganalisis transaksi-transaksi 
pembayaran utang bagi perusahaan 
dagang dan cara pengentriannya. 

3.22. Menganalisis transaksi-transaksi 
penjualan bagi perusahaan dagang dan 
cara pengentriannya. 

3.23. Menganalisis transaksi-transaksi 
pelunasan piutang bagi perusahaan 
dagang dan cara pengentriannya. 

3.24. Menganalisis transaksi-transaksi 
pengeluaran kas/bank bagi perusahaan 
dagang dan cara pengentriannya. 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

3.25. Menganalisis transaksi-transaksi 
penerimaan kas/bank bagi perusahaan 
dagang dan cara pengentriannya. 

3.26. Mendeskripsikan cara penyelesaian 
rekonsiliasi bank untuk perusahaan 
dagang 

3.27. Menganalisis transaksi umum termasuk 
transaksi penyesuaiann dan cara 
pengentriannya ke dalam buku jurnal 
umum perusahaan dagang 

3.28. Mendeskripsikan cara penyusunan 
laporan keuangan untuk perusahaan 
dagang 

3.29. Mendeskripsikan cara pembuatan file 
backup untuk perusahaan dagang 

4. Mengolah, menalar, dan 
menyaji dalam ranah konkret 
dan ranah abstrak  terkait 
dengan pengembangan dari 
yang dipelajarinya di sekolah 
secara mandiri, dan mampu 
melaksanakan tugas spesifik 
di bawah pengawasan 
langsung.  

 

 

4.1. Menginstal program aplikasi komputer 
akuntansi pada sistem komputer yang 
telah dipersiapkan. 

4.2. Membuat file data akuntansi baru untuk 
perusahaan jasa   

4.3. Menyusun daftar akun dan hubungan 
akun (link accounts) untuk perusahaan 
jasa  

4.4. Menyesuaikan seting pajak 
pertambahan nilai (PPN) untuk 
perusahaan jasa 

4.5. Mengsisi saldo awal akun buku besar 
perusahaan jasa  

4.6. Mengentri transaksi-transaksi 
pengeluaran kas/bank pada perusahaan 
jasa  

4.7. Mengentri transaksi-transaksi 
penerimaan kas/bank pada perusahaan 
jasa 

4.8. Membuat rekonsiliasi bank untuk 
perusahaan jasa  

4.9. Mengentri  transaksi umum  termasuk 
transaksi penyesuaian ke dalam buku 
jurnal umum perusahaan jasa 

4.10. Membuat laporan keuangan untuk 
perusahaan jasa  

4.11. Membuat file backup untuk perusahaan 
jasa  

4.12. Membuat file data akuntansi baru untuk 
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KOMPETENSI  INTI KOMPETENSI  DASAR 

perusahaan dagang  

4.13. Membuat  daftar akun dan hubungan 
akun buku besar perusahaan dagang. 

4.14. Menyesuaikan seting pajak 
pertambahan nilai (PPN) untuk 
perusahaan dagang 

4.15. Mengentri saldo awal akun-akun buku 
besar untuk perusahaan dagang 

4.16. Membuat kartu piutang dan mengisi 
saldonya untuk perusahaan dagang 

4.17. Membuat kartu utang dan mengisi 
saldonya perusahaan dagang 

4.18. Membuat kartu perlengkapan/ 
persediaan dan mengisi saldonya untuk 
perusahaan dagang 

4.19. Membuat kartu aktiva tetap dan mengisi 
saldonya untuk perusahaan dagang 

4.20. Mengentri transaksi-transaksi pembelian 
tunai dan kredit bagi perusahaan 
dagang 

4.21. Mengentri transaksi-transaksi 
pembayaran utang bagi perusahaan 
dagang 

4.22. Mengentri transaksi-transaksi penjualan 
bagi perusahaan dagang 

4.23. Mengentri transaksi-transaksi pelunasan 
piutang bagi perusahaan dagang 

4.24. Mengentri transaksi-transaksi 
pengeluaran kas/bank bagi perusahaan 
dagang 

4.25. Mengentri transaksi-transaksi 
penerimaan kas/bank bagi perusahaan 
jasa dan dagang 

4.26. Membuat rekonsiliasi bank untuk 
perusahaan dagang 

4.27. Mengentri transaksi umum termasuk 
transaksi penyesuaian ke dalam jurnal 
umum perusahaan  dagang 

4.28. Membuat laporan keuangan untuk 
perusahaan dagang 

4.29. Membuat file backup untuk perusahaan 
dagang 
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F. Cek Kemampuan Awal 
 
Sebelum kamu memelajari buku ini, kamu diminta untuk menjawab semua 
pertanyaan di bawah ini dengan mencontreng kolom YA atau TIDAK. 

No Butir Pertanyaan 
Kemampuan 

Ya Tidak 

 Apakah kamu dapat menyiapkan data 

awal? 

  

 Apakah kamu dapat membuat daftar 

akun? 

  

 Apakah kamu dapat menyesuai-kan 

pajak? 

  

 Apakah kamu dapat membuat buku 

pembantu 

  

 Apakah kamu dapat mengentri saldo 

awal? 

  

 Apakah kamu dapat mencatat transaksi 

penjualan? 

  

 Apakah kamu dapat mencatat transaksi 

pembelian? 

  

 Apakah kamu dapat mencatat transaksi 

kas bank? 

  

 Apakah kamu dapat mencatat entri 

penyesuaian? 

  

 Apakah kamu dapat menampilkan 

laporan keuangan? 

  

 Apakah kamu dapat membuat file 

backup? 
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A. Deskripsi 
 
 
Proses pembelajaran yang dirancang untuk komputer akuntansi ini, lebih 
mengarah pada model pembelajaran berbasis masalah/kasus (Problem Based 
Learning), dimana para peserta didik dirangsang dan dilatih untuk mampu mencari 
solusi (pemecahan masalah) yang diberikan baik secara individual maupun 
kelompok. 

Tahapan-tahapan yang akan digunakan adalah sebagai berikut: 
 

Fase Aktivitas peserta didik 

Fase 1. 

Identifikasi Kasus. 

 Identifikasi tujuan pembelajaran. 
 Identifikasi kelengkapan logistik. 
 Identifikasi kelengkapan informasi/ 

data dalam kasus yang diberikan. 

Fase 2. 

Organisasi Tugas. 

 Menentukan alternatif pemecahan 
kasus. 

 Inventarisasi tugas. 
 Pembagian tugas. 

Fase 3. 

Pelaksanaan tugas atau 
eksperimen 

 Mengumpulkan informasi yang sesuai 
untuk melaksanaan tugas. 

 Melaksanakan eksperimen 
 Mengatasi kesulitan/kesalahan yang 

terjadi dalam pelaksanaan 
eksperimen 

Fase 4. 

Penyajian hasil tugas. 

 Membuat laporan  
 Menyajikan hasil tugas 

Fase 5. 

Analisis dan Evaluasi 
proses pemecahan 
kasus. 

 Presentasi individu/kelompok  
 Mengevaluasi kasus yang diberikan 
 Mengevaluasi proses pemecahan 

kasus 

 
 

Bab II 

Pembelajaran 
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Banyak tersedia program aplikasi komputer akuntansi yang bisa digunakan untuk 
pelatihan, namun dalam pembelajaran kali ini akan difokuskan pada program 
MYOB Accounting, yang biasa digunakan di perusahaan tingkat menengah ke 
bawah. Pengoperasian program MYOB relatif lebih mudah yaitu dengan memilih 
menu jenis transaksi dan mengisi formulir yang terkait, sedang komputer akan 
memproses jurnal dan laporan keuangannya secara otomatis. Ada beberapa jenis 
program MYOB Accounting yang dijual di pasaran, tetapi yang digunakan untuk 
pembelajaran kali ini adalah MYOB versi pendidikan, yaitu MYOB Accounting Plus 
v18 untuk Windows, dikeluarkan di Australia, Release 12.4.OJ Education Edition. 

 

B. Kegiatan Belajar 
 

Penulisan buku II Komputer Akuntansi yang diaplikasikan pada perusahaan 
dagang ini dijabarkan dalam 10 (sepuluh) kegiatan belajar yaitu  meliputi : 

1) Kegiatan belajar 1 : Menyiapkan data awal perusahaan; 
2) Kegiatan balajar 2 : Membuat daftar akun; 
3) Kegiatan belajar 3 : Membuat Buku Pembantu; 
4) Kegiatan belajar 4 : Mengentri Saldo Awal; 
5) Kegiatan belajar 5 : Mencatat Transaksi Penjualan; 
6) Kegiatan belajar 6 : Mencatat Transaksi Pembelian; 
7) Kegiatan belajar 7 : Mencatat Transaksi Kas-Bank; 
8) Kegiatan belajar 8 : Mencatat Entri Penyesuaian; 
9) Kegiatan belajar 9 : Menampilkan laporan Keuangan; 

10) Kegiatan belajar 10 : Membuat file backup. 

Setiap kegiatan belajar dilengkapi dengan tujuan pembelajaran, uraian materi, 
rangkuman, tugas-tugas, tes formatif, kunci jawaban tes formatif, dan lembar kerja 
peserta didik. 
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Kegiatan Belajar 1 
Menyiapkan Data Awal 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 
akhir sesi ini diharapkan peserta didik dapat: Menjelaskan persyaratan 
pendirian bank 

1. Membuat file data baru 

2. Mengecek Informasi Perusahaan 

3. Menyesuaikan format Pajak 

 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Pembuatan File Data Baru 

2. Pengecekan Informasi Perusahaan 

3. Penyesuaian Format Pajak 

 
1. Pembuatan File Data Baru. 

MYOB merupakan salah satu aplikasi komputer akuntansi yang berbasis 
Windows, oleh sebab itu pastikan bahwa spesifikasi peralatan komputer 
yang dituntut untuk menginstall MYOB adalah minimal sama dengan yang 
dipersyaratkan oleh program Windows. 

Ada beberapa versi MYOB yang tersedia di masyarakat, tetapi versi yang 
digunakan dalam pembelajaran ini adalah AccountingPlus 18 versi edukasi 
yang dirilis oleh MYOB Australia. Pastikan bahwa program ini telah diinstal 
terlebih dahulu di komputer anda. Langkah awal sebelum mengoperasikan 
MYOB, adalah pengecekan bahwa simbol mata uang dan seting tanggal 
sudah sesuai dengan sistem Indonesia. 

File data bisnis adalah file yang digunakan oleh MYOB untuk menyimpan 
seluruh data yang dientri ke komputer. Yang perlu dingat kembali adalah 
nama file tersebut harus unik (artinya tidak ada nama file yang sama 
sebelumnya), baik untuk file yang sudah eksis atau yang akan dibuat.  

Data yang dibutuhkan pembuatan File Data baru adalah: 

a. Identitas perusahaan, meliputi : nama perusahaan, nomor registrasi, 
alamat perusahaan, nomor telepon, nomor fax dan alamat e-mail. 

b. Periode akuntansi, yang meliputi: tahun periode berjalan, bulan akhir 
periode, bulan konversi , dan jumlah bulan dalam periode. 
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c. Teknik pembuatan daftar akun. Pada tahap ini akan digunakan cara 
yang kedua, yaitu mengimport daftar akun yang sudah dipersiapkan 
oleh perusahaan sebelumnya: 

d. Nama File dan Folder tempat penyimpanan file tersebut. 

Hal-hal yang perlu diperhatikan dalam pembuatan file data baru ini adalah: 

 Data input sudah diidentifikasi dan dipersiapkan. 

 Pembuatan file data bisnis hanya satu kali yaitu pada saat konversi dan 
akan digunakan selama perusahaan tetap beroperasi. 

 Jika dalam proses pembuatan data bisnis ada yang salah dan file  
sudah terlanjur disimpan, maka kesalahan tidak dapat dikoreksi. Satu 
solusi yang tepat yaitu membuat file data bisnis baru dari awal. 

 Data UD Rasela Media Mandiri: 
 

Identitas Perusahaan dan Usaha pokok 

Nama perusahaan  :  UD Rasela Media Mandiri 
Nama Pemilik  :  Rasela Marta 
Bidang Usaha  :  Computer Dealer 
Alamat   :  Jl. Pamulang Raya 17, Tangerang Selatan. 
No Telepon/Faximile :  021 7434352 
Alamat email  :  ud.rmm@yahoo.com 
Bank   :  MANDIRI KCP Pamulang 
No Rekening  :  048 213 457896 

Kebijakan Komputerisasi Akuntansi 

1. Menggunakan sistem berpasangan dangan dasar akrual basis. 

2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia. 

3. Menggunakan Special Journal  

4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut: 

 Tahun akuntansi berjalan (Current Financial year)  : 2013,  

 Bulan akhir tahun  (Last month of the year)   : December,  

 Bulan pergantian (Conversion Month)  : January, 

 Jumlah bulan dalam speriode  (Accounting Period) : Twelve. 

5. Pada tahap pembuatan daftar akun (Build your accounts list): 

 Mengimport daftar akun yang telah disediakan oleh perusahaan. 

o (I would like to import a list of accounts provided by …. ) 

6. Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:  

 Company file name  : UD-RMM 

 Folder penyimpanan file  : Document atau My Document 

 

Masalah Pajak (PPN) 

1. Setiap pembelian/penjualan barang dagangan diperthitungkan PPN 10% 
2. Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah termasuk PPN 

10% (tax Inclusive). 
3. Jika terjadi retur pembelian atau retur penjualan maka PPN masukan atau PPN keluaran 

akan diperhitungkan pengurangannya. 
4. Pembayaran utang dan penerimaan pelunasan piutang dengan discount akan langsung 

mengurangi nilai piutang/utang tetapi tidak mempengaruhi PPN yang telah diperhitungkan. 
5. GST (Good Services Tax), yang akan diedit menjadi: PPN (Pajak Pertambahan Nilai) sebesar 

10%.  

mailto:ud.rmm@yahoo.com
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Langkah membuat file data baru sebagai berikut: 
 

1 Klik Create pada pilihan menu awal 

2 Pilih Next pada window [Welcome To MYOB.....] 

3 Masukkan data identitas perusahaan seperti pada gambar: 

 Nama perush. 

 Alamat 

 No. Telepon 

 No Faximili. 

 E-mail address 
NB: Kolom ABN (Australian Business Number) kosongkan. 
 

 

 

 

Gambar 2. 1 Identitas Perusahaan 

 
4 

 

Klik Next untuk meneruskan,  Masukkan data periode akuntansi seperti pada 

gambar di bawah:  

Tahun periode:  2013;  Bulan akhir periode: December 

Bulan konversi:  Januari;   Jumlah periode akuntansi:  Twelve 

Kemudian klik Next. 
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Gambar 2. 2 Periode Akuntansi 

 

5 
Periksa kembali kebenaran data periode akuntansi, bila ada kesalahan klik Back 
dan betulkan data yang salah. Bila data sudah benar klik Next. 

 

6 
Untuk pembuatan daftar akun, pilih opsi nomor 2 yaitu:  I would like to import a 
list of account provided by ......  kemudian Klik Next untuk meneruskan 

 

 

 

 

Gambar 2. 3 Opsi Pembuatan Daftar Akun 
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7 

 

Untuk itu klik Change untuk mengubah nama file dan folder 

 

 

 

Gambar 2. 4  Mengubah Nama File 

8 Penyimpanan file data akuntansi:  Nama file : RMM-1 dan Nama Folder :  

Documents atau My Documents 

Klik Save untuk menyimpan file yang sudah dibuat. 

 

 

 

Gambar 2. 5 Penentuan Nama File dan Folder 
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9 Nama file dan folder sudah diubah 

 

 

Gambar 2. 6 Nama Baru untuk file an Folder 

10 Klik Next untuk meneruskan  

Klik Command Centre untuk menampilkan menu utama. 

Tampilan menu utama, ada 4 kelompok pilihan: 

1. Menu Bar 

2. Command Centre 

3. Command Button 

4. Command Panel 
 

 

 

Gambar 2. 7 Tampilan Menu Utama 

 



 
Komputer Akuntansi Jilid 2  

Direktorat Pembinaan SMK (2013) 
18 

2. Pengecekan Informasi Perusahaan. 

File data baru yang akan digunakan sebagai tempat pencatatan data 
akuntansi telah disiapkan, tapi apakah data yang telah di input itu sudah 
benar? MYOB menyediakan fasilitas untuk mengecek kebenaran data, 
terutama untuk identitas perusahaan dan periode akuntansi. 

Langkah-langkah untuk mengecek hasil pembuatan file data baru (kasus 
UD Rasela Media Mandiri.): 

1 Klik menu Setup dan pilih Company Informastion. 

 

 

 

2 Cek kebenaran informasi perusahaan, terutama identitas perusahaan dan 
periode akuntansi. Jika identitas perusahaan ada yang salah dapat diedit. Tetapi 
jika ada data periode akuntansi yang salah maka proses pembuatan file data 
baru harus diulang kembali. Jika keduanya benar klik OK 
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3. Penyesuaian Jenis Pajak. 

Program MYOB v18 (versi Australia) menyediakan fasilitas untuk 
menghitung dan mencatat berbagai jenis pajak, yaitu: 

 

Code Description Type Rate 

EXP GST Free Exports Goods & Services Tax 0% 

FRE GST Free Goods & Services Tax 0% 

GCA GST on Capital Aquisition Goods & Services Tax 10% 

GST Goods & Services Tax Goods & Services Tax 10% 

INP Input Taxed Purchases Input Taxed 10% 

ITS Input Taxed Sales Good & Services Tax 0% 

N-T Not Reportable Good & Services Tax 0% 

NTD Non Tax Deductible Input Taxed 0% 

PRI GST Private Use Good & Services Tax 10% 

 
Diantara jenis-jenis pajak tersebut, ada 2 jenis yang bisa digunakan yaitu: 
GST dan NT. Sedangkan jenis-jenis pajak yang lainnya tidak digunakan di 
Indonesia, oleh sebab itu perlu dihapus.   

Langkah-langkah untuk menghapus pajak yang tidak digunakan: 
 

1 Klik List, dan Tax Codes untuk menampilkan daftar pajak 

 

 

2 Hapus dengan memilih satu jenis pajak misalnya PRI (GST Private Use)  
dan klik kanan-mouse, kemudian klik Delete. 

 Pen
gant
ar 

Eko
nomi 
dan 
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3 Ulangi cara yang sama untuk menghapus jenis pajak yang lainnya hingga 

tersisa dua jenis pajak: GST dan N-T. 

 
Selanjutnya jenis pajak GST (Goods and Services Tax) akan diubah 
menjadi PPN (Pajak Pertambahan Nilai) dan ‘link account’ yang terkait 

akan disesuaian. 
 

1 Klik GST dan Edit  untuk mengedit jenis pajak GST. 

2 Kolom Tax Code diisi dengan PPN dan kolom Description diisi dengan 
Pajak Pertambahan Nilai. 

3 Pilih akun PPN Collected  untuk Tax Collected dan PPN paid untuk Tax 
Paid (linked accounts). 

4 Klik OK untuk mengakhiri. 

 

 

 

Pengantar Administrasi Perkantoran 
 (C1-2) 
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4. Keluar dari Program. 

1 
Untuk keluar dari program MYOB klik File di Menu Bar, kemudian klik Exit. 

 

 

Gambar 2. 8 Menu Exit 

2 Pada tampilan untuk membuat file Backup, klik No untuk keluar dari MYOB tanpa 
backup. 

 

c. Rangkuman 

• MYOB merupakan salah satu aplikasi komputer akuntansi yang 
berbasis Windows, oleh sebab itu spesifikasi peralatan komputer yang 
dituntut untuk menginstall MYOB adalah minimal sama dengan yang 
dipersyaratkan oleh program Windows. 

• Ada beberapa versi MYOB yang tersedia di masyarakat, tetapi versi 
yang digunakan dalam pembelajaran ini adalah AccountingPlus 18 
versi edukasi yang dirilis oleh MYOB Australia. Program ini perlu 
diinstal terlebih dahulu di komputer anda. Langkah awal sebelum 
mengoperasikan MYOB, anda perlu menyesuaikan simbol mata uang 
dan seting tanggal sesuai dengan sistem Indonesia. 

• Untuk membuat file data bisnis yang baru diperlukan identitas 
perusahaan, misalnya nama dan alamat perusahaan, nomor telepon, 
alamat e-mail dan sebagainya. Disamping itu juga diperlukan data 
periode akuntansi, bulan konversi dan rencana pembuatan daftar akun 
untuk pencatatan akuntansi. 

• Oleh karena program MYOB yang digunakan ini adalah versi Australia 
maka fasilitas perhitungan dan jenis pajaknya juga versi Australia, oleh 
sebab itu perlu adanya penyesuaian jenis pajak untuk digunakan di 
Indonesia.  
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d. Tugas 

Berdasarkan Kasus 1.1. UD Rasela Media Mandiri yang ada pada 
‘Lembar Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan 
dalam KB1 ini melalui kerjasama kelompok. 

3. Tugas 1, cek format tanggal dan simbol mata uang di komputer 
masing-masing, bila formatnya masih default atau menggunakan 
format Amerika maka ubahlah ke format Indonesia.  

4. Tugas 2, buatlah file data bisnis baru didasarkan pada Ikuti langkah-
langkah seperti yang telah dijelaskan di dalam buku ini. 

5. Tugas 3, menghapus jenis pajak yang tidak sesuai. 

6. Tugas 4, menyesuaikan GST menjadi PPN dan  linked account untuk 
PPN. 

 

 

e. Tes Formatif 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Kolom informasi perusahaan yang harus diisi (tidak boleh kosong): 
a. Serial Number 
b. Company Name 
c. Address 
d. Phone and fax number 
e. Email Address. 

2. Yang dimaksudkan dengan Current Financial Year: 
a. Periode akuntansi yang sedang berjalan 
b. Periode akuntansi yang akan datang 
c. Periode akuntansi yang lalu 
d. Periode akuntansi selama perusahaan beraktivitas 
e. Periode akuntansi tertentu. 

3. Yang dimaksud dengan Last Month of Financial Year: 
a. Bulan awal dari periode akuntansi 
b. Bulan awal dan akhir dari periode akuntansi 
c. Bulan akhir dari periode akuntansi 
d. Akhir bulan (Desember) dari periode akuntansi 
e. Akhir bulan (Januari) dari periode akuntansi  
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4. Yang dimaksud dengan Conversion Month: 

a. Bulan saat terjadinya transaksi 
b. Bulan saat terjadinya konversi dari sistem manual ke komputer 
c. Bulan awal periode akuntansi 
d. Bulan akhir periode akuntansi 
e. Bulan pergantian periode akuntansi 

5. Tarif GST atau PPN adalah: 
a. 25% 
b. 5% 
c. 15% 
d. 10% 
e. 35%. 

6. Jenis pajak N-T adalah singkatan dari: 
a. No Tax 
b. Not Tax 
c. Not Reportable 
d. No Traceable 
e. Not Taxable 

7. Jika total penjualan barang sebesar Rp. 27.500.000,- (including Tax) maka 
besarnya pendapatan dari penjualan barang adalah: 
a. Rp. 27.500.000,- 
b. Rp. 25.375.000,- 
c. Rp. 22.500.000,- 
d. Rp. 25.000.000,- 
e. Rp. 21.250.000,- 

8. Jika total penjualan barang sebesar Rp. 27.500.000,- (excluding Tax) maka 
besarnya PPN adalah: 
a. Rp. 2.750.000,- 
b. Rp. 1.375.000,- 
c. Rp. 2.500.000,- 
d. Rp. 5.000.000,- 
e. Rp. 1.250.000,- 

9. Menu yang digunakan untuk mengedit atau menghapus jenis-jenis pajak 
adalah: 

a. Setup > List  > Tax Codes 
b. List  > Setup > Tax Codes 
c. Tax Codes  > List  
d. List  > Tax Codes 
e. Setup > Tax Codes  > List 

10. Menu yang digunakan untuk keluar dari program MYOB adalah: 
a. File > Setup > Exit 
b. Exit  > File 
c. File  > Exit  
d. Setup  > Exit 
e. Setup > File > Exit 
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2. Tes Keterampilan. 

Berdasarkan Kasus 1.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta 
didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, buatlah file data bisnis baru didasarkan pada Kasus 1.2. tersebut 
di atas. 

4. Tugas 2, menghapus jenis-jenis pajak yang tidak sesuai. 

5. Tugas 3, menyesuaikan GST menjadi PPN dan  linked account untuk PPN. 

 

f. Kunci Jawaban Tes Formatif 

 
1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 b  6 c 

2 a  7 d 

3 c  8 a 

4 b  9 d 

5 d  10 c 
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2. Kunci Tes Keterampilan 

Tugas 1, Company Information (file data bisnis baru). 

 

Tugas 2, menghapus jenis-jenis pajak yang tidak sesuai. 
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Tugas 3, Seting PPN dan  linked account untuk PPN. 

 
 

g. Lembar Kerja Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 

didik di komputer melalui program MYOB versi 18. 

 

KASUS 1.1. UD RASELA MEDIA MANDIRI 

Identitas Perusahaan dan Usaha pokok 

Nama perusahaan :  UD Rasela Media Mandiri 
Nama Pemilik  :  Rasela Marta 
Bidang Usaha  :  Computer Dealer 
Alamat   :  Jl. Pamulang Raya 17, Tangerang Selatan. 
No Telepon/Faximile :  021 7434352 
Alamat email  :  ud.rmm@yahoo.com 
Bank   :  MANDIRI KCP Pamulang 
No Rekening  :  048 213 457896 

Keputusan Manajemen 

Pada awal Januari 2013 pemilik perusahaan Rasela Marta ingin menerapkan 
sistem informasi yang memproses data akuntansi untuk perusahaannya secara 
otomatis.  Program yang akan digunakan adalah MYOB Accounting ver 18. 
 

mailto:ud.rmm@yahoo.com
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Kebijakan Komputerisasi Akuntansi 

1. Menggunakan sistem berpasangan dangan dasar akrual basis. 

2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia. 

3. Menggunakan Special Journal  

4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut: 

 Tahun akuntansi berjalan (Current Financial year)  : 2013,  

 Bulan akhir tahun  (Last month of the year)   : December,  

 Bulan pergantian (Conversion Month)  : January, 

 Jumlah bulan dalam speriode  (Accounting Period) : Twelve. 

5. Pada tahap pembuatan daftar akun (Build your accounts list): 

 Mengimport daftar akun yang telah disediakan oleh perusahaan. 

 (I would like to import a list of accounts provided by …. ) 

6. Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:  

 Company file name   : RMM-1 

 Folder penyimpanan file  : Document atau My Document 

Masalah Pajak (PPN) 

1. Setiap pembelian/penjualan barang dagangan diperthitungkan PPN 10% 

2. Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah 

termasuk PPN 10% (tax Inclusive). 

3. Jika terjadi retur pembelian atau retur penjualan maka PPN masukan atau 

PPN keluaran akan diperhitungkan pengurangannya. 

4. Pembayaran utang dan penerimaan pelunasan piutang dengan discount akan 

langsung mengurangi nilai piutang/utang tetapi tidak mempengaruhi PPN yang 

telah diperhitungkan. 

5. GST (Good Services Tax), yang akan diedit menjadi: PPN (Pajak 

Pertambahan Nilai) sebesar 10%.  
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KASUS 1.2. UD RIOLA MEDIA MANDIRI 

Identitas Perusahaan dan Usaha pokok 

Nama perusahaan :  UD Riola Media Mandiri 
Nama Pemilik  :  Riola Marta 
Bidang Usaha  :  Computer Dealer 
Alamat   :  Jl. Pamulang Raya 17, Tangerang Selatan. 
No Telepon/Faximile :  021 7434352 
Alamat email  :  ud.rmm@yahoo.com 

 

Keputusan Manajemen 

Pada awal Januari 2013 pemilik perusahaan Riola Marta ingin menerapkan sistem 
informasi yang memproses data akuntansi untuk perusahaannya secara otomatis.  
Program yang akan digunakan adalah MYOB Accounting ver 18. 
 

Kebijakan Komputerisasi Akuntansi 

1. Menggunakan sistem berpasangan dangan dasar akrual basis. 

2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia. 

3. Menggunakan Special Journal  

4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut: 

 Tahun akuntansi berjalan (Current Financial year)  : 2013,  

 Bulan akhir tahun  (Last month of the year)   : December,  

 Bulan pergantian (Conversion Month)  : January, 

 Jumlah bulan dalam speriode  (Accounting Period) : Twelve. 

5. Pada tahap pembuatan daftar akun (Build your accounts list): 

 Mengimport daftar akun yang telah disediakan oleh perusahaan. 

 (I would like to import a list of accounts provided by …. ) 

6. Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:  

 Company file name   : RMM-2 

 Folder penyimpanan file  : Document atau My Document 

Masalah Pajak (PPN) 

1. Setiap pembelian/penjualan barang dagangan diperthitungkan PPN 10% 

2. Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah 

termasuk PPN 10% (tax Inclusive). 

3. Jika terjadi retur pembelian atau retur penjualan maka PPN masukan atau 

PPN keluaran akan diperhitungkan pengurangannya. 

4. Pembayaran utang dan penerimaan pelunasan piutang dengan discount akan 

langsung mengurangi nilai piutang/utang tetapi tidak mempengaruhi PPN yang 

telah diperhitungkan. 

5. GST (Good Services Tax), yang akan diedit menjadi: PPN (Pajak 

Pertambahan Nilai) sebesar 10%.  

 

mailto:ud.rmm@yahoo.com


 
Komputer Akuntansi Jilid 2  

Direktorat Pembinaan SMK (2013) 
29 

Kegiatan Belajar 2 
Membuat Daftar Akun 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 
akhir sesi ini diharapkan peserta didik dapat: Menjelaskan pengertian 
sumber-sumber dana bank 

1. Mengidentifikasi tipe-tipe akun 

2. Mengimport daftar akun 

3. Menyesuaikan linked accounts 

4. Menghapus dan mengedit akun 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Tipe-tipe akun 

2. Pembuatan daftar akun 

3. Penyesuaian link account 

4. Menghapus dan mengedit akun-akun 

 
1. Tipe-tipe akun 

Dalam MYOB, daftar akun dikelompokkan dalam 8 tipe, yaitu: 

Kode Tipe Akun Sub Tipe Akun Sub Tipe Akun 

1 Asset Assets dibagi 5: Liabilities dibagi 5: 

2 Liability  Bank 

 Accounts Receivable 

 Other Current Asset 

 Fixed Asset 

 Other Asset 
 

 Credit card 

 Accounts Payable 

 Other Current Liability 

 Long Term Liability 

 Other Liability 
 

3 Equity 

4 Income 

5 Cost of Sales 

6 Expense 

7 Tidak ada 

8 Other Income 

9 Other Expense   

Kode Akun 

Setiap akun memiliki kode 5 digit, contoh akun Cash in Bank   1 - 1100 

Digit ke 1  : Kategori Akun. 

Digit ke 2 - 5 : Nomor ID Akun (Unik, tidak boleh ada yang sama). 

Kelompok Akun. 



 
Komputer Akuntansi Jilid 2  

Direktorat Pembinaan SMK (2013) 
30 

a) Akun Header, berfungsi sebagai header, nilainya tidak dapat diposting 
(Non Postable). Akun ini biasanya tercetak dengan huruf tebal. 

b) Akun Detail, berfungsi sebagai child, nilainya dapat diposting (Postable). 
Akun ini tercetak dengan huruf biasa. 

Contoh daftar akun: 

 

Gambar 2. 9 Contoh Daftar Akun 

2. Pembuatan Daftar Akun 

Program MYOB menyediakan tiga pilihan untuk pembuatan daftar akun: 

a) Memilih salah satu yang disediakan oleh MYOB 
b) Mengimport daftar akun  
c) Membuat atau mengetik daftar akun sendiri 

Dalam pembelajaran kali ini akan dipraktekkan opsi (b) yaitu mengimport 
daftar akun. Untuk itu anda harus mempunyai text file yang sudah 
tersimpan di folder tertentu di komputer anda. 

Hal-hal yang perlu diperhatikan dalam mengimport daftar akun adalah: 

a) Format file daftar akun dalam bentuk text file (tab delimeted). 
b) Field-field daftar akun harus mengikuti format dalam MYOB v18. 
c) Daftar akun yang digunakan oleh perusahaan yang terkait (lihat Daftar 

Akun pada Lembar Kerja Peserta Didik). 
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Praktekkan langkah-langkah mengimpor daftar akun berikut ini: 

 

1 
 

Dobel Klik ikon MYOB Accounting. Kemudian klik Open pada Menu Utama 

untuk membuka file. 
 

 

Gambar 2. 10 Open MYOB 

 

2 

 

Klik folder Documents. Klik nama file RMM-1.MYO dan klik Open 

 

 

Gambar 2. 11 Open File 
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3 Membuat file daftar akun yang akan dimport dengan  cara: 

 Pertama, copy tabel daftar akun yang ada di lembar kerja peserta didik;  

 Kedua, buka program NotePad dan paste tabel yang dicopy ke 

NotePad; 

 Ketiga, file daftar akun yang ada di NotePad disimpan di folder My 

Document dengan nama: Daftar-Akun-UDRMM. Tutup NotePad. 

(lihat gambar berikut) 

 

 
Gambar 2. 12 Open File 
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4 

 

Klik menu bar File > Import Data > Account > Account Information. 
 

 

 

Gambar 2. 13 Import Data 

 

 

5 

 

Pada box Duplicate Records ubah Reject Them ke Update Existing Record. 
Kemudian klik Continue 

  

 

Gambar 2. 14 Update Existing Record 
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6 Pilih  file: Daftar-Akun-UDRMM yang disimpan di folder Documents. Klik Open 

 

 
Gambar 2. 15 Nama File untuk diimport 

 

7 

 

Pilih field-field yang akan diimpor dengan cara klik field kiri dan klik field di kanan 

untuk baris yang sesuai.  Klik Import untuk memproses. 

  

 

Gambar 2. 16 Pemilihan Field-field 
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8 Laporan hasil import akan ditampilkan setelah proses selesai. Klik OK untuk 

mengakhiri. 

  

 

Gambar 2. 17 Hasil Import 

3. Penyesuaian Linked Accounts  

Program MYOB sudah membuat hubungan akun (linked accounts) untuk 
beberapa akun, diantaranya seperti Cheque Account dan Trade Debtors. 
Fungsi akun-akun ini sudah digantikan oleh  Cash In Bank dan Account 
Receivable, tetapi justru belum ada linked-nya. Oleh sebab itu  anda perlu 
menyesuaikan hubungan akun-akun ini dan juga akun-akun lainnya. 

Linked accounts untuk Banking 

 

1 
Klik Setup > Linked Accounts > Accounts & Banking Accounts.  

Ubah link  untuk Historical Balancing dari 3-0999 menjadi 3-9999, dan 
Electronic Clearing Account → 1-1160 serta Undeposited Funds →1-
1150. Klik OK. 

 

 
Gambar 2. 18 Banking Linked Account 
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Linked account untuk Sales 

 

1 
 

Klik Setup > Linked Accounts > Sales. Ubah 1-0200 Trade Debtor menjadi 1-
1210 Account Receivable. Ubah 1-0100 Cheque Account menjadi 1-1110 
Cash in Bank. Lengkapi data yang lainnya seperti di bawah ini. Klik OK 

 

 

Gambar 2. 19 Sales Linked Accounts 

Linked Account untuk Purchase 

 

1 

 

Klik Setup > Linked Accounts > Purchases. Ubah 2-0200 Trade Creditor 
menjadi 2-1200 Account Payable, Ubah 1-0100 Cheque Account menjadi  
1-1110 Cash in Bank. Lengkapi data yang lainny kemudian klik OK. 

 

 

Gambar 2. 20 Purchase Linked Accounts 
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Linked Account untuk Payroll 

 

1 
 

Klik Setup > Linked Accounts > Payroll Accounts. Sesuaikan akun-akun seperti 
gambar di samping kanan, kemudian klik OK. 

 

 

Gambar 2. 21 Payroll Linked Accounts 

4. Menghapus/mengedit  akun-akun  

Setelah penyesuaian linked accounts, maka ada beberapa akun lama (di-
create oleh MYOB) yang bisa dihapus atau diedit.  
 
Akun-akun yang bisa dihapus 

1-0100  Cheque Account 

1-0150  Provision Account 

1-0160  Investment Account 

1-0180  Undeposited Funds 

1-0190  Electronic Clearing Account 

1-0200  Trade Debtors 

2-0200  Trade Creditor 

2-0300  Payroll Acrual Payable 

3-8000  Retained Earnings 

3-9000  Current Year Earnings 

3-0999  Historical Balancing 

 

Akun-akun yang harus di-edit 

3-0800  Retained Earnings 

3-0900  Current Year Earnings 

Diubah 

Diubah 

3-8000  Retained Earnings 

3-9000  Current Year Earnings 
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Langkah menghapus/mengedit akun 

 

1 Klik Setup > Easy Setup Assisstant. Klik Accounts. Klik Next 
 

 

Gambar 2. 22 Accounts – Easy Setup assistant 
 

2 
 

MYOB menyediakan fasilitas Accounts - Easy Setup Assistant untuk memu-
dahkan menghapus akun atau  mengedit akun dan juga untuk menambah akun 
baru. 

 

 

Gambar 2. 23 New, Edit and Delete accounts 

  

Klik Cheque Account dan klik Delete untuk menghapus akun tsb. Untuk mengedit 
akun, misalnya akan mengubah nomor akun klik Retained Earning dan klik Edit, 
kemudian ubah no akun dan klik OK untuk mengedit akun tsb.  
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c. Rangkuman 

• MYOB memberikan kode lima digit angka untuk setiap akun. Digit 
pertama untuk kategori akun, sedang digit kedua s.d. kelima 
merupakan nomor ID akun. Akun dibedakan dalam delapan kategori, 
yaitu: Assets (1), Liabilities (2), Equity (3), Income (4), Cost of Sales 
(5), Expense (6), Other Income (8) dan Other Expense (9). Kategori 
nomor 7 tidak dipergunakan. Ditinjau dari fungsi, akun dibedakan 2 
kelompok, akun header dan akun detail. 

• MYOB menyediakan tiga cara dalam pembuatan daftar akun, yaitu: 
pertama, menggunakan daftar akun yang disediakan oleh program; 
kedua, mengimpor akun yang telah disediakan oleh teknisi akuntansi; 
dan ketiga, membuat daftar akun sendiri. Dalam modul ini dijelaskan 
cara yang kedua, mengimpor daftar akun.  

• Setelah berhasil mengimport daftar akun, maka tahap berikutnya 
adalah menyesuaikan linked-account untuk banking accounts, sales 
accounts, dan purchases accounts. Selanjutnya akun-akun yang 
tidak diperlukan dapat dihapus atau diedit.   

 

 

d. Tugas 

Berdasarkan Kasus Daftar Akun yang ada pada ‘Lembar Kerja Peserta 
Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan 
dalam KB2 ini melalui kerjasama kelompok. 

3. Tugas 1, Menyusun daftar akun dengan cara mengimport file Daftar-
Akun-UDRMM.txt 

4. Tugas 3, Menyesuaikan Linked account 

5. Tugas 4, Menghapus dan mengedit akun-akun tertentu 
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e. Tes Formatif 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Dalam MYOB, akun diberi kode dengan: 
a. Satu digit 
b. Dua digit 
c. Tiga digitt 
d. Empat digt 
e. Lima digit 

2. Dalam sistim pengkodean akun pada MYOB, digit pertama untuk: 
a. Header akun 
b. Detail akun 
c. Nomor ID akun 
d. Kategori akun 
e. Hubungan akun 

3. Dalam sistim pengkodean akun pada MYOB, digit ke-2 s.d.5 untuk: 
a. Header akun 
b. Detail akun 
c. Nomor ID akun 
d. Kategori akun 
e. Hubungan akun 

4. Kelompok akun yang nilainya dapat diposting: 
a. Akun Header  
b. Akun Detail 
c. Akun Header dan Akun Detail 
d. Akun Heading 
e. Akun Children 

5. Kelompok akun yang nilainya tidak dapat diposting: 
a. Akun Header  
b. Akun Detail 
c. Akun Header dan Akun Detail 
d. Akun Heading 
e. Akun Children 

6. Petty Cash termasuk kategori: 
a. Bank 
b. Account Receivable 
c. Other Current Assets 
d. Fixed Assets 
e. Other Assets 
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7. Store Supplies termasuk kategori: 
a. Bank 
b. Account Receivable 
c. Other Current Assets 
d. Fixed Assets 
e. Other Assets 

8. Wages Payable termasuk kategori: 
a. Credit Card 
b. Account Payable 
c. Other Current Liability 
d. Long Term Liability 
e. Other Liability 

9. Format file yang diimport untuk pembuatan daftar akun hendaknya dalam 
bentuk: 
a. Text (MS-DOS) 
b. Formated Text (space delimited) 
c. Unicode Text. 
d. Text (tab delimeted). 
e. CSV(comma delimited). 

10. Pada proses import daftar akun, pada kolom Duplicate Record diisi dengan 
Update Existing Record, hal ini berarti: 

a. Nama akun hasil import akan ditolak untuk no akun yang sama. 
b. Nama akun hasil import akan ditolak untuk nama akun yang sama 
c. Nama akun hasil import akan menggantikan (replace) untuk no akun 

yang sama 
d. No akun hasil import akan menggantikan (replace) untuk nama akun 

yang sama 
e. Tidak ada jawaban yang tepat. 

 

2. Tes Keterampilan. 

Berdasarkan Kasus Daftar Akun yang ada pada ‘Lembar Kerja Peserta 
Didik’, kerjakan  tes berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Menyusun daftar akun dengan cara mengimport file Daftar-
Akun-UDRMM.txt 

4. Tugas 2, Menyesuaikan Linked account 

5. Tugas 3, Menghapus dan mengedit akun-akun tertentu 
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f. Kunci Jawaban Tes Formatif 

1. Kunci Tes Pengetahuan 
 

Soal No. Jawaban  Soal No. Jawaban 

1 e  6 a 

2 d  7 c 

3 c  8 c 

4 b  9 d 

5 a  10 c 
 
 

2. Kunci Tes Keterampilan 
Tugas 1 & 3, Menyusun daftar akun (hasil akhir). 
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Tugas 2, Menyesuaikan Linked account 
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g. Lembar Kegiatan Peserta Didik 

 
Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 
didik di komputer melalui program MYOB versi 18. 

 

Kasus Daftar Akun untuk: 
Kasus 2.1. UD Rasela Media Mandiri atau  
Kausus 2.2. UD Riola Media Mandiri 
 

Account 
Number 

Account Name Header Account Type 

10000 Assets H Asset 

11000 Current Assets H Asset 

11100 Cash On Hand H Asset 

11110 Cash In Bank  Bank 

11120 Payroll Cheque Account  Bank 

11130 Cash Drawer  Bank 

11140 Petty Cash  Bank 

11150 Undeposited Funds  Bank 

11160 Electronic Clearing Account  Bank 

11210 Account Receivable  Accounts Receivable 

11220 Allowance for Doubtful Debts  Accounts Receivable 

11300 Merchandise Inventory H Asset 

11310 Inventory - Computers   Other Current Asset 

11320 Inventory - Printers   Other Current Asset 

11400 Other Current Assets H Asset 

11410 Supplies Inventory  Other Current Asset 

11420 Deposits Paid  Other Current Asset 

11430 Prepaid Insurance  Other Current Asset 

11440 Prepaid Rent  Other Current Asset 

12000 Fixed Assets H Asset 

12100 Store Equipment H Asset 

12110 Store Equip - at Cost  Fixed Asset 

12120 Store Equip - Accum Dep'n  Fixed Asset 

12200 Leasehold Improvements H Asset 

12210 Improvements at Cost  Fixed Asset 

12220 Improvements Amortisation  Fixed Asset 

12300 Demonstration Equipment H Asset 

12310 Demo Equip - at Cost  Fixed Asset 

12320 Demo Equip - Accum Dep'n  Fixed Asset 

12400 Office Equipment H Asset 
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Account 
Number 

Account Name Header Account Type 

12410 Office Equip - at Cost  Fixed Asset 

12420 Office Equip- Accum Dep'n  Fixed Asset 

12500 Furniture & Fixtures H Asset 

12510 Furniture Equip - at Cost  Fixed Asset 

12520 Furniture Equip- Accum Dep'n  Fixed Asset 

12600 Motor Vehicles H Asset 

12610 Motor Vehicles - at Cost  Fixed Asset 

12620 Motor Vehicles - Accum Dep'n  Fixed Asset 

20000 Liabilities H Liability 

21000 Current Liabilities H Liability 

21100 Credit Cards H Liability 

21110 Bankcard  Credit Card 

21120 MasterCard  Credit Card 

21200 Account Payable  Accounts Payable 

21210 A/P Accrual - Inventory  Other Current Liability 

21300 PPN Liabilities H Liability 

21310 PPN Collected  Other Current Liability 

21320 PPN Paid  Other Current Liability 

21330 PPN Payable  Other Current Liability 

21400 Payroll Liabilities H Liability 

21410 Wages & Salaries Payable  Other Current Liability 

21420 Hari Raya Incentive Payable  Other Current Liability 

21500 Customer Deposits  Other Current Liability 

21600 Income Tax Payable  Other Current Liability 

22000 Long Term Liabilities H Liability 

22100 Mandiri Loan  Long Term Liability 

22200 Other Long Term Liabilities  Long Term Liability 

30000 Equity H Equity 

31000 Rasela Marta's Equity H Equity 

31100 Rasela Marta's Capital  Equity 

31200 Rasela Marta's Drawings  Equity 

38000 Retained Earnings  Equity 

39000 Current Year Earnings  Equity 

39999 Historical Balancing  Equity 

40000 Income H Income 

41000 Sales H Income 

41100 Sales - Computers  Income 

41200 Sales - Printers  Income 

45000 Freight Collected  Income 
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Account 
Number 

Account Name Header Account Type 

46000 Late Fees Collected  Income 

48000 Miscellaneous Income  Income 

50000 Cost of Goods Sold H Cost of Sales 

51100 COGS - Computer  Cost of Sales 

51200 COGS - Printer  Cost of Sales 

53000 Sales Discounts  Cost of Sales 

60000 Expenses H Expense 

61000 General & Administrative Exp H Expense 

61200 Bank Charges  Expense 

61300 Depreciation  Expense 

61400 Subscriptions  Expense 

61500 Office Supplies  Expense 

61600 Purchase Discounts  Expense 

61700 Freight Paid  Expense 

61800 Late Fees Paid  Expense 

63000 Advertising & Promotion Exp H Expense 

63100 Advertising  Expense 

63110 In-store Promotions  Expense 

64000 Operating Expenses H Expense 

64100 Maintenance  Expense 

64200 Postage  Expense 

64300 Speedy - Internet  Expense 

64400 Rent  Expense 

64500 Telephone  Expense 

64600 Water  Expense 

64650 Electricity  Expense 

64700 Cleaning  Expense 

64800 Store Supplies  Expense 

64900 Merchandise Spoilage  Expense 

65100 Employment Expenses H Expense 

65110 Staff Amenities  Expense 

65120 Wages & Salaries  Expense 

65130 Workers' Compensation  Expense 

65140 Other Employer Expenses  Expense 

80000 Other Incomes H Other Income 

81000 Interest Income  Other Income 

90000 Other Expenses H Other Expense 

91000 Interest Expense  Other Expense 

92000 Income Tax Expense  Other Expense 
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Kegiatan Belajar 3 
Membuat Buku Pembantu 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada akhir 
sesi ini diharapkan peserta didik dapat:  

 
1. Menyiapkan Buku Pembantu/kartu piutang. 

2. Menyiapkan Buku Pembantu/kartu utang. 

3. Menyiapkan Buku Pembantu/kartu item persediaan. 

 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  
1. Kartu piutang dagang 
2. Kartu utang dagang 
3. Kartu item persediaan 

 
Program MYOB menggunakan istilah “kartu” yang fungsinya sama dengan buku 
pembantu. MYOB menyediakan menu untuk pembuatan kartu piutang (customer 
cards), kartu utang (supplier cards) dan kartu item persediaan (item cards). 
 
1. Kartu Piutang 

Kartu piutang berisi informasi tentang customer, meliputi identitas, history dan 
data lain. Kartu piutang ini berfungsi sebagai tempat mencatat mutasi 
(penambahan, pengurangan dan saldo) piutang dagang  sebagai akibat dari 
transaksi penjualan atau pelunasan piutang. 

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu piutang: 

a) Satu kartu untuk satu customer. 
b) Penentuan termin pembayaran, denda keterlambatan, dan pajak. 
c) Daftar customer UD Rasela Media Mandiri: 
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Langkah pembuatan buku pembantu piutang: 
 

1 
 

Klik Command Centre  Card File  > Card List > New. Card Type: Customer 
Ketik nama customer dan tekan [enter]. Lengkapi data customer lainnya pada 
tab Profile (lihat data Toko Ganesha Unggul). 

 

 

Gambar 2. 24 Customer Profile 
 

2 

 

Pada tab Selling Details lengkapi data Customer Term Information. 
Tax Code: PPN. Freight Tax Code: N-T. Klik OK 
 

 

 

Gambar 2. 25 Selling Details 

 

3 

 

Ulangi langkah-langkah 1 dan 2 untuk pembuatan kartu customer berikutnya, 
yaitu untuk Toko Global Persada. 
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2. Kartu Utang Dagang 

Kartu utang dagang berisi informasi tentang supplier, meliputi identitas,  
history, dan juga data lainnya. Kartu utang ini berfungsi sebagai tempat 
mencatat mutasi (penambahan dan pengurangan) utang sebagai akibat dari 
transaksi pembelian atau pembayaran utang. 

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu utang adalah: 

a) Satu kartu untuk satu supplier. 
b) Penentuan termin pembayaran, denda keterlambatan, dan pajak. 
c) Daftar Supplier UD Rasela Media Mandiri: 

 

Langkah pembuatan buku pembantu utang: 

 

1 
 

Klik Command Centre  Card File  > Card List > New. Card Type: Supplier 
Ketik nama supplier dan tekan [enter]. Lengkapi data supplier lainnya pada tab 
Profile (lihat data PT Merbabu Raya) 

 

 

Gambar 2. 26 Supplier Profile 

 

 

 

 

 

 



 
Komputer Akuntansi Jilid 2  

Direktorat Pembinaan SMK (2013) 
53 

 

2 

 

Pada tab Buying Details lengkapi data Supplier Term Information. 
Tax Code: PPN. Freight Tax Code: N-T. Klik OK 

 
 

 

Gambar 2. 27 Buying Details 

 

3 

 

Ulangi langkah-langkah 1 dan 2 untuk pembuatan kartu supplier berikutnya, yaitu 
untuk PT Merapi Abadi. 
 

 

3. Kartu Item Persediaan 

Kartu item persediaan berfungsi sebagai tempat pencatatan saldo awal dan 
keluar masuknya setiap item persediaan.  

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu item persediaan: 

a) Satu kartu untuk mencatat satu item persediaan . 

b) Tentukan linked-account dengan Cost of Sales, Tracking Sales dan Asset 
Account untuk item persediaan yang terkait. 

c) Tentukan kuantitas dan harga pokok per unit. 

d) Daftar Item Persediaan UD Rasela Media Mandiri: 
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Langkah-langkah membuat buku pembantu persediaan: 

 

1 
 

Klik Command Centre  Inventory  > Item list  > New. Pada tab Profile, ketik 
identitas item  number & name. Set linked accounts: I Buy, I Sell, I Inven 
Klik tab Buying details (lihat data item persediaan HP Pro Book 4421s) 
 

 

 

Gambar 2. 28 Item COM-001 Profile 

 

2 

 

Klik Buying Details. Pada tab Buying Details lengkapi data pajak. Tax Code 
When Bought: pilih PPN 
 
 

 

 

Gambar 2. 29 Item COM-001 Buying Details 
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3 Klik Selling Details Pada tab Selling Details lengkapi data pajak. Tax Code 
When Sold: PPN. Klik option untuk Prices are Tax Inclusive.  
 

 

 

Gambar 2. 30 Item COM-001 Selling Details 

 

4 
 

Klik OK. Item No. COM-001 sudah tercatat di daftar seperti terlihat di gambar 
samping. Klik New untuk membuat kartu item berikutnya. 
 

 

 

Gambar 2. 31 Item COM-001 List 

 

5 

 

Ulangi langkah-langkah yang sama1 s.d. 4 untuk pembuatan kartu item 
berikutnya, yaitu untuk COM-002 HP Pro Book 5530. Yakinkan bahwa dalam tab 
‘All Items’ akan ada dua item yaitu COM-001 dan COM-002. 
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6 Klik New untuk membuat kartu item berikutnya yaitu PRN-001. Ketik identitas 
item tersebut seperti dalam gambar berikut. 
 

 

 

Gambar 2. 32 Item PRN-001 Profile 

 

7 

 

Klik Buying Details. Pada tab Buying Details lengkapi data pajak. Tax Code 
When Bought: PPN 
 

 

 

Gambar 2. 33 Item COM-001 Buying Details 
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8 Klik Selling Details. Pada tab Selling Details lengkapi data pajak. Tax Code 
When Sold: PPN. Klik option untuk Prices are Tax Inclusive. 
 

 

 

Gambar 2. 34 Item COM-001 Selling Details 

 

9 

 

Klik New untuk membuat kartu item berikutnya.  yaitu.  Ulangi langkah-langkah 
yang sama 6 s.d. 8 untuk pembuatan kartu item berikutnya, yaitu untuk PRN-002  
Printer Canon BJ-555. Yakinkan bahwa dalam tab ‘All Items’ akan ada empat 
item yaitu COM-001, COM-002, PRN-001 dan PRN-002 
 

                         

c. Rangkuman 

         

 MYOB menyediakan menu untuk membuat buku tambahan berupa kartu, 
yakni kartu piutang (customer cards) dan kartu utang (supplier cards). 
Dalam MYOB, setiap item barang dagangan juga dicatat dalam satu format 
(sejenis kartu). Pada prinsipnya, kartu-kartu tersebut merupakan detil 
penjabaran dari akun-akun buku besar seperti piutang dagang, utang 
dagang dan Persediaan barang. 

 Dalam proses pembuatan kartu-kartu tersebut ada Linked-Account yang 
harus diset dengan akun-akun tertentu sehinga apabila terjadi transaksi-
transaksi yang terkait dengan kartu tertentu maka secara otomatis jumlah-
jumlah yang tertulis di dalam kartu akan bertambah atau berkurang. 

 Yang perlu diperhatikan dalam proses pembuatan kartu adalah bahwa 
kartu harus dibuat terlebih dahulu sebelum diisi dengan saldo awalnya. 
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d. Tugas 

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada 
‘Lembar Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Membuat kartu Piutang (2 Customer) 

4. Tugas 2, Membuat kartu Utang (2 Supplier) 

5. Tugas 3, Membuat kartu Item Persediaan (4 item) 

 

e. Tes Formatif 

 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Menu yang digunakan untuk membuat kartu piutang (customer card): 
a. Card File  > Card List > New > Pilih Card Type Supplier 
b. Card List > Card File  > New > Pilih Card Type Customer 
c. Card File  > New > Card List > Pilih Card Type Customer 
d. Card List > Card File  > New > Pilih Card Type Supplier 
e. Card File  > Card List > New > Pilih Card Type Customer 

2. Jika termin pembayaran piutang N/30, maka pilihan yang tepat untuk 
Payment is Due: 
a. COD 
b. On a Day of the Month 
c. # of Days after EOM 
d. In a Given # of Days 
e. Day of Month ater EOM 

3. Menu yang digunakan untuk membuat kartu utang (supplier card) 
a. Card File  > Card List > New > Pilih Card Type Supplier 
b. Card List > Card File  > New > Pilih Card Type Customer 
c. Card File  > New > Card List > Pilih Card Type Customer 
d. Card List > Card File  > New > Pilih Card Type Supplier 
e. Card File  > Card List > New > Pilih Card Type Customer 

4. Dalam pembelian dinyatakan bahwa Freight Tax Code: N-T, artinya: 
a. Ada beban pajak dalam pembelian 
b. Tidak ada beban pajak dalam pembelian 
c. Ada beban pajak dalam pembayaran biaya angkut pembelian 
d. Tidak ada beban pajak dalam pembayaran biaya angkut pembelian 
e. Tidak ada beban pajak dalam pembelian dan biaya angkut 
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5. Menu yang digunakan untuk membuat kartu item persediaan: 
a. Card File  > Item List > New 
b. Inventory  > Inventory Item  > New. 
c. Card File  > Inventory Item > New 
d. Inventory  > Item list  > New. 
e. Item list  > Inventory  > New. 

6.  I Buy This Item.     I Sell This Item.    I Inventory This Item. Ini berarti 
Item tersebut adalah: 
a. Item barang dagangan 
b. Item berupa jasa 
c. Item berupa barang dagangan dan jasa 
d. Item barang dalam proses 
e. Item bahan mentah  

7. Linked account untuk Cost of Sales Account adalah: 
a. Sales of Item 
b. Purchases Product 
c. Merchandise Inventory 
d. Sales Product 
e. Cost of Goods Sold 

8. Linked account untuk Income account for Tracking Sales adalah: 
a. Cost of Sales 
b. Purchases Product 
c. Merchandise Inventory 
d. Sales Product 
e. Cost of Goods Sold 

9. Apa yang akan terjadi apabila kolom ’Tax Code When Bought’ diisi dengan 
N-T : 
a. Pada saat pembelian dan penjualan barang tidak akan diperhitungkan 

PPN-nya. 
b. Pada saat penjualan barang tidak akan diperhitungkan PPN-nya. 
c. Pada saat pembelian barang tidak akan diperhitungkan PPN-nya. 
d. Pada saat pembelian dan penjualan barang secara otomatis akan 

diperhitungkan PPN-nya. 
e. Pada saat pembelian barang akan diperhitungkan PPN-nya. 

10. Apa yang akan terjadi apabila kolom ’Tax Code When Sold’ diisi dengan 
PPN : 
a. Pada saat pembelian dan penjualan barang akan diperhitungkan PPN-

nya. 
b. Pada saat pembelian barang tidak akan diperhitungkan PPN-nya. 
c. Pada saat penjualan barang akan diperhitungkan PPN-nya. 
d. Pada saat pembelian barang secara otomatis akan diperhitungkan 

PPN-nya. 
e. Pada saat penjualan barang tidak akan diperhitungkan PPN-nya. 
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2. Tes Keterampilan. 

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta 
didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Membuat kartu Piutang (2 Customer) 

4. Tugas 2, Membuat kartu Utang (2 Supplier) 

5. Tugas 3, Membuat kartu Item Persediaan (4 item) 

 

 

f. Kunci Jawaban Tes Formatif 

 
1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 e  6 a 

2 d  7 e 

3 a  8 d 

4 c  9 c 

5 d  10 C 
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2. Kunci Tes Keterampilan 
 
Tugas 1, Membuat kartu Piutang (2 Customer) 
 

 

 

Tugas 2, Membuat kartu Utang (2 Supplier) 
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Tugas 3, Membuat kartu Item Persediaan (4 item) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Komputer Akuntansi Jilid 2  

Direktorat Pembinaan SMK (2013) 
63 

g. Lembar Kerja Peserta Didik  

 
Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 
didik di komputer melalui program MYOB versi 18. 
 

 
Kasus 3.1 : Kasus UD Rasela Media Mandiri. 

 
Daftar Customers 

Kode Nama Alamat Telepon 

C-001 Toko Ganesha Unggul Jl. Setia Budi 23, Pamulang  021 7431270 

C-002 Toko Global Persada Jl. Cendana 11, Ciputat 021 7431171 

 
Catatan:   
Termin pembayaran untuk Customer: 2/10, n/30 dan denda late payment 2%. 
 

Daftar Suppliers 

Kode Nama Alamat Telepon 

S-001 PT Merbabu Raya Jl. Gajah Mada 12 Jakarta  021 4433000 

S-002 PT Merapi Abadi  Jl. Mangga Dua 29 Jakarta 021 2335577 

 
Catatan:   
Termin pembayaran dari Supplier: 3/10, n/30 dan denda late payment 2%. 
Persediaan Barang Dagangan 

Tabel persediaan barang dagangan per awal januari 2013. 
 

No Kode Nama Barang Kelompok Jml 

Unit 

Cost/Unit Total 

1 COM-001 HP Pro book 4421s Computer 20 9.000.000,- 180.000.000,- 

2 COM-002 HP Pro book 5530 Computer 12 11.000.000,- 132.000.000,- 

3 PRN-001 Canon Lj-215 Printer 40 650.000,- 26.000.000,- 

4 PRN-002 Canon Bj-555 Printer 40 350.000,- 14.000.000,- 

 
Pencatatan Persediaan  

 Sistem pencatatan persediaan: sistem perpetual. 

 Metode perhitungan: metode rata-rata bergerak (moving average). 
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Kasus 3.2 : Kasus UD Riola Media Mandiri. 
 

Daftar Suppliers 

Kode Nama Alamat Telepon 

S-001 PT Merbabu Raya Jl. Gajah Mada 12 Jakarta   021 4433000 

S-002 PT Merapi Abadi  Jl. Mangga Dua 29 Jakarta 021 2335577 

 
Catatan:   
Termin pembayaran dari Supplier: 3/10, n/30 dan denda late payment 2%. 

 

Daftar Customers 

Kode Nama Alamat Telepon 

C-001 Toko Ganesha Unggul Jl. Setia Budi 23, Pamulang  021 7431270 

C-002 Toko Global Persada Jl. Cendana 11, Ciputat 021 7431171 

 
Catatan:   
Termin pembayaran untuk Customer: 2/10, n/30 dan denda late payment 2%. 
 

Persediaan Barang Dagangan 

UD Riola Media Mandiri bergerak dalam bidang penjualan komputer dan barang-barang 
elektronik lainnya. Berikut tabel persediaan barang dagangan per awal januari 2013. 
 

No Kode Nama Barang Kelompok Jml 

Unit 

Cost/Unit Total 

1 COM-001 HP Pro book 4421s Computer 20 9.000.000,- 180.000.000,- 

2 COM-002 HP Pro book 5530 Computer 12 11.000.000,- 132.000.000,- 

3 PRN-001 Canon Lj-215 Printer 40 650.000,- 26.000.000,- 

4 PRN-002 Canon Bj-555 Printer 40 350.000,- 14.000.000,- 

 
Pencatatan Persediaan  

 Sistem pencatatan persediaan: sistem perpetual. 

 Metode perhitungan: metode rata-rata bergerak (moving average). 
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Kegiatan Belajar 4 
Mengentri Saldo Awal 

 
a. Tujuan Pembelajaran 

 
Dengan diberikan kasus akuntansi perusahaan dagang, maka pada akhir 
sesi ini diharapkan peserta didik dapat:  

1. Mencatat Saldo awal akun buku besar. 

2. Mencatat Saldo awal buku pembantu piutang. 

3. Mencatat Saldo awal buku pembantu utang. 

4. Mencatat Saldo awal buku pembantu persediaan 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Entri saldo awal akun buku besar. 

2. Entri saldo awal buku pembantu piutang. 

3. Entri saldo awal buku pembantu utang. 

4. Entri saldo awal buku pembantu persediaan 

 
1. Entry Saldo Awal Akun Buku Besar 

Entri saldo awal akun buku besar dilakukan pada saat konversi ke sistem 
baru. Jika bulan konversi sama dengan bulan awal periode akuntansi maka 
hanya bisa dientri saldo-saldo dari akun-akun neraca. Apabila bulan konversi 
tidak sama dengan bulan awal periode akuntansi maka bisa dientri saldo-
saldo dari akun neraca dan akun laba-rugi. 

Hal-hal yang perlu diperhatikan dalam entri saldo awal akun buku besar: 

a) Ada dua cara, bisa melalui menu Command Centre Accounts > 
Account List > Edit Account satu per satu atau melalui menu utama 
Setup > Balances > Account Opening Balances. Cara yang ke-dua ini 
cenderung lebih mudah untuk mengontrol nilai Historical Balancing. 

b) Jika nilai akun Historical Balancing = 0, ini berarti bahwa total akun-akun 
assets sama dengan total akun-akun Liability dan Equity. Jika  nilai akun 
Historical Balancing ≠ 0, ini berarti bahwa telah terjadi ketidak-
seimbangan antara total assets dengan total Liability dan Equity. 

c) Akun-akun kontra dientri dengan tanda ”–” (minus). Yang termasuk akun 
kontra: Allowance for Doubtful Debts, Fixed Assets Accumulation 
Depresiation, Owner’s Drawing, Other Contra Account. 
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d) Data Neraca Saldo UD Rasela Media Mandiri: 
 

 
 

Langkah-langkah Entry Saldo Awal Akun 
 

 

1 

 

Klik  Setup > Balance > Account Opening Balance 
Entri saldo akun satu per satu dengan nilai positif kecuali akun-akun yang 
nilainya negatif (akun kontra). 
 

 

2 
 

Cek saldo akun Historical Balancing di bawah, nilai 0 adalah tanda seimbang 

dalam persamaan dasar akuntansi.  
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Gambar 2. 35 Saldo Awal Akun Buku Besar 

 

 
2. Entry Saldo awal buku pembantu piutang 

Pencatatan saldo awal buku pembantu piutang atau kartu piutang dilakukan 
pada saat konversi. Program MYOB akan mengecek kesamaan total semua 
kartu piutang dengan saldo akun Piutang Dagang (Account Receivable). Jika 
terjadi kesamaan atau ketidaksamaan maka program MYOB akan 
memberikan pesan atau peringatan (warning). 
Hal-hal yang perlu diperhatikan dalam pencatatan saldo awal piutang: 

a) Ada dua cara. Cara yang pertama, melalui menu Setup > Balances > 
Customer Balances > Pilih Customer > Add Sale. Cara kedua melalui 
menu Setup, Easy Setup Assistant > Sales > Historical Sales > Add 
Sale. Cara pertama yang lebih banyak digunakan 

Eti
ka 
Pr
ofe
si 
 

(C
2-
2) 
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b) Entri saldo kartu piutang sampai muncul pesan: Congratulations, yang 
menandakan jumlah piutang di Customer list sama dengan jumlah piutang 
di Account Opening Balances. 

c) Kasus UD Rasela Media Mandiri: 

 

Langkah-langkah entri saldo awal kartu piutang: 

 

1 

 

Klik  Setup > Balance > Customer Balance. Klik opsi Customer Details. 
Pilih nama customer. Klik Add Sale 

 

 

Gambar 2. 36 Add Sale 

 

 

 

 

 

 



 
Dasar-dasar Perbankan Jilid 2 

Direktorat Pembinaan SMK (2013) 
69 

 

2 
Klik [Enter] untuk menampakkan format.  Entri data ke dalam format. Jika telah 
selesai diisi klik Record . Peringatan dari MYOB: Please Note:......... untuk ini 
klik OK. 
 

 
 

 

Gambar 2. 37 Historical Sale 

 

3 

 

Saldo pembantu piutang yang pertama sudah tercatat. Klik Add Sale untuk entri 
saldo pembantu piutang berikutnya atau klik Close jika sudah selesai. 

 
 

 

Gambar 2. 38 Customer Balances 

 

4 

 

Ulangi langkah-langkah 1 dan 3 untuk entri saldo awal buku pembantu piutang 
berikutnya, yaitu untuk Toko Global Persada. 
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3. Entry Saldo awal buku pembantu persediaan 
 
Setelah disiapkan buku pembantu atau kartu item persediaan, tahap 
berikutnya adalah mencatat saldo awal untuk masing-masing item. Ada dua 
cara pencatatan saldo awal item persediaan. Kedua cara ini akan berakhir 
pada ujung yang sama yaitu Adjust Inventory.  

Hal-hal yang perlu diperhatikan dalam entri saldo awal item barang:  

a) Cara pertama memakai menu Command Centre Inventory > Count 
Inventory > ketik kuantitas untuk setiap Item > Adjust Inventory > 
Continue > Opening Balances > ketik unit cost & nomor akun untuk 
setiap item. 

b) Cara kedua langsung  menggunakan menu Command Centre Inventory 
> Adjust Inventory > kemudian ketik kuantitas, unit cost & nomor akun 

untuk setiap item 

c) Cara kedua yang akan digunakan untuk latihan karena lebih praktis. 

d) Kasus UD Rasela Media Mandiri, Daftar Persediaan Barang: 

 

Langkah-langkah entri saldo awal buku pembantu persediaan: 

 

1 

 

Klik Command Centre Inventory > Adjust Inventory. Ketik data berikut: 

 

2 

 

Gambar 2. 39 Adjust Inventory 
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2 Cek data persediaan yang telah di Record dalam Jurnal dengan cara klik 
Command Centre Inventory > Transaction Journal. Sesuaikan tanggal dari 
1/12/2012 s.d. 31/01/2013. 

 
 

 

Gambar 2. 40 Inventory Transaction Journal 

 

c. Rangkuman 

Pencatatan saldo awal untuk akun-akun buku besar, untuk kartu piutang, 
kartu utang dan kartu item persediaan dilakukan pada saat pindah ke sistem 
yang baru (komputerisasi akuntansi). Jadi hanya satu kali saja proses 
tersebut, selanjutnya saldo-saldo ini akan dihitung dan ditampilkan secara 
otomatis oleh MYOB pada awal periode berikutnya. 

Kebenaran entri saldo awal buku besar ditandai akun Historical Balancing 
yang mempunyai saldo Rp. 0,- (NOL). Untuk kartu piutang dan kartu utang, 
kebenaran entri saldo ditandai dengan adanya pesan “Congratulation” yang 
diberikan oleh MYOB. Sedang untuk entri saldo item persediaan dikatakan 
benar jika dicek bahwa total cost untuk seluruh item sama dengan jumlah 
persediaan yang tertulis di dalam buku besar. 

 

d. Tugas 

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada 
‘Lembar Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 

kelompok. 
2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 

KB3 ini melalui kerjasama kelompok. 
3. Tugas 1, Mengentri saldo Awal Buku Besar. 
4. Tugas 2, Mengentri saldo Kartu Piutang (2 Customer) 
5. Tugas 3, Mengentri saldo Kartu Utang (2 Supplier) 
6. Tugas 4, Mengentri saldo Kartu Persediaan (4 item) 
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e. Tes Formatif 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Menu untuk mengentri saldo akun buku besar adalah: 
a. Setup > Easy Setup Assisstant > Account Opening Balances 
b. Setup > Easy Setup Assisstant >Balances  
c. Setup > Balances > Account Opening Balances 
d. Easy Setup Assisstant > Balances > Account Opening Balances 
e. Setup > Easy Setup Assisstant  > Balances  > Account Opening 

Balances 

2. Akun yang termasuk dalam “Kontra Akun” berikut ini adalah: 
a. Allowance for Doubtful Debt 
b. Account Payable 
c. Bad Debt 
d. Depreciation of Office Equipment 
e. Prepaid Insurance 

3. Jika dalam pencatatan saldo awal ditunjukkan bahwa Historical Balancing 
terdapat saldo Rp. 550.000,- ini memberi tanda: 
a. Terdapat kesalahan input sebesar Rp. 550.000,- 
b. Jumlah debet lebih kecil sebesar Rp. 550.000,- 
c. Jumlah debet lebih besar sebesar Rp. 550.000,- 
d. Terdapat kelebihan kredit sebesar Rp. 550.000,- 
e. Tidak bermasalah, karena itu adalah saldo akun tersebut. 

4. Jika dalam pencatatan saldo awal ditunjukkan bahwa Historical Balancing 
terdapat saldo minus Rp. 550.000,- ini memberi tanda: 
a. Terdapat kesalahan input sebesar Rp. 550.000,- 
b. Jumlah debet lebih kecil sebesar Rp. 550.000,- 
c. Jumlah debet lebih besar sebesar Rp. 550.000,- 
d. Terdapat kelebihan debet sebesar Rp. 550.000,- 
e. Tidak bermasalah, karena itu adalah saldo akun tersebut. 

5. Menu untuk mengentri saldo kartu piutang dagang adalah: 
a. Easy Setup Assistant > Sales > Historical Sales > Add Sale 
b. Setup > Customer Balances > Balances > Add Sale> Pilih Customer 
c. Setup > Easy Setup Assistant > Sales > Add Sale 
d. Setup > Balances > Customer Balances> Pilih Customer > Add Sale 
e. Setup > Balances > Customer Balances> > Add Sale> Pilih Customer 
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6. Mengentri saldo seluruh kartu piutang dianggap berhasil apabila: 
a. Tidak ada saldo kartu piutang yang dobel dientri 
b. Seluruh saldo kartu piutang berhasil dientri ke dalam komputer 
c. Seluruh saldo kartu piutang berhasil dientri ke dalam komputer dan 

terakhir muncul pesan ”Congratulation” 
d. Ada pesan ”Congratulation”, walaupun belum semua saldo dientri 
e. Ada pesan ”Congratulation”, walaupun ada saldo kartu piutang yang 

dobel dientri 

7. Menu untuk mengentri saldo kartu utang dagang adalah: 
a. Setup > Supplier Balances > Pilih Customer > Add Purchase 
b. Setup > Balances >  Pilih Customer > Add Purchase 
c. Balances > Supplier Balances > Pilih Customer > Add Purchase 
d. Setup > Balances > Supplier Balances > Pilih Customer > Add 

Purchase 
e. Setup Assisstant > Balances > Supplier Balances > Pilih Customer > 

Add Purchase 

8. Dalam kartu utang tertulis termin pembayaran 2% 10 Net 30, artinya: 
a. Diskon 2% dari jumlah utang apabila dibayar dalam waktu 10-30 hari. 
b. Diskon 2% dari jumlah utang apabila dibayar dalam waktu setelah10 

hari sampai dengan 30 hari 
c. Diskon 10% dari jumlah utang apabila dibayar dalam waktu 10 hari, 

Jika tidak, maka jatuh tempo pembayaran utang 30 hari. 
d. Diskon 2% dari jumlah utang apabila dibayar dalam waktu 10 hari, Jika 

tidak, maka jatuh tempo pembayaran utang 30 hari 
e. Diskon 10% dari jumlah utang apabila dibayar dalam waktu 10 hari, 

Jika tidak, maka jatuh tempo pembayaran utang 30 hari 

9. Menu untuk mengentri saldo item-item persediaan: 
a. Count Inventory  > Inventory > Adjust Inventory 
b. Inventory > Count Inventory  > Adjust Inventory 
c. Inventory > Adjust Inventory 
d. Inventory > Count Inventory > Adjust Inventory > Opening Balances 
e. Inventory >  Adjust Inventory > Continue > Opening Balances  

10. Menu untuk melihat tampilan jurnal setelah record Adjust Inventory: 
a. Count Inventory  > Inventory > Adjust Inventory 
b. Inventory > Count Inventory  > Adjust Inventory 
c. Inventory > Adjust Inventory 
d. Inventory > Count Inventory > Adjust Inventory > Opening Balances 
e. Inventory > Transaction Journal 
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2. Tes Keterampilan. 

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta 
didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Mengentri saldo Awal Buku Besar. 

4. Tugas 2, Mengentri saldo Kartu Piutang (2 Customer) 

5. Tugas 3, Mengentri saldo Kartu Utang (2 Supplier) 

6. Tugas 4, Mengentri saldo Kartu Persediaan (4 item) 

 

f. Kunci Jawaban Tes Formatif 

 

1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 c  6 c 

2 a  7 d 

3 c  8 d 

4 b  9 c 

5 d  10 e 
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2. Kunci Tes Keterampilan 

Tugas 2, Mengentri saldo Kartu Piutang (2 Customer) 

 

Tugas 4, Mengentri saldo Kartu Persediaan (4 item) 
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Tugas 1, Mengentri saldo Awal Buku Besar. 
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g. Lembar Kerja Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 
didik di komputer melalui program MYOB versi 18. 

 

Kasus 4.1 : Kasus UD Rasela Media Mandiri. 
 

UD RASELA MEDIA MANDIRI 
Neraca Saldo Per 31 Desember 2012 

 
No. Akun Nama Akun Debit Kredit 

  Rp. Rp. 

1-1110 Cash In Bank 210.000.000  

1-1140 Petty Cash 5.000.000  

1-1210 Account Receivable 275.000.000  

1-1310 Inventory - Computers 312.000.000  

1-1320 Inventory - Printers 40.000.000  

1-1410 Supplies Inventory 4.300.000  

1-2110 Store Equip at Cost 100.000.000  

1-2120 Store Equip Accum Dep  10.000.000 

1-2310 Demo Equip at Cost 20.000.000  

1-2320 Demo Equip Accum Dep  2.000.000 

1-2410 Office Equip at Cost 60.000.000  

1-2420 Office Equip Accum Dep  12.000.000 

1-2510 Furniture Equip at Cost 80.000.000  

1-2520 Furniture Equip Accum Dep  16.000.000 

2-1200 Account Payable  187.000.000 

2-1600 Income Tax Payable  8.300.000 

2-2100 Bank Mandiri Loan  300.000.000 

3-1100 Rasela Marta Capital  571.000.000 

    

Jumlah 1.106.300.000 1.106.300.000 
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Daftar Saldo Piutang Dagang 
Per awal Januari 2013 
 

Kode Nama Keterangan Faktur Jumlah (Rp.) 

C-001 Toko Ganesha Unggul 

 

Faktur Penjualan No. FP-003 
tanggal 27-12-2012 

Termin 2/10, n/30 

Denda Late payment 2%/bl. 

209.000.000,- 

C-002 Toko Global Persada Faktur Penjualan No. FP-005 
tanggal 29-12-2012 

Termin 2/10, n/30 

Denda Late payment 2%/bl. 

66.000.000,- 

 Jumlah Total 275.000.000,- 

 
Daftar Saldo Utang Dagang 
Per awal Januari 2013 
 

Kode Nama  Keterangan Faktur Jumlah (Rp.) 

S-001 PT Merbabu Raya 

 

Faktur Pembelian No. CE-12 
tanggal 26-12-2012 

Termin 3/10, n/30 

Denda Late payemnt 3%/bl. 

110.000.000,- 

S-002 PT Merapi Abadi Faktur Pembelian No. B-215 
tanggal 28-12-2012 

Termin 3/10, n/30 

Denda Late payemnt 3%/bl. 

77.000.000,- 

 Jumlah Total 187.000.000,- 
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Kasus 4.2 : Kasus UD Riola Media Mandiri. 
 

UD RIOLA MEDIA MANDIRI 

Neraca Saldo Per 31 Desember 2012 

 
No. Akun Nama Akun Debit Kredit 

  Rp. Rp. 

1-1110 Cash In Bank 210.000.000  

1-1140 Petty Cash 5.000.000  

1-1210 Account Receivable 275.000.000  

1-1310 Inventory - Computers 312.000.000  

1-1320 Inventory - Printers 40.000.000  

1-1410 Supplies Inventory 4.300.000  

1-2110 Store Equip at Cost 100.000.000  

1-2120 Store Equip Accum Dep  10.000.000 

1-2310 Demo Equip at Cost 20.000.000  

1-2320 Demo Equip Accum Dep  2.000.000 

1-2410 Office Equip at Cost 60.000.000  

1-2420 Office Equip Accum Dep  12.000.000 

1-2510 Furniture Equip at Cost 80.000.000  

1-2520 Furniture Equip Accum Dep  16.000.000 

2-1200 Account Payable  187.000.000 

2-1600 Income Tax Payable  8.300.000 

2-2100 Bank Mandiri Loan  300.000.000 

3-1100 Rasela Marta Capital  571.000.000 

    

Jumlah 1.106.300.000 1.106.300.000 

 
Daftar Saldo Piutang Dagang 
Per awal Januari 2013 
 

Kode Nama Keterangan Faktur Jumlah (Rp.) 

C-001 Toko Ganesha Unggul 

 

Faktur Penjualan No. FP-003 
tanggal 27-12-2012 

Termin 2/10, n/30 

Denda Late payment 2%/bl. 

209.000.000,- 

C-002 Toko Global Persada Faktur Penjualan No. FP-005 
tanggal 29-12-2012 

Termin 2/10, n/30 

Denda Late payment 2%/bl. 

66.000.000,- 

 Jumlah Total 275.000.000,- 
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Daftar Saldo Utang Dagang 
Per awal Januari 2013 
 

Kode Nama  Keterangan Faktur Jumlah (Rp.) 

S-001 PT Merbabu Raya 

 

Faktur Pembelian No. CE-12 
tanggal 26-12-2012 

Termin 3/10, n/30 

Denda Late payemnt 3%/bl. 

110.000.000,- 

S-002 PT Merapi Abadi Faktur Pembelian No. B-215 
tanggal 28-12-2012 

Termin 3/10, n/30 

Denda Late payemnt 3%/bl. 

77.000.000,- 

 Jumlah Total 187.000.000,- 
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Kegiatan Belajar 5 
Mengentri Transaksi Penjualan  

 
 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 
akhir sesi ini diharapkan peserta didik dapat:  

 
1. Mencatat transaksi Order Penjualan (Sales Order)  

2. Mencatat transaksi Penjualan Kredit (Sales)  

3. Mencatat transaksi Penjualan Tunai (Counter Sales)  

4. Mencatat transaksi Retur Penjualan (Sales Return)  

5. Mencatat transaksi Retur Penjualan Tunai (Counter Sales Return)  

6. Mencatat transaksi Penerimaan Piutang (Receipt Payment) tanpa 
Discount 

7. Mencatat transaksi Penerimaan Piutang (Receipt Payment) dengan 
Discount 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  
1. Entri transaksi Order Penjualan (Sales Order)  
2. Entri transaksi Penjualan Kredit (Sales)  
3. Entri transaksi Penjualan Tunai (Counter Sales)  
4. Entri transaksi Retur Penjualan (Sales Return)  
5. Entri transaksi Retur Penjualan Tunai (Counter Sales Return)  
6. Entri transaksi Penerimaan Piutang (Receipt Payment) tanpa 

Discount 
7. Entri transaksi Penerimaan Piutang (Receipt Payment) dengan 

Discount 

Program MYOB menyediakan menu-menu pilihan untuk mengentri berbagai 
transaksi yang terkait dengan penjualan (Sales).  

 
Gambar 2. 41 Menu Sales 
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1. Entri Transaksi Order Penjualan (Sales Order) 

Hal-hal yang perlu diperhatikan dalam transaksi order penjualan: 

a) Tidak ada jurnal untuk Sales Order, jadi belum ada pengaruh apapun 
terhadap akun buku besar ataupun kartu piutang dan persediaan. 

b) Anda bisa lihat hasil entri pada menu Sales Register 

c) Selamanya akan tercatat di Sales Register kalau anda belum merubahnya 
menjadi Invoice. 

d) Dokumen sumber  Bukti No: 01 & 02: 
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Praktekkan langkah-langkah berikut ini: 
 

 

1 

 

Klik Command Centre Sales > Enter Sales 
 

2 
 

Klik Layout, pilih Item, klik OK.  Kemudian set ke format ORDER 
 

 

Gambar 2. 42 Select Layout Item 

 

3 Isi data Sales Order sesuai dengan dokumen sumber (Bukti No. 01). Kemudian 
klik  Record dan Klik Cancel. 

 
 

 

Gambar 2. 43 Sales Order 
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4 Untuk melihat Sales Order yang sudah dientri klik Command Centre Sales > 
Sales Register, kemudian klik Tab Order. Set Tanggal l 1/1/13 to 31/1/13 

 
 

 

 

Gambar 2. 44 Sales register 

 

5 

 

Ulangi langkah-langkah 1 dan 4 untuk mengisi data Sales Order sesuai dengan 
dokumen sumber (Bukti No. 02) 
 

 
 
2. Entri Transaksi Penjualan Kredit (Sales on Account)  

Hal-hal yang penting diingat dalam transaksi penjualan kredit: 

a) Berpengaruh terhadap: akun piutang dagang, akun penjualan, kartu 
piutang dan kartu persediaan. 

b) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum  klik Record. 
(Tekan Ctrl-R untuk mengecek jurnalnya). 

c) Dokumen sumber : Bukti No: 03 & 04 
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Praktekkan langkah-langkah berikut ini: 

 

1 

 

Klik Command Centre Sales > Sales Register, kemudian klik Tab Order. 

Klik Sales Order yang akan diubah menjadi Invoice, Klik Change to Invoice 

 
 

 

Gambar 2. 45 Change to Invoice 

 

3 

 

Isi data penjualan sesuai dengan dokumen sumber Bukti No. 03 Invoice. 

 

 

Gambar 2. 46 Sales Invoice 
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4 

 

Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 
Transaction.  

Kembali ke Invoice semula klik Record, dan klik Cancel 
 

 

Gambar 2. 47 Recap Transaction in Sales 

 

5 

 

Ulangi langkah-langkah 1 s.d. 4 untuk mengisi data penjualan sesuai dengan 
dokumen sumber (Bukti No. 04) 
 

 

3. Entri Transaksi Penjualan Tunai (Counter Sales) 

Hal-hal yang perlu diperhatikan dalam transaksi penjualan tunai: 

a) Dalam format Invoice kolom Paid Today diisi sebesar Total Amount. 

b) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum klik Record. 
(Tekan Ctrl-R untuk mengecek jurnalnya). 

c) Dokumen sumber : Bukti No: 05 & 06 
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Praktekkan langkah-langkah berikut ini: 

 

1 

 

Klik Command Centre  Sales > Enter Sales 

Pilih Customer: Counter Sales, karena belum ada maka anda perlu buat. 

Klik New dan Ketik Nama: COUNTER SALES, Card ID#: 00, Klik OK  
 

 

Gambar 2. 48 Counter Sales 

2 Pilih Customer: Counter Sales, kemudian isi data counter sales sesuai dengan 
dokumen sumber Bukti No: 05. Kolom Paid Today diisi sama dengan Total 
Amount. 

 
 

 

Gambar 2. 49 Counter Sales Invoice 
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3 

 

Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 
Transaction.  

Kembali ke Invoice semula klik Record, dan klik Cancel  untuk menutup format 
invoice. 

 
 

 

Gambar 2. 50 Recap Transaction in Counter Sales 

 

4 

 

Ulangi langkah-langkah 2 dan 3 untuk mengisi data counter sales sesuai dengan 
Bukti No: 06 
 

 

4. Entri Transaksi Retur Penjualan  (Sales Return)  

Hal-hal yang perlu diperhatikan dalam transaksi retur penjualan: 

a) Entri data seperti penjualan kredit tetapi quatity diketik angka minus. 

b) Jangan lupa masuk ke Sales Register  dan Tab Returns & Credits, 
untuk memproses pengurangan saldo dalam kartu customer klik Apply to 
Sale. 

c) Dokumen sumber : Bukti No: 07 & 08 
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Praktekkan langkah-langkah berikut ini: 

1 Klik Command Centre Sales > Enter Sales 

Entri data untuk retur penjualan, jangan lupa ketik Quantity (Ship) dengan 
angka minus. 

 

 
Gambar 2. 51 Sales Return 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup 

Recap Transaction. Kembali ke Invoice semula klik Record, dan klik 
Cancel 

 

 
Gambar 2. 52 Recap Transaction of Sales Return 
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3 Klik Command Centre Sales > Sales Register.  

Kemudian klik Tab Returns & Credits. Klik Apply to Sale untuk mengurangi 
jumlah piutang pada kartu customer. 

 

 
Gambar 2. 53 Returns & Credits 

4 Entry retur penjualan sudah tercatat sebesar Rp. 16.830.000,- Klik Apply to Sale 

 

 
Gambar 2. 54 Settle Returns & Credits 
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5 Sesuaikan data ID# dan Date dengan documen sumber Bukti No: 07. Kemudian 
Discount diset menjadi 0 dan posisikan mouse di kolom Amount Applied 
sejajar dengan SL-001 tgl. 04/01/2013 kemudian klik mouse. 

Jika dilihat jurnalnya, maka akan tampak seperti berikut ini: 

 

 

Gambar 2. 55 Recap Transaction in Sales Return (Complete Journal) 

 

6 

 

Ulangi langkah-langkah 1 s.d. 5 untuk mengisi data retur penjualan sesuai 
dengan Bukti No: 08 
 

 

5. Entri Transaksi Retur Penjualan Tunai 

Hal-hal yang perlu diperhatikan dalam transaksi retur penjualan tunai: 

a) Entri data seperti retur penjualan kredit, quatity diketik angka minus. 

b) Jangan lupa masuk ke Sales Register  dan Tab Returns & Credits, untuk 
memproses pembayaran kembali ke customer klik Pay Refund. 

c) Dokumen sumber : Bukti No: 09 & 10 
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Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
96 

Praktekkan langkah-langkah berikut ini: 

1 Klik Command Centre Sales > Enter Sales 

Entri data untuk retur penjualan, jangan lupa ketik Quantity (Ship) dengan 
angka minus. 

 

 

Gambar 2. 56 Counter Sales Return 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup 

Recap Transaction. Kembali ke Invoice semula klik Record, dan klik 

Cancel.  

Klik Command Centre Sales > Sales Register. Kemudian klik Tab 
Returns & Credits.  
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Gambar 2. 57 Sales register 

3 Klik Pay Refund untuk pembayaran kembali kepada customer. 

 

 

Gambar 2. 58 Pay Refund 
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4 Sesuaikan data Cheque No dan Date dengan documen sumber Bukti No: 

09. Kemudian klik Record. 

Jika dilihat jurnalnya, maka akan tampak seperti berikut ini: 

 

 

Gambar 2. 59 Jurnal retur penjualan Tunai 

5 Untuk menampakkan jurnal di atas, klik Sales > Transaction Journal. 

Kemudian set Dated from 01/01/2013 sd 31/1/2013. Pilih Tab All 

 
6 

 
Ulangi langkah-langkah 1 s.d. 5 untuk mengisi data retur penjualan tunai 
sesuai dengan Bukti No: 10 
 
 

6. Entri Transaksi Penerimaan Piutang (Receipt Payment) 

Hal-hal yang perlu diperhatikan dalam transaksi receipt payment: 

a) Menggunakan Command Centre Sales > Receive Payments BUKAN 
Banking > Receive Money. 

b) Harus memilih secara tepat Nama Customer dan Piutang yang terkait 
dengan pelunasan. 

c) Dokumen sumber : Bukti No: 11 & 12 
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Praktekkan langkah-langkah berikut: 

1 Klik Command Centre Sales > Receive Payments. Kemudian pilih nama 

customer sesuai dan isi data pelunasan piutang sesuai dengan dokumen sumber. 

 

 

Gambar 2. 60 Penerimaan Pelunasan Piutang 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction. Kembali ke Invoice semula klik Record, Print Later dan klik Cancel.  

 

 

Gambar 2. 61 Recap Transaction in Receive payments 

 

3 

 

Ulangi langkah-langkah 1 dan 2 untuk mengisi data penerimaan piutang sesuai 
dengan Bukti No: 12 
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7. Entri Transaksi Receipt Payment With Discount 

Hal-hal yang perlu diperhatikan dalam transaksi receipt payment  dengan 
diskon: 
a) Menggunakan Command Centre Sales > Receive Payments BUKAN 

Banking > Receive Money. 

b) Diskon yang menyebabkan pengurangan Pajak (PPN) dihilangkan. 

c) Dokumen sumber : Bukti No: 13 & 14 
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Praktekkan langkah-langkah berikut: 

1 Klik Command Centre Sales > Receive Payments. Kemudian pilih nama 

customer sesuai dan isi data sesuai dengan dokumen sumber. 

 

 
Gambar 2. 62 Penerimaan Pelunasan dengan Diskon 

2 Klik Record, Print Later dan klik Cancel.  Klik Command Centre Sales > 

Transaction Journal untuk menampakkan jurnalnya: 

 

 

Gambar 2. 63 Jurnal Penerimaan Pelunasan Piutang dengan Diskon 
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3 Klik di  (panah kiri)  untuk jurnal yang terkait dengan diskon (jurnal yang di 

tengah. 

 

 

Gambar 2. 64 Mengeliminasi PPN dalam Diskon 

4 Ubah PPN menjadi N-T untuk jumlah-jumlah yang ada dalam tabel di atas. 

Hasilnya adalah jurnal yang baru seperti berikut ini. Klik Close. 

 

 

Gambar 2. 65 Jurnal Eliminasi PPN dalam Diskon 

 

3 

 

Ulangi langkah-langkah 1 s.d. 4 untuk mengisi data penerimaan piutang dengan 
potongan sesuai dengan Bukti No: 14 
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c. Rangkuman 

• Biasanya transaksi penjualan (Sales), diawali dengan adanya order dari 
pelanggan, kemudian dilanjutkan dengan penjualan kredit/tunai, 
kadang-kadang terjadi retur, penerimaan piutang dan lain sebagainya. 
Semua transaksi tersebut disediakan menu dan format khusus oleh 
MYOB. Data transaksi dientri ke dalam format dan kemudian diproses 
secara otomatis.  

• Komputer akan memberikan hasil berupa laporan jurnal, saldo akun 
buku besar yang sudah di-update, bahkan laporan keuangan. 

• Untuk mencegah kesalahan dalam data entri maka dianjurkan sebelum 
di-record dicek terlebih dahulu jurnal yang akan dihasilkan dengan 
menekan Ctrl-R. 

 

d. Tugas 

 
Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Mencatat transaksi Order Penjualan (2 transaksi) 

4. Tugas 2, Mencatat transaksi Penjualan Kredit (2 transaksi) 

5. Tugas 3, Mencatat transaksi Penjualan Tunai (2 transaksi) 

6. Tugas 4, Mencatat transaksi Retur Penjualan (2 transaksi) 

7. Tugas 5, Mencatat transaksi Retur Penjualan Tunai (2 transaksi) 

8. Tugas 6, Mencatat transaksi Penerimaan Piutang tanpa diskon (2 
transaksi) 

9. Tugas 7, Mencatat transaksi Penerimaan Piutang dengan Discount (2 
transaksi) 
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e. Tes Formatif 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Jenis layout faktur yang biasa digunakan oleh perusahaan dagang: 
a. Service 
b. Item and Service 
c. Item 
d. Miscellaneous 
e. Sales > Sales Register > Pilih Order > Change to Invoice 

2. Langkah mengubah order penjualan menjadi penjualan kredit/tunai: 
a. Sales > Enter Sales 
b. Sales > Sales Register > Enter Sales 
c. Sales Register > Enter Sales 
d. Sales Register > Pilih Order > Change to Invoice 
e. Sales > Sales Register > Pilih Order > Change to Invoice 

3. Langkah mengentri transaksi penerimaan piutang dari debitur: 
a. Sales > Receive Money 
b. Sales > Receive Payment 
c. Sales Register > Receive Money 
d. Sales Register > Sales > Receive Payament 
e. Sales > Sales Register > Receive Money 

4. Langkah mengentri transaksi retur penjualan, pertama Sales > Enter Sales 
> Quantity minus. Kedua ... 
a. Sales > Enter Sales > Receive Payment 
b. Sales > Receive Payment 
c. Sales Register > Sales > Receive Payment > Apply to Sale 
d. Sales > Sales Register > Pilih Tab Returns & Credit > Apply to Sale 
e. Sales > Sales Register > Pilih Tab Returns & Debett > Apply to Sale 

5. Langkah mengentri transaksi penjualan counter atau tunai.... 
a. Sales > Enter Sales > Paid to Day diisi dengan total penjualan 
b. Sales > Paid to Day diisi dengan total penjualan  
c. Sales Register > Sales > Receive Payment 
d. Sales > Sales Register > Receive Payment 
e. Sales Register > Paid to Day diisi dengan total penjualan 

6. Dalam Faktur penjualan kolom untuk Tax Inclusive dicontreng  ini berarti 
kolom harga barang akan diisi dengan.... 
a. Harga jual plus PPN 5%. 
b. Harga jual plus PPN 10%. 
c. Harga jual plus PPN 15% 
d. Harga jual tidak termasuk PPN. 
e. Harga jual minus PPN. 
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7. Perintah untuk melihat jurnal Order Penjualan.... 
a. Sales > Sales Journals 
b. Sales > Sales Register > Sales Journal 
c. Sales Register > Sales > Sales Journal 
d. Tidak ada jurnal untuk Sales Order 
e. Ada jurnal untuk Sales Order 

8. Perintah untuk melihat jurnal Penjualan.... 
a. Sales > Sales Transaction Journals  
b. Sales > Sales Register > Sales Journal 
c. Sales Register > Sales > Sales Journal 
d. Sales > Sales Journals  
e. Sales > Transaction Journals  

9. Dalam pengisian data Faktur Penjualan, terlihat kolom ’Out of Balance’ 
berisi dengan Rp. 500.000,- . Apa yang akan terjadi jika diklik Record ? 
a. Jurnal penjualan akan diproses. 
b. Data yang tertulis di invoice akan dihapus. 
c. Jurnal penjualan tidak akan diproses karena ada pilihan yang salah. 
d. Jurnal penjualan akan diproses walapun ada data yang salah  
e. Jurnal penjualan tidak akan diproses karena jumlah debet dan kredit 

tidak seimbang. 

10. Perintah untuk mengecek jurnal penjualan sebelum diklik Record: 
a. Ctrl - C 
b. Sales > Transaction Journal. 
c. Ctrl - J 
d. Ctrl - R 
e. Sales > Sales Register 

 

2. Tes Keterampilan. 

Sesuaikan daftar pajak pada MYOB dengan Pajak yang berlaku di Indonesia 
(Lihat Kasus 1.1 di lembar kerja peserta didik):  

Berdasarkan Kasus 3.1. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Mencatat transaksi Order Penjualan (2 transaksi) 
4. Tugas 2, Mencatat transaksi Penjualan Kredit (2 transaksi) 
5. Tugas 3, Mencatat transaksi Penjualan Tunai (2 transaksi) 
6. Tugas 4, Mencatat transaksi Retur Penjualan (2 transaksi) 
7. Tugas 5, Mencatat transaksi Retur Penjualan Tunai (2 transaksi) 
8. Tugas 6, Mencatat transaksi Penerimaan Piutang tanpa diskon                 

(2 transaksi) 
9. Tugas 7, Mencatat transaksi Penerimaan Piutang dengan Discount           

(2 transaksi) 
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f. Kunci Jawaban Tes Formatif 

1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 c  6 b 

2 e  7 d 

3 b  8 e 

4 d  9 e 

5 a  10 d 
 

2. Kunci Tes Keterampilan 

Tugas 1 Transaksi Order Penjualan (2 transaksi) 

Tidak ada Jurnal 

Tugas 2, Transaksi Penjualan Kredit (2 transaksi) 
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Tugas 3, Transaksi Penjualan Tunai (2 transaksi) 

 

Tugas 4, Transaksi Retur Penjualan (2 transaksi) 
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Tugas 5, Transaksi Retur Penjualan Tunai (2 transaksi) 

 

 

Tugas 6, Transaksi Penerimaan Piutang tanpa diskon (2 transaksi) 
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Tugas 7, Transaksi Penerimaan Piutang dengan Discount (2 transaksi) 
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g. Lembar Kerja Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 
didik di komputer melalui program MYOB versi 18. 

 

Kasus 5.1 : Kasus UD Rasela Media Mandiri. 

Transaksi Order Penjualan (2 transaksi) 
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Transaksi Penjualan Kredit (2 transaksi) 
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Transaksi Penjualan Tunai (2 transaksi) 
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Transaksi Retur Penjualan (2 transaksi) 
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Transaksi Retur Penjualan Tunai (2 transaksi) 
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Transaksi Penerimaan Piutang tanpa diskon (2 transaksi) 
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Transaksi Penerimaan Piutang dengan Discount (2 transaksi) 
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Kasus 5.2 : Kasus UD Riola Media Mandiri. 
 
Transaksi Order Penjualan (2 transaksi) 

 

 

 

 

 



 
Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
119 

Transaksi Penjualan Kredit (2 transaksi) 
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Transaksi Penjualan Tunai (2 transaksi) 
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Transaksi Retur Penjualan (2 transaksi) 
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Transaksi Retur Penjualan Tunai (2 transaksi) 
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Transaksi Penerimaan Piutang tanpa diskon (2 transaksi) 
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Transaksi Penerimaan Piutang dengan Discount (2 transaksi) 
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Kegiatan Belajar 6 
Mengentri Transaksi Pembelian 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada akhir 
sesi ini diharapkan peserta didik dapat:  

1. Mencatat transaksi order pembelian (purchase order)  

2. Mencatat transaksi pembelian (purchases) 

3. Mencatat transaksi pebelian aktiva tetap (purchase of fixed asset)  

4. Mencatat transaksi retur pembelian (purchase return)  

5. Mencatat transaksi pembelian tunai (cash purchase)  

6. Mencatat transaksi retur pembelian tunai (cash purchase return) 

7. Mencatat transaksi pembayaran utang (pay bill) 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Entri transaksi Order Pembelian (Sales Order)  

2. Entri transaksi Pembelian Kredit (Sales)  

3. Entri transaksi Pembelian Tunai (Counter Sales)  

4. Entri transaksi Retur Pembelian (Sales Return)  

5. Entri transaksi Retur Pembelian Tunai (Counter Sales Return)  

6. Entri transaksi Pembayaran Utang (Pay Bill) tanpa Discount 

7. Entri transaksi Pembayaran Utang (Pay Bill) dengan Discount 

Program MYOB menyediakan berbagai menu pilihan untuk mengentri 
transaksi pembelian yang dilakukan oleh perusahaan. 

 

Gambar 6-1   Menu Purchase 



 
Dasar-dasar Perbankan Jilid 2 

Direktorat Pembinaan SMK (2013) 
126 

1. Entri Transaksi Order Pembelian (Purchase Order) 

 

Hal-hal yang perlu diperhatikan dalam transaksi order pembelian: 

a) Seperti halnya pada order penjualan, order pembelian tidak dijurnal. 

b) Anda bisa lihat hasil entri pada menu Purchase Register 

c) Selamanya akan tercatat di Purchase Register kalau anda belum 
merubahnya menjadi Bill. 

d) Dokumen sumber  Bukti No: 15 & 16 
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Praktekkan langkah-langkah berikut ini: 

 

1 

 

Klik Command Centre Purchase > Enter Purchase 
 

2 
 

Klik Layout, pilih Item, klik OK.  Kemudian set ke format ORDER 
 

 

Gambar 6-2 Layout Item for Purchase 

 

3 Isi data Purchase Order sesuai dengan dokumen sumber (Bukti No. 15). 
Kemudian klik  Record dan Klik Cancel. 

 
 

 

Gambar 6-3 Purchase Order 
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4 Untuk melihat Purchase Order yang sudah dientri klik Command Centre 

Purchase > Purchase Register, kemudian klik Tab Order. Set Tanggal dari 

1/1/13 to 31/1/13. Klik New Order untuk mencatat order berikutnya.. 

 

 

Gambar 6-4 Layout Item for Purchase 

 

6 

 

Ulangi langkah-langkah 1 s.d. 5 untuk mengisi data Purchase Order sesuai 
dengan dokumen sumber (Bukti No. 16) 
 

 

2. Entri Transaksi Pembelian Kredit 
 

Hal-hal yang penting diingat dalam transaksi pembelian kredit: 

a) Transaksi ini mempunyai pengaruh terhadap: akun utang dagang, akun 
pembelian, kartu utang dan kartu persediaan. 

b) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum  klik Record. 
(Tekan Ctrl-R untuk mengecek jurnalnya). 

c) Dokumen sumber : Bukti No: 17 & 18 
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Praktekkan Langkah-langkah berikut ini: 

 

1 

 

Klik Command Centre Purchase > Purchase Register 
 

 

Gambar 6-5 Purchase Register 

 

2 Klik  purchase order yang akan diubah menjadi Bill. Kemudian klik  Change 
to Bill. Isi data pembelian sesuai dengan bukti no. 17  ditambah freight 
sebesar Rp. 90.000,- 

 
 

 

Gambar 6-6  Purchase Bill 
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3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup 

Recap Transaction. Kembali ke Invoice semula klik Record, Print Later dan 

klik Cancel. 

 

 

Gambar 6-7  Recap Transaction in Purchases 

 

4 

 

Ulangi langkah-langkah 1 s.d. 3 untuk mengubah Purchase Order ke Bill 
sesuai dengan dokumen sumber (Bukti No. 18) 
 

 

3. Entri Tansaksi Pembelian Aktiva Tetap (Purchases of Fixed Assets) 
secara kredit. 
 

Hal-hal yang perlu diperhatikan dalam pembelian untuk Aktiva Tetap: 

a) Transaksi ini mempunyai pengaruh terhadap: akun utang, akun aktiva 
tetap, kartu utang. 

b) Set layout ke format Miscellaneous dan isi data pembelian. 

c) Cek terlebih dahulu jurnal yang akan dihasilkan sebelum  klik Record. 
(Tekan Ctrl-R untuk mengecek jurnalnya). 

d) Dokumen sumber : Bukti No: 19 & 20 
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Praktekkan Langkah-langkah berikut ini: 

 

1 

 

Klik Command Centre Purchase > Enter Purchase 

Set ke format BILL, Pilih Supplier PT AUTO 2000 karena belum ada, klik New 
 

 

Gambar 6-8  Membuat Supplier Baru 

 

2 Ketik Nama PT AUTO 2000 dan alamat serta no. telepon. Klik OK. 

 
 

 

Gambar 6-9 Supplier Baru 
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2 Kembali ke format BILL. Set Lay-out ke Misscellaneous.  Pilih Supplier PT 

AUTO 2000. Isi data pembelian sesuai dengan bukti no. 19 . 

 

 

Gambar 6-10 Mengubah layout Misscellaneous 

3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction. Kembali ke Invoice semula klik Record, Print Later dan klik 

Cancel. 

 

 

Gambar 6-11 Recap Transaction in Fixed Asset Purchase  

 

4 

 

Ulangi langkah-langkah 1 s.d. 3 untuk mencatat pembelian aset tetap sesuai 
dengan dokumen sumber (Bukti No. 20) 
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4. Mengentri Transaksi Retur Pembelian (Purchase Return). 

Hal-hal yang perlu diperhatikan dalam transaksi retur pembelian: 

a) Entri data seperti pembelian kredit, quatity diketik angka minus. 

b) Jangan lupa masuk ke Purchase Register  dan Tab Returns & 
Debits, untuk pengurangan julah di kartu Supplier. 

c) Dokumen sumber : Bukti No: 21 & 22 
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Praktekkan langkah-langkah berikut ini: 

1 Klik Command Centre Purchases > Enter Purchases 

Entri data untuk retur pembelian, jangan lupa ketik Quantity (Ship) dengan angka 
minus (lihat Bukti No. 21). 

 

 

Gambar 6-12 Purchase Return 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction. Kembali ke Bill semula klik Record, dan klik Cancel.  

 
 

 

Gambar 6-13 Recap Transaction in Purchase Return 

3 Klik Command Centre Purchases > Purchases Register. Kemudian klik Tab 
Returns & Debits. 
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Gambar 6-14  Purchase Register 

4 Klik Apply to Purchase  untuk memproses pengurangan di kartu Supplier. 

 

 

Gambar 6-15  Apply to Purchase 

5 Sesuaikan data ID# dan Date kemudian tempatkan kursor di kolom Amount 
Applied sejajar dengan baris PO-001 tgl. 15/01/2013. Klik Record. Klik Close 
untuk menutup Purchase Register. 

 

6 

 

Ulangi langkah-langkah 1 s.d. 5 untuk mengentri data untuk retur pembelian, 
sesuai dengan Bukti No. 22. 
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5. Entri Transaksi Pembelian Tunai (Cash Purchases)  

Hal-hal yang perlu diperhatikan dalam transaksi pembelian tunai: 

a) Buat Supplier baru dengan nama: cash purchase. 

b) Entri data seperti pembelian kredit. 

c) Jangan lupa Paid To Day diisi sejumlah total amount pembelian. 

d) Dokumen sumber : Bukti No: 23 & 24 
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Praktekkan langkah-langkah berikut ini: 

1 Klik Command Centre Purchases > Enter Purchases 

Set ke format Bill, Pilih Supplier CASH PURCHASE. Jika belum ada klik New. 
Buat Supllier baru nama CASH PURCHASE, Card ID S-000. Klik OK. 

 

 

Gambar 6-16  Cash Purchase 

2 Kembali ke Bill, pilih Supplier Cash Purchase. Entri data untuk pembelian, jangan 

lupa ketik Paid Today sebesar total pembelian (lihat bukti no. 23). 

 
 

 

Gambar 6-17  Pengisian Jumlah Paid Today  
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3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction 

 

 

Gambar 6-18  Recap Transaction in Cash Purchase 

 

4 

 

Ulangi langkah-langkah 2 dan 3 untuk mengentri data pembelian tunai, sesuai 
dengan Bukti No. 24. 
 

 

6. Mengentri Transaksi Retur Pembelian Tunai (Cash Purchase Return)  

Hal-hal yang perlu diperhatikan dalam transaksi retur pembelian tunai: 

a) Entri data seperti retur pembelian kredit, quatity diketik angka minus. 

b) Jangan lupa masuk ke Purchase Register dan Tab Returns & Debits, 
untuk memproses penerimaan uang kembali dari supplier klik Receive 
Refund. 

c) Dokumen sumber : Bukti No: 25 & 26 
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Praktekkan langkah-langkah berikut ini: 

1 Klik Command Centre Purchases > Enter Purchases 

Pilih Supplier CASH PURCHASE. Entri data untuk retur pembelian tunai, jangan 
lupa ketik Quantity (Ship) dengan angka minus (lihat Bukti No. 25). 

 

 

Gambar 6-19  Retur Pembelian Tunai 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction. Kembali ke Bill semula klik Record, dan klik Cancel.  

Klik Command Centre Purchases > Purchases Register. Kemudian klik Tab 
Returns & Debits.  

 
 

 

Gambar 6-20 Purchase Register untuk Cash Purchase 
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3 Klik Receive Refund untuk penerimaan pembayaran kembali dari Supplier. 

 

 

Gambar 6-21 Settle Returns & Debits untuk Cash Purchase 

 

4 

 

Ulangi langkah-langkah 1 s.d. 3 untuk mengentri data untuk retur pembelian tunai 
sesuai dengan Bukti No. 26. 
 

 

7. Entri Transaksi Pembayaran Utang (Pay Bill) 

Hal-hal yang perlu diperhatikan dalam transaksi receipt payment: 

a) Menggunakan Command Centre Purchase > Pay Bills BUKAN 
Banking > Spend Money. 

b) Harus memilih secara tepat Nama Supplier dan Utang yang terkait 
dengan pembayaran. 

c) Dokumen sumber : Bukti No: 27 & 28 
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Praktekkan langkah-langkah berikut: 

1 
Klik Command Centre Purchase > Pay Bills. Kemudian pilih nama supplier 

sesuai dan isi data pembayaran utang sesuai dengan dokumen sumber (Bukti 

No. 27) 

 

 

Gambar 6-22  Pembayaran Utang 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction. Kembali ke Bill semula klik Record, Print Later dan klik Cancel.  

 

 

Gambar 6-23  Recap Transaction in Pay Bills 

 

3 

 

Ulangi langkah-langkah 1 dan 2 untuk mengentri data pembayaran utang, sesuai 
dengan Bukti No. 28. 
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8. Entri Transaksi Pembayaran Utang (Pay Bill) Dengan Diskon 

Hal-hal yang perlu diperhatikan dalam transaksi pembayaran utang  
dengan diskon: 

a) Menggunakan Command Centre Purchase > Pay Bills BUKAN 
Banking > Spend Money. 

b) Diskon yang menyebabkan pengurangan Pajak (PPN) dihilangkan. 

c) Dokumen sumber : Bukti No: 29 & 30 
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Praktekkan langkah-langkah berikut: 

1 Klik Command Centre Purchase > Pay Bills. Kemudian pilih nama supplier dan 

isi data sesuai dengan dokumen sumber (Bukti No. 29). 

 

 

Gambar 6-24  Pay bill dengan Diskon 

2 Klik Record, Print Later dan klik Cancel.  Klik Command Centre Purchase > 

Transaction Journal untuk menampakkan jurnalnya: 

 

 

Gambar 6-25 Jurnal Pembayaran Utang dengan Diskon 
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3 Klik di  (panah kiri)  untuk jurnal yang terkait dengan diskon. 

 

 

Gambar 6-26  Mengeliminasi Diskon Pembelian 

4 Ubah PPN menjadi N-T untuk jumlah-jumlah yang ada dalam tabel di atas. 

Hasilnya adalah jurnal yang baru seperti berikut ini. Klik Close. 

 

 

Gambar 6-27  Jurnal Mengeliminasi PPN dalam Diskon 

 

5 

 

Ulangi langkah-langkah 1 s.d. 4 untuk mengentri data pembayaran utang dengan 
diskon sesuai dengan Bukti No. 30. 
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c. Rangkuman 

 

 Biasanya transaksi pembelian (Purchases), diawali dengan adanya 

order dari pemasok, kemudian dilanjutkan dengan pembelian 
kredit/tunai, kadang-kadang terjadi retur, pembayaran utang dan lain 
sebagainya. Semua transaksi tersebut disediakan menu dan format 
khusus oleh MYOB.  

 Data transaksi dientri ke dalam format dan kemudian diproses secara 
otomatis. Komputer akan memberikan hasil berupa laporan jurnal, 
saldo akun buku besar yang sudah di-update, bahkan laporan 
keuangan. 

 Untuk mencegah kesalahan dalam data entri maka dianjurkan 
sebelum di-record dicek terlebih dahulu jurnal yang akan dihasilkan 
dengan menekan Ctrl-R. 

 

 

d. Tugas 

 
Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Mencatat transaksi order pembelian (2 transaksi) 

4. Tugas 2, Mencatat transaksi pembelian (2 transaksi) 

5. Tugas 3, Mencatat transaksi pebelian aktiva tetap (2 transaksi) 

6. Tugas 4, Mencatat transaksi retur pembelian (2 transaksi) 

7. Tugas 5, Mencatat transaksi pembelian tunai (2 transaksi) 

8. Tugas 6, Mencatat transaksi retur pembelian tunai (2 transaksi) 

9. Tugas 7, Mencatat transaksi pembayaran utang tanpa diskon (2 transaksi) 

10. Tugas 8, Mencatat transaksi pembayaran utang dengan diskon                 
(2 transaksi) 
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e. Tes Formatif 

 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 
1. Berikut ini menu yang tidak termasuk dalam Command Centre: 

a. Sales 
b. Purchases 
c. Card Files 
d. Setup 
e. Inventory 

2. Langkah mengubah order pembelian menjadi pembelian kredit/tunai: 
a. Purchase > Enter Purchase 
b. Purchase > Purchase Register > Enter Purchase 
c. Purchase Register > Enter Purchase 
d. Purchase Register > Pilih Order > Change to Bill 
e. Purchase > Purchase Register > Pilih Order > Change to Bill 

3. Langkah mengentri transaksi pembayaran utang: 
a. Purchase > Spend Money 
b. Purchase > Pay Bill 
c. Purchase Register > Pay Bill 
d. Purchase Register > Purchase > Spend Money 
e. Purchase > Purchase Register > Pay Bill 

4. Langkah mengentri transaksi retur pembelian, pertama Purchase > Enter 
Purchase > Ketik quantity minus. Kedua ... 
a. Purchase > Enter Purchase > Spend Money 
b. Purchase > Purchase Register 
c. Purchase Register > Purchase > Apply to Sale 
d. Purchase Register > Pilih Tab Returns & Credit >  
e. Purchase > Purchase Register > Pilih Tab Returns & Credit  > Apply to 

Purchase 

5. Langkah mengentri transaksi pembelian counter atau tunai: 
a. Purchase> Enter Purchase > Paid to Day diisi dengan total pembelian 
b. Enter Purchase > Paid to Day diisi dengan total pembelian  
c. Purchase Register > Purchase  
d. Purchase > Purchase Register  
e. Purchase Register > Paid to Day diisi dengan total pembelian 

6. Pada pengisian data dalam Purchases Invoice kolom Tax Inclusive 
dikosongkan, ini berarti dalam kolom harga diisi dengan jumlah.... 
a. Harga beli termasuk PPN 
b. Harga beli tidak termasuk PPN 
c. Harga beli termasuk PPN dan Freight 
d. Harga beli termasuk Freight 
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e. Harga beli termasuk PPN, Freight, and Insurance 
7. Jenis Layout apakah yang digunakan untuk pembelian Aset Tetap secara 

kredit ? 
a. Service 
b. Item 
c. Professional 
d. Miscellaneous 
e. Fixed Asset 

8. Perubahan akun apa saja yang dipengaruhi oleh adanya transaksi 
pembelian kredit ? 
a. Account Payable, Merchandise Inventory, Purchases 
b. Purchases, Account Payable 
c. Purchases, Merchandise Inventory 
d. Purchases, Account Receivable 
e. Account Payable, Merchandise Inventory 

9. Program MYOB menghitung potongan utang dagang dari .... 
a. Total utang dagang 
b. Total utang dagang setelah dikurangi dengan retur pembelian 
c. Total utang dagang setelah dikurangi dengan PPN  
d. Total utang dagang setelah ditambah PPN 
e. Total utang dagang setelah dikurangi uang muka. 

10. Perintah untuk melihat jurnal Pembelian .... 
a. Purchases > Purchases Transaction Journals  
b. Purchases > Purchases Register > Purchases Journal 
c. Purchases Register > Purchases > Purchases Journal 
d. Purchases > Purchases Journals  
e. Purchases > Transaction Journals  

 

2. Tes Keterampilan. 

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Mencatat transaksi order pembelian (2 transaksi) 

4. Tugas 2, Mencatat transaksi pembelian (2 transaksi) 

5. Tugas 3, Mencatat transaksi pebelian aktiva tetap (2 transaksi) 

6. Tugas 4, Mencatat transaksi retur pembelian (2 transaksi) 

7. Tugas 5, Mencatat transaksi pembelian tunai (2 transaksi) 

8. Tugas 6, Mencatat transaksi retur pembelian tunai (2 transaksi) 

9. Tugas 7, Mencatat transaksi pembayaran utang tanpa diskon (2 transaksi) 
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10. Tugas 8, Mencatat transaksi pembayaran utang dengan diskon                  
(2 transaksi) 

 

f. Kunci Jawaban Tes Formatif 

1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 d  6 b 

2 e  7 d 

3 b  8 e 

4 e  9 a 

5 a  10 e 

 

2. Kunci Tes Keterampilan 

Tugas 1, Mencatat transaksi order pembelian (2 transaksi) 

Tidak ada jurnalnya. 

Tugas 2, Mencatat transaksi pembelian (2 transaksi) 
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Tugas 3, Mencatat transaksi pebelian aktiva tetap (2 transaksi) 

 

Tugas 4, Mencatat transaksi retur pembelian (2 transaksi) 
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Tugas 5, Mencatat transaksi pembelian tunai (2 transaksi) 

 

Tugas 6, Mencatat transaksi retur pembelian tunai (2 transaksi) 
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Tugas 7, Mencatat transaksi pembayaran utang tanpa diskon (2 transaksi) 

 

Tugas 8, Mencatat transaksi pembayaran utang dengan diskon (2 transaksi) 
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g. Lembar Kegiatan Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 
didik di komputer melalui program MYOB versi 18. 

 

Kasus 6.1 : Kasus UD Rasela Media Mandiri. 

Transaksi order pembelian (2 transaksi) 
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Transaksi pembelian (2 transaksi) 
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Transaksi pembelian aktiva tetap (2 transaksi) 
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Transaksi retur pembelian (2 transaksi) 



 
Dasar-dasar Perbankan Jilid 2 

Direktorat Pembinaan SMK (2013) 
160 

 

 

 

Transaksi pembelian tunai (2 transaksi) 
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Transaksi retur pembelian tunai (2 transaksi) 
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Transaksi pembayaran utang tanpa diskon (2 transaksi) 
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Transaksi pembayaran utang dengan diskon (2 transaksi) 
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Kasus 6.2 : Kasus UD Riola Media Mandiri. 
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Transaksi order pembelian (2 transaksi) 

 

 

 

 

 

Transaksi pembelian (2 transaksi) 
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Transaksi pebelian aktiva tetap (2 transaksi) 
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Transaksi retur pembelian (2 transaksi) 
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Transaksi pembelian tunai (2 transaksi) 
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Transaksi retur pembelian tunai (2 transaksi) 
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Transaksi pembayaran utang tanpa diskon (2 transaksi) 
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Transaksi pembayaran utang dengan diskon (2 transaksi) 
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Kegiatan Belajar 7 
Mengentri Transaksi Kas Bank         

 

a. Tujuan Pembelajaran 

 
Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 

akhir sesi ini diharapkan peserta didik dapat: 

1. Mencatat transaksi Pengeluaran Kas 

2. Mencatat transaksi Pengeluaran Kas Kecil 

3. Mencatat transaksi Penerimaan Kas 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Entri transaksi Pengeluaran Kas 
2. Entri transaksi Pengeluaran Kas Kecil 
3. Entri transaksi Penerimaan Kas 

 

Program MYOB menyediakan berbagai Command Centre Banking yang 
digunakan untuk mengentri transaksi pengeluaran kas untuk pembayaran beban-
beban dan juga penerimaan kas dari pendapatan lain-lain. 

 

Gambar 7-1   Menu Banking 
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1. Entri Transaksi Pengeluaran Kas (Spend Money - Cash In Bank) 

Hal-hal yang perlu diperhatikan dalam transaksi pengeluaran Kas: 

a) Menggunakan Command Centre Banking > Spend Money. 

b) Mengidentifikasi pembayaran dengan cek, tunai (cash on hand), kas kecil 
atau via kartu kredit. 

c) Dokumen sumber : Bukti No: 31 & 32 
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Praktekkan langkah-langkah berikut: 

1 Klik Command Centre Banking > Spend Money. Kemudian isi data sesuai 

dengan dokumen sumber. Untuk memilih akun yang terkait klik       dan pilih 

akun. Kemudian klik Use Account. 

 

 

Gambar 7-2 Spend Money – Memilih Akun Beban 

2 Isi format Spend Money sesuai dengan dokumen sumber (Bukti No. 31) seperti 

berikut. 
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Gambar 7-3 Spend Money – Cash In Bank 

3 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 
Transaction. Kembali ke Bill semula klik Record, dan klik Cancel. 

 

 

Gambar 7-4  Recap Transaction in Spend Money- Cash In Bank 

 

4 

 

Ulangi langkah-langkah 1 s.d. 3 untuk mengentri data pengeluaran kas sesuai 
dengan Bukti No. 32. 
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2. Entri Transaksi Pengeluaran Kas Kecil (Spend Money - Petty Cash) 

Hal-hal yang perlu diperhatikan: 

a) Menggunakan Command Centre Banking > Spend Money. 

b) Mengubah Cash in Bank dengan Petty Cash. 

c) Dokumen sumber : Bukti No: 33 & 34 
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Praktekkan langkah-langkah berikut: 

1 Klik Command Centre Banking > Spend Money. Kemudian ubah Cash in 
Bank  menjadi Petty Cash.  Isi data sesuai dengan dokumen sumber (Bukti 

No. 33).     

 

 

Gambar 7-5   Spend Money – Petty Cash 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup 

Recap Transaction. Kembali ke Bill semula klik Record, dan klik Cancel. 

 

 

Gambar 7-6  Recap Transaction in Spend Money – Petty Cash 
 

3 

 

Ulangi langkah-langkah 1 dan 2 untuk mengentri data pengeluaran kas kecil  
sesuai dengan Bukti No. 34. 
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3. Transaksi Penerimaan Kas (Receive Money) 

Hal-hal yang perlu diperhatikan dalam transaksi pembayaran utang  dengan 
diskon: 

a) Menggunakan Command Centre Banking > Receive Money. 

b) Dokumen sumber : Bukti No: 35 & 36 
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Praktekkan langkah-langkah berikut: 

1 Klik Command Centre Banking > Receive Money. Kemudian isi data sesuai 

dengan dokumen sumber (Bukti No. 35) 

 

 

Gambar 7-7 Receive Money 

2 Tekan CTRL-R untuk cek jurnal, jika sudah benar klik OK untuk menutup Recap 

Transaction. Kembali ke Bill semula klik Record, dan klik Cancel. 

 

 

Gambar 7-8 Recap Transaction In Receive Money 
 

3 

 

Ulangi langkah-langkah 1 dan 2 untuk mengentri data penerimaan kas sesuai 
dengan Bukti No. 36. 
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c. Rangkuman 

 
• Transaksi pengeluaran yang dapat dientri melalui Command Centre 

Banking adalah berbagai transaksi pembayaran beban operasi dan 
beban non operasi yang dibayar dengan cek, kas atau kas kecil, tetapi 
tidak termasuk transaksi pembayaran utang (Command Centre 
Purchases). Demikian juga transaksi penerimaan yang dapat dientri 
melalui Banking adalah berbagai transaksi penerimaan kecuali 
penerimaan pembayaran piutang. 

• Semua transaksi penerimaan dan pengeluaran tersebut disediakan 
menu dan format khusus oleh MYOB. Data transaksi dientri ke dalam 
format dan kemudian diproses secara otomatis. Komputer akan 
memberikan hasil berupa laporan jurnal, saldo akun buku besar yang 
sudah di-update, bahkan laporan keuangan. Untuk mencegah 
kesalahan dalam data entri maka dianjurkan sebelum di-record dicek 
terlebih dahulu jurnal yang akan dihasilkan dengan menekan Ctrl-R. 

 

d. Tugas 

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada 
‘Lembar Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 
1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang 

per kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan 
dalam KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Mencatat transaksi Pengeluaran Kas (2 transaksi) 

4. Tugas 2, Mencatat  transaksi Pengeluaran Kas Kecil (2 transaksi) 

5. Tugas 3, Mencatat transaksi Penerimaan Kas (2 transaksi) 
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e. Tes Formatif 

 
1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Langkah untuk mengentri transaksi pengeluaran kas kecil untuk beban 
operasi: 
a. Banking > Petty Cash Out 
b. Banking > Cash Payment > Set Account to Petty Cash 
c. Banking > Petty Cash 
d. Banking > Spend Money > Set Account to Petty Cash 
e. Banking > Set Account to Petty Cash > Spend Money 

2. Menu yang digunakan untuk mencatat transaksi pembayaran dalam MYOB 
adalah : 
a. Banking > Pay Bill  
b. Banking > Spend Money 
c. Banking > Money Out  
d. Banking > Banking Register > Spend Money 
e. Banking Register > Spend Money 

3. Menu untuk mengentri transaksi pembayaran dengan Cek: 
a. Banking > Pay Bill > Pay from Account: Cash in Bank. 
b. Banking > Spend Money > Pay from Account: Cash in Bank. 
c. Banking > Money Out > Pay from Account: Cash in Bank. 
d. Banking > Banking Register > Pay from Account: Cash in Bank. 
e. Banking Register > Pay Bill > Pay from Account: Cash in Bank. 

4. Sebelum me-record transaksi pembayaran, selalu dianjurkan untuk 
menekan Ctrl-R. Tujuan langkah ini adalah untuk:  
a. Menghindari kesalahan dalam pencatatan. 
b. Membetulkan jika ada kesalahan dalam pencatatan. 
c. Mengeliminir kesalahan dalam jurnal  
d. Mengecek kebenaran jurnal sebelum diproses 
e. Mengecek kebenaran jurnal sesudah diproses 

5. Dalam MYOB klik Record terhadap pencatatan transaksi berarti: 
a. Memerintahkan komputer untuk memperoses jurnalnya. 
b. Memerintahkan komputer untuk menghapus jurnalnya. 
c. Memerintahkan komputer untuk membatalkan jurnalnya. 
d. Memerintahkan komputer untuk memproses ulang jurnalnya. 
e. Memerintahkan komputer untuk memproses jurnal dan posting ke buku 

besar serta buku pembantu. 
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6. Menu yang digunakan untuk mencatat transaksi penerimaan dalam MYOB 
adalah : 
a. Banking > Receive Payment 
b. Banking > Money In 
c. Banking > Receive Money 
d. Banking > Banking Register > Receive Money 
e. Banking Register > Receive Money 

7. Menu untuk mengentri transaksi penerimaan berupa cek: 
a. Banking > Receive Payment > Deposit to Account: Cash in Bank. 
b. Banking > Money In > Deposit to Account: Cash in Bank. 
c. Banking Register > Receive Money > Deposit to Account: Cash in 

Bank. 
d. Banking > Receive Money > Deposit to Account: Cash in Bank. 
e. Banking Register > Receive Money > Deposit to Account: Cash in 

Bank. 

8. Jika ada transaksi penerimaan cek dari setoran pemilik untuk tambahan 
investasi sebesar Rp. 300.000,- maka MYOB akan memproses jurnalnya: 
a. Dr: Cash in Bank. Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
b. Dr: Owner’s Capital Rp. 300.000,- Cr: Cash in Bank. Rp. 300.000,- 
c. Dr: Cash in Bank. Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,- 
d. Dr: Bankcard Rp. 300.000,- Cr: Sales or Fee Rp. 300.000,- 
e. Dr: Cash Drawer Rp. 300.000,- Cr: Owner’s Capital Rp. 300.000,- 

9. Menu untuk mengentri transaksi penerimaan berupa uang tunai: 
a. Banking > Receive Payment > Deposit to Account: Cash in Bank 
b. Banking > Receive Money > Deposit to Account: Cash Drawer 
c. Banking > Money In > Deposit to Account: Cash Drawer 
d. Banking Register > Receive Money > Deposit to Account: Cash oh 

hand 
e. Banking Register > Receive Money > Deposit to Account: Cash on 

Hand 

10. Dalam MYOB klik Record terhadap pencatatan transaksi yang masih 
belum seimbang akan terjadi .... 
a. Komputer akan memperoses jurnalnya. 
b. Komputer akan menghapus jurnalnya. 
c. Komputer akan membatalkan jurnalnya. 
d. Komputer akan menolak pemprosesan jurnalnya. 
e. Komputer akan akan memberi peringatan.  

2. Tes Keterampilan. 

Berdasarkan Kasus 3.1. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta 
didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Mencatat transaksi Pengeluaran Kas (2 transaksi) 
4. Tugas 2, Mencatat  transaksi Pengeluaran Kas Kecil (2 transaksi). 
5.  Tugas 3, Mencatat transaksi Penerimaan Kas (2 transaksi) 



 
Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
184 

 

f. Kunci Jawaban Tes Formatif 

1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 d  6 c 

2 b  7 d 

3 b  8 c 

4 d  9 b 

5 e  10 e 

 

2. Kunci Tes Keterampilan 

Tugas 1, Mencatat transaksi Pengeluaran Kas (2 transaksi) 
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Tugas 2, Mencatat  transaksi Pengeluaran Kas Kecil (2 transaksi) 

 

Tugas 3, Mencatat transaksi Penerimaan Kas (2 transaksi) 
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g. Lembar Kerja Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh 
peserta didik di komputer melalui program MYOB versi 18. 

 
Kasus 7.1 : Kasus UD Rasela Media Mandiri. 
 
Entri Transaksi Pengeluaran Kas (Spend Money - Cash In Bank) 
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Entri Transaksi Pengeluaran Kas Kecil (Spend Money - Petty Cash) 
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Penerimaan Kas (Receive Money) 
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Kasus 7.2 : Kasus UD Riola Media Mandiri. 
 

Entri Transaksi Pengeluaran Kas (Spend Money - Cash In Bank) 
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Entri Transaksi Pengeluaran Kas Kecil (Spend Money - Petty Cash) 
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Transaksi Penerimaan Kas (Receive Money) 

 

 

 



 
Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
192 

Kegiatan Belajar 8 
Mengentri Transaksi Penyesuaian 

 

a. Tujuan Pembelajaran 

 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 
akhir sesi ini diharapkan peserta didik dapat:  

1. Mencatat transaksi penyesuaian untuk depresiasi aktiva tetap  

2. Mencatat transaksi penyesuaian untuk beban supplies  

3. Mencatat transaksi penyesuaian untuk kerusakan barang dagangan  

4. Mencatat transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank  

 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 1 ini meliputi:  

1. Entri transaksi penyesuaian untuk depresiasi aktiva tetap  

2. Entri transaksi penyesuaian untuk beban supplies  

3. Entri transaksi penyesuaian untuk kerusakan barang dagangan  

4. Entri transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank  

 

Program MYOB menyediakan menu pilihan Record Journal Entry untuk mengentri 
transaksi penyesuaian pada akhir periode akuntansi. Praktek entri transaksi 
penyesuaian ini didasarkan pada Kasus UD. Rasel Media Mandiri. 

 

Gambar 2. 66 Menu Accounts - Record Journal Entry 
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1. Entri Transaksi  penyesuaian untuk depresiasi aktiva tetap 

Hal-hal yang perlu diperhatikan: 

a) Memeriksa hasil perhitungan depresiasi aktiva tetap di dokumen. 

b) Dokumen sumber : Bukti No: 37  

 
 

1 Klik Command Centre Account > Record Journal Entry.  Kemudian isi data 

sesuai dengan dokumen sumber (Bukti No. 37) di atas. 

 

 
Gambar 2. 67 Transaksi Depresiasi Aktiva Tetap 
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2 
 

Cek Jurnal dengan cara klik Command Centre Acount > Transaction Journal. 

Sesuaikan tanggal dari 1/1/2013 s.d. 31/1/2013. 

 

 

Gambar 2. 68 Jurnal Transaksi Depresiasi Aktiva Tetap 

 

2. Transaksi penyesuaian untuk beban supplies 

Hal-hal yang perlu diperhatikan: 

a) Memeriksa menghitung/memeriksa hasil perhitungan beban supplies  

b) Dokumen sumber : Bukti No: 37 
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Praktekkan langkah-langkah berikut: 
 

1 Klik Command Centre Account > Record Journal Entry.  Kemudian isi data 

sesuai dengan dokumen sumber (Bukti No. 37). 

 

 

Gambar 2. 69 Transaksi Beban Supplies 

 

2 
Cek Jurnal dengan cara klik Command Centre Acount > Transaction Journal. 

Sesuaikan tanggal dari 1/1/2013 s.d. 31/1/2013. 
 

 

Gambar 2. 70 Jurnal Transaksi Beban Supplies 
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3. Entri Transaksi penyesuaian untuk kerusakan barang dagangan 

Hal-hal yang perlu diperhatikan: 

a) Memeriksa cost dari item-item rusak dan akan dihapus.  

b) Dokumen sumber : Bukti No: 38  
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Praktekkan langkah-langkah berikut: 
 

1 Klik Command Centre Inventory  > Adjustment Inventory.  Kemudian isi data 

sesuai dengan dokumen sumber. Untuk quantiti diawali dengan tanda “-“ (minus) 

 

 

Gambar 2. 71 Transaksi Penghapusan Item Persediaan 

2 
 

Cek Jurnal dengan cara klik Command Centre Inventory > Transaction Journal. 

Sesuaikan tanggal dari 1/1/2013 s.d. 31/1/2013. 

 

 

 
Gambar 2. 72 Jurnal Transaksi Penghapusan Item Persediaan 
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4. Transaksi penyesuaian untuk rekonsiliasi akun Cash In Bank 

Hal-hal yang perlu diperhatikan: 

a) Rekening Koran dari Bank per tanggal 31/1/2013 

b) Dokumen sumber : Rek. Koran Bank Mandiri. 
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Praktekkan langkah-langkah berikut: 
 

1 Klik Command Centre Banking > Reconcile Accounts.  Pastikan bahwa Account: 

1-1110 Cash In Bank. Kemudian ketik Saldo RK sebesar 230974250 di kolom New 

Statement Balance dan ketik tanggal 31/1/2013 tekan [Enter]. 

Klik mouse di kolom paling kiri [ ] untuk jumlah-jumlah yang ada di catatan 

perusahaan ( tercatat di komputer ) dan ada juga di rekening koran (catatan di 

bank).  

 

 
Gambar 2. 73 Proses Rekonsiliasi Bank 
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2 
 

Khusus untuk Bank Charges dan Interest Income dicatat melalui Bank Entry. Jadi 

Klik Bank Entry dan lihat pencatatan untuk kedua beban tersebut di gambar 

berikut ini 

 

 

 
Gambar 2. 74 Transaksi Bank Charges dan Interest Income 

 

3 
 

Untuk memeriksa bahwa proses rekonsiliasi sudah benar maka pastikan bahwa 

saldo Out of Balance = 0 (Nol). Jika saldonya bukan Nol maka berarti proses 

pencatatan transaksi pengeluaran/penerimaan Cash in Bank yang anda kerjakan 

masih ada yang salah. Cek ulang !  
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c. Rangkuman 

 

• Pencatatan transaksi penyesuaian dilakukan di akhir periode 
akuntansi. Jika perusahaan menggunakan periode bulanan maka 
pada setiap akhir bulan, dan jika periode tahunan maka pada setiap 
akhir periode, misalnya 31/12. Untuk kasus UD Rasela Media 
Mandiri menggunakan periode tahunan, tetapi setiap bulan 
diharapkan dapat membuat laporan keuangannya. 

• Tidak seperti dalam entri-entri sebelumnya seperti entri di Sales, 
Purchases, atau di Banking dimana jurnal dibuat secara otomatis 
oleh komputer. Untuk jurnal penyesuaian ini penentuan akun-akun 
mana yang didebit atau dikredit dilakukan oleh petugas (teknisi 
akuntansi) yang mengoperasikan MYOB. 

 
 
 
 

d. Tugas 

Berdasarkan Kasus 3.1. UD Rasela Media Mandiri yang ada pada 
‘Lembar Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang 
dijabarkan dalam KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Mencatat transaksi penyesuaian untuk depresiasi aktiva 
tetap. 

4. Tugas 2, Mencatat transaksi penyesuaian untuk beban supplies. 

5. Tugas 3, Mencatat transaksi penyesuaian untuk kerusakan barang 
dagangan 

6. Tugas 4, Mencatat transaksi penyesuaian untuk rekonsiliasi akun 
Cash in Bank. 
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e. Tes Formatif 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

 
1. Langkah untuk mengentri transaksi penyesuaian: 

a. Account > Record Journal Entry > Pilih akun-akun di debit dan dikredit 
b. Account > Memorial > Pilih akun-akun di debit dan dikredit 
c. Account > General Journal > Pilih akun-akun di debit dan dikredit 
d. Account > Journal Entry > Pilih akun-akun di debit dan dikredit 
e. Account > Record Journal > Pilih akun-akun di debit dan dikredit 

2. Langkah untuk mengentri penghapusan item persediaan: 
a. Inventory > Delete Inventory > Pilih item-item yang dihapus (Minus) 
b. Account > Record Journal > Pilih item-item yang dihapus (Minus) 
c. Inventory > Adjust Inventory > Pilih item-item yang dihapus (Plus) 
d. Inventory > Adjust Inventory > Pilih item-item yang dihapus (Minus) 
e. Account > Record Journal > Pilih item-item yang dihapus (Plus) 

3. Langkah untuk membuat rekonsiliasi bank: 
a. Account > Reconcile Accounts  
b. Banking > Adjust Bank Accounts 
c. Banking > Reconcile Accounts 
d. Account > Adjust Bank Accounts 
e. Banking > Set bank Accounts 

4. Dalam proses rekonsiliasi jumlah tertentu akan diklik [  ] apabila: 
a. Jumlah tersebut tercatat di komputer saja 
b. Jumlah tersebut tercatat di komputer dan tidak di rekening koran 
c. Jumlah tersebut tidak tercatat di komputer dan tapi di rekening koran 
d. Jumlah tersebut tercatat di rekening koran saja 
e. Jumlah tersebut tercatat di komputer dan juga di rekening koran 

5. Khusus untuk transaksi bank charges dan interest income dicatat di: 
a. Bank Entry 
b. Banking > Spend Money dan Receive Money  
c. Banking > Receive Money 
d. Banking > Spend Money 
e. Account > Record Journal Entry 

6. Pencatatan entri penyesuaian diperlukan agar : 
a. Saldo akun-akun menunjukkan jumlah yang sesuai. 
b. Saldo akun-akun menunjukkan jumlah yang seimbang 
c. Saldo akun-akun menunjukkan jumlah yang sama. 
d. Saldo akun-akun menunjukkan jumlah yang sesungguhnya. 
e. Saldo akun-akun menunjukkan jumlah yang setara. 
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7. Rekening Koran yang diterima dari BCA melaporkan bahwa ada Interest 
Income dan Bank Charge sejumlah tertentu. Transaksi ini akan berakibat 
penyesuaian terhadap akun: 
a. Bank Loan 
b. Account Payable 
c. Expense 
d. Cash in Bank 
e. Income 

8. Selama periode akuntansi telah terjadi pemakaian supplies tetapi belum 
diadakan pencatatan. Transaksi ini akan berakibat penyesuaian terhadap 
akun-akun: 
a. Dr: beban supplies dan Cr: Persediaan barang 
b. Dr: Persediaan supplies dan Cr: Persediaan barang 
c. Dr: Beban supplies dan Cr: Persediaan Supplies 
d. Dr: Beban supplies dan Cr: Beban operasional 
e. Dr: Beban operasional dan Cr: Persediaan supplies 

9. Penggunaan aset tetap dalam kegiatan operasi pada akhir periode akan 
menyebabkan penyesuaian terhadap akun-akun: 
a. Dr: Akun aset tetap dan Cr: Depresiasi aset tetap 
b. Dr: Akun aset tetap dan Cr: Akum. depresiasi aset tetap 
c. Dr: Depresiasi aset tetap dan Cr: beban operasi 
d. Dr: Akum. depresiasi aset tetap dan Cr: beban operasi 
e. Dr: Depresiasi aset tetap dan Cr: Akum. depresiasi aset tetap. 

10. Beban salary bulan Januari akan dibayarkan di awal Pebruari. Transaksi 
ini akan berakibat penyesuaian terhadap akun-akun: 
a. Dr: Beban salary dan Cr: Utang beban 
b. Dr: Beban operasi dan Cr: Utang salary 
c. Dr: Beban salary dan Cr: beban operasi 
d. Dr: Beban salary dan Cr: Utang salary 
e. Dr: Beban operasi dan Cr: Utang operasi  
 

2. Tes Keterampilan. 

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta 
didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Mencatat transaksi penyesuaian untuk depresiasi aktiva tetap. 

4. Tugas 2, Mencatat transaksi penyesuaian untuk beban supplies. 

5. Tugas 3, Mencatat transaksi penyesuaian untuk kerusakan barang 
dagangan 

6. Tugas 4, Mencatat transaksi penyesuaian untuk rekonsiliasi akun Cash in 
Bank. 
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f. Kunci Jawaban Tes Formatif 

1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 a  6 d 

2 e  7 d 

3 c  8 c 

4 e  9 e 

5 a  10 d 
 

2. Kunci Tes Keterampilan 

Tugas 1, Transaksi penyesuaian untuk beban supplies dan depresiasi aktiva 
tetap. 
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Tugas 3, Transaksi penyesuaian untuk kerusakan barang dagangan 

 

 

Tugas 4, Transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank. 
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g. Lembar Kerja Peserta Didik  

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh 
peserta didik di komputer melalui program MYOB versi 18. 

 

Kasus 8.1 : Kasus UD Rasela Media Mandiri. 

Entri transaksi penyesuaian untuk depresiasi aktiva tetap & beban supplies. 
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Entri transaksi penyesuaian untuk kerusakan barang dagangan  
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Entri transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank 
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Kasus 8.2 : Kasus UD Riola Media Mandiri. 

Entri transaksi penyesuaian untuk depresiasi aktiva tetap & beban supplies. 

 

Entri transaksi penyesuaian untuk kerusakan barang dagangan 
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Entri transaksi penyesuaian untuk rekonsiliasi akun Cash in Bank 
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Kegiatan Belajar 9 
Membuat Laporan Keuangan 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 
akhir sesi ini diharapkan peserta didik dapat:  

1. Menyiapkan Laporan Laba Rugi  

2. Menyiapkan Laporan Neraca  

3. Menyiapkan Laporan Arus Kas  

4. Menyiapkan Laporan Piutang  

5. Menyiapkan Laporan Utang  

6. Menyiapkan Laporan Persediaan 

 

b. Uraian Materi 

Lingkup uraian materi pada kegiatan belajar 9 ini meliputi:  

1. Laporan Laba Rugi  
2. Laporan Neraca  
3. Laporan Arus Kas  
4. Laporan Piutang  
5. Laporan Utang  
6. Laporan Persediaan 

Program MYOB menyediakan berbagai menu REPORTS untuk menampilkan 
laporan berbagai keuangan perusahaan 

 

Gambar 2. 75 Menu Reports 
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1. Pembuatan Laporan Laba-Rugi 

Hal-hal yang perlu diperhatikan: 

a) Periode laporan Laba-Rugi yaitu 1/1/2013 s.d. 31/1/2013 

b) Ada dua cara, ke-1 yaitu Reports > Index to Reports  (posisi menu 
diatas) atau Cara ke-2 Reports > Accounts > Accounts (posisi menu 
di bawah. 

Langkah-langkah: 

1 Klik menu Reports > Index to Reports > Tab Accounts > Profit & Loss 

(Accrual) > Customise 

 

 

Gambar 2. 76 Menu Reports – Profit & Loss 

2 
 

Ketik periode 1/1/2013 to 31/1/2013, kemudian klik Display. 
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Gambar 2. 77 Profit & Loss Report 
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2. Pembuatan Laporan neraca 

Hal-hal yang perlu diperhatikan: 

a) Per tanggal laporan Neraca yaitu 31/1/2013 

b) Ada dua cara, ke-1 yaitu Reports  > Index to Reports  (posisi menu 
diatas) atau Cara ke-2 Reports > Accounts > Accounts (posisi menu 
di bawah. 

Langkah-langkah: 

1 Klik menu Reports > Index to Reports > Tab Accounts > Standard 

Balance Sheet > Customise 

 

 
Gambar 2. 78 Report – Balance Sheet 

 

2 
 

Pilih periode Januari , Ketik tanggal 31/1/2013, kemudian klik Display. 
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Gambar 2. 79 Standar Balance Sheet  Report 
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3. Pembuatan Laporan Arus Kas 

Hal-hal yang perlu diperhatikan: 

a) Per tanggal laporan Neraca yaitu 31/1/2013 

b) Melalui menu Reports  > Index to Reports  > Tab Banking  

 

Langkah-langkah:  

1 Klik menu Reports > Index to Reports > Tab Banking > Customise 

 

 
Gambar 2. 80 Menu Report- Statement of Cash Flow 

 

2 
 

Pilih periode Januari  1/1/2013 to January  31/1/2013, kemudian klik Display. 
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Gambar 2. 81 Statement of Cash Flow Report 
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4. Pembuatan Laporan Piutang 

Hal-hal yang perlu diperhatikan: 

a) Per tanggal laporan piutang yaitu 31/1/2013 

b) Melalui menu Reports  > Index to Reports > Tab Cards 

Langkah-langkah: 

1 Klik menu Reports > Index to Reports > Tab Cards > Customise 

 

 
Gambar 2. 82 Menu Card Report 

2 
 

Pilih Customers, kemudian klik Display. 

 

 

Gambar 2. 83 Card List  Report - Customers 
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5. Pembuatan Laporan Utang 

Hal-hal yang perlu diperhatikan: 

a) Per tanggal laporan piutang yaitu 31/1/2013 

b) Melalui menu Reports  > Index to Reports > Tab Cards 

Langkah-langkah: 

1 Klik menu Reports > Index to Reports > Tab Cards > Customise 

 

 
Gambar 2. 84 Menu Card List - Suppliers 

2 
 

Pilih Suppliers, kemudian klik Display. 

 

  
 

Gambar 2. 85 Card List  Report – Suppliers 
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6. Pembuatan Laporan persediaan 

Hal-hal yang perlu diperhatikan: 

a) Per tanggal laporan Neraca yaitu 31/1/2013 

b) Melalui menu Reports  > Index to Reports > Inventory   

Langkah-langkah: 

1 Klik menu Reports > Index to Reports > Tab Inventory > Customise 

 

 

Gambar 2. 86 Menu Item List Report 

2 
 

Pilih All , kemudian klik Display. 

 

 
 

Gambar 2. 87 Items List  Report 
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c. Rangkuman 

 Program MYOB memproses laporan keuangan secara otomatis 
didasarkan pada seluruh transaksi yang telah dientri ke dalam 
komputer. Berbagai laporan dapat dibuat melalui pemilihan menu-
menu yang tersedia, tetapi dalam modul ini difokuskan pada enam 
laporan pokok, yaitu laporan Laba-Rugi, Neraca, Laporan Arus Kas, 
Laporan Saldo Piutang dan Utang, serta laporan saldo persediaan. 

 Untuk menampilkan laporan keuangan perlu diperhatikan bebarapa 
kriteria, antara lain jenis laporan yang diinginkan, pemilihan menu 
yang tepat dan penentuan periode atau tanggal laporan. Laporan 
keuangan yang dihasilkan dapat ditampilkan di layar komputer, 
dieksport ke program excell ataupun dicetak (hard copy). Dalam 
pembelajaran kali ini difokuskan pada tampilan di layar komputer. 

 

d. Tugas 

 
 

Berdasarkan Kasus 9.1. UD Rasela Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Menyiapkan Laporan Laba Rugi 

4. Tugas 2, Menyiapkan Laporan Neraca 

5. Tugas 3, Menyiapkan Laporan Arus Kas 

6. Tugas 4, Menyiapkan Laporan Piutang 

7. Tugas 5, Menyiapkan Laporan Utang 

8. Tugas 6, Menyiapkan Laporan Persedia 
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e. Tes Formatif 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 
c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Langkah untuk menampilkan laporan Laba-Rugi: 

a. Reports > Index to reports > Tab Account > Profit & Loss (Accrual) 
b. Account > Index to reports > Tab Account > Profit & Loss 
c. Reports > Tab Account > Index to reports > Profit & Loss (Accrual) 
d. Account > Tab Account > Profit & Loss 
e. Reports  > Index to reports > Profit & Loss (Accrual) 

2. Langkah untuk menampilkan laporan Neraca: 

a. Reports > Index to reports > Balance > Standard Balance Sheet 
b. Account > Index to reports > Standard Balance Sheet 
c. Reports > Index to reports > Standard Balance Sheet 
d. Index to reports > Reports > Standard Balance Sheet 
e. Reports > Index to reports > Tab Account > Standard Balance Sheet 

3. Langkah untuk menampilkan laporan Arus Kas: 

a. Account > Index to reports > Tab Banking > Statement of Cash Flow 
b. Banking > Index to reports > Statement of cash Flow 
c. Banking > Reports > Statement of Cash Flow 
d. Reports > Index to reports > Tab Banking > Statement of Cash Flow 
e. Banking > Statement of cash Flow 

4. Langkah untuk menampilkan laporan Piutang dan Utang: 

a. Account > Index to reports > Tab Card > Card List Summary 
b. Reports > Tab Card > Card List Summary 
c. Account > Tab Card > Card List Summary 
d. Reports > Index to reports > Tab Card > Card List Summary 
e. Reports > Index to reports > Card List Summary 

5. Langkah untuk menampilkan laporan persediaan: 

a. Accounts > Index to reports > Tab Inventory > Items List Summary 
b. Reports > Index to reports > Tab Inventory > Items List Summary 
c. Accounts > Tab Inventory > Items List Summary 
d. Reports > Index to reports > Items List Summary 
e. Accounts > Index to reports > Items List Summary 

6. Laporan yang memperlihatkan perincian persediaan supplies selama 
periode akuntansi tertentu: 

a. Laporan Laba-Rugi 

b. Neraca 

c. Laporan perubahan modal 

d. Arus Kas 

e. Catatan atas Laporan Keuangan 
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7. Laporan keuangan adalah laporan yang bersifat finansial. Pilih mana yang 
tidak termasuk laporan keuangan di bawah ini: 

a. Laporan pemakaian supplies tiap bulan. 
b. Laporan depresiasi aset tetap perusahaan.  
c. Laporan kerusakan mobil perusahaan. 
d. Laporan bulanan penjualan jasa per wilayah. 
e. Laporan pembayaran listrik bulanan. 

8. Laporan yang menginformasikan posisi aset, kewajiban dan equitas 
perusahaan pada periode tertentu adalah: 

a. Laporan Laba-Rugi 
b. Neraca 
c. Laporan perubahan modal 
d. Arus Kas 
e. Catatan atas Laporan Keuangan 

9. Laporan yang menginformasikan suatu ikhtisar pendapatan dan beban dari 
sebuah perusahaan dalam satu periode akuntansi: 

a. Laporan Laba-Rugi 

b. Neraca 

c. Laporan perubahan modal 

d. Arus Kas 

e. Catatan atas Laporan Keuangan 

10. Langkah untuk menampilkan Jurnal Umum: 

a. Account > Index to reports > Tab Banking > General Journal 
b. Reports > Index to reports > Tab Account > General Journal 
c. Reports > Index to reports > General Journal 
d. Reports > Reports > General Journal 
e. Reports > General Journal 

 

2. Tes Keterampilan. 

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh peserta 
didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Menyiapkan Laporan Laba Rugi 

4. Tugas 2, Menyiapkan Laporan Neraca 

5. Tugas 3, Menyiapkan Laporan Arus Kas 

6. Tugas 4, Menyiapkan Laporan Piutang 

7. Tugas 5, Menyiapkan Laporan Utang 

8. Tugas 6, Menyiapkan Laporan Persediaan 
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f. Kunci Jawaban Tes Formatif 

1. Kunci Tes Pengetahuan 

 

Soal No. Jawaban  Soal No. Jawaban 

1 a  6 e 

2 e  7 c 

3 d  8 b 

4 d  9 a 

5 b  10 b 
 

2. Kunci Tes Keterampilan 

Tugas 3, Menyiapkan Laporan Arus Kas 
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Tugas 1, Menyiapkan Laporan Laba Rugi 

 



 
Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
226 

Tugas 2,  Menyiapkan Laporan Neraca 
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Tugas 4, Menyiapkan Laporan Piutang 

 

Tugas 5, Menyiapkan Laporan Utang 

 

Tugas 6, Menyiapkan Laporan Persediaan 
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g. Lembar Kerja Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh 
peserta didik di komputer melalui program MYOB versi 18. 

 

Kasus 9.1 : Kasus UD Rasela Media Mandiri. 
 
Sebagai Teknisi Akuntansi anda diminta untuk memproses data akuntansi 
bulan Januari 2013 dengan program MYOB dan menyusun Laporan 
Keuangan: 
 

1. Tugas 1,  Menyiapkan Laporan Laba Rugi 

2. Tugas 2,  Menyiapkan Laporan Neraca 

3. Tugas 3, Menyiapkan Laporan Arus Kas 

4. Tugas 4, Menyiapkan Laporan Piutang 

5. Tugas 5, Menyiapkan Laporan Utang 

6. Tugas 6, Menyiapkan Laporan Persediaan 

 
 

Kasus 9.2 : Kasus UD Riola Media Mandiri. 

 
Sebagai Teknisi Akuntansi anda diminta untuk memproses data akuntansi 
bulan Januari 2013 dengan program MYOB dan menyusun Laporan 
Keuangan: 

 

1. Tugas 1,  Menyiapkan Laporan Laba Rugi 

2. Tugas 2,  Menyiapkan Laporan Neraca 

3. Tugas 3, Menyiapkan Laporan Arus Kas 

4. Tugas 4, Menyiapkan Laporan Piutang 

5. Tugas 5, Menyiapkan Laporan Utang 

6. Tugas 6, Menyiapkan Laporan Persediaan 
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Kegiatan Belajar 10 
Membuat File Backup 

 

a. Tujuan Pembelajaran 

Dengan diberikan kasus akuntansi perusahaan dagang, maka pada 
akhir sesi ini diharapkan peserta didik dapat:  

1. Membuat backup file  

2. Me-restore file backup 

 
 

b. Uraian Materi 

 
Program MYOB menyediakan menu File > BACKUP untuk membuat file 
cadangan dan menu File > RESTORE untuk membuka backup file yang telah 
dibuat sebelumnya. 
 

 
 

Gambar 2. 88 Menu File Backup/Restore 
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1. Pembuatan Backup file 

Hal-hal yang perlu diperhatikan: 

a) Pilihan tentang kelengkapan data yang akan dibuat backupnya dan 
perlu tidaknya pengecekan kemungkinan adanya kesalahan data. 

b) File Bakup merupakan ZIP File. 

c) Melalui Menu File > Backup dan File > Restore 

Langkah-langkah: 

1 Klik menu File > Backup 

 

 
Gambar 2. 89 Menu File-Backup 

2 
 

Klik untuk opsi backup file: Bacup Company file dan Check for file errors, klik 

Continue. 
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Gambar 2. 90 Opsi File Backup 

2 
 

Pilih Folder untuk menyimpan backup file dan ketik nama filenya dan klik Save 

untuk menyimpan backup file. 

 

 
Gambar 2. 91 Save Backup File 
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2. Membuka Restore Backup File 

Hal-hal yang perlu diperhatikan: 

a) Menentukan folder dan nama file yang akan di-restore  

b) Menyimpan file restore dengan nama dan folder tertentu. 

Langkah-langkah: 

1 Klik menu File > Restore 

 

 
Gambar 2. 92 Menu File - Restore 

2 
 

Pilih File yang akan di restore, kemudian klik Open. 

 

 
Gambar 2. 93 Memilih File Backup 
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2 
 

Ketik nama file yang akan di restore, kemudian klik Save. 

 

 
Gambar 2. 94 Pemberian Nama Restore File 

3 
 

Klik OK untuk menyimpan file yang telah direstore. 

 

 

 
Gambar 2. 95 Konfirmasi Pemberian Nama Restore File 
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c. Rangkuman 

• Untuk menjaga keutuhan data dari bahaya virus atau bahaya 
lainnya maka data akuntansi yang diproses perlu dibuatkan file 
cadangan atau Backup File. Ini perlu dilakukan di setiap akhir 
periode akuntansi (setiap akhir bulan atau setiap akhir tahun).  

• Bakcup file merupakan file yang telah dikompres atau ZIP file 
dimana Sizenya menjadi jauh lebih kecil dari file aslinya. 

• Untuk membuka kembali backup file menjadi file aslinya, maka 
diperlukan proses Restore. File yang telah di-restore ini dapat 
disimpan dengan nama dan folder yang baru. 

 

d. Tugas 

Berdasarkan Kasus 9.1. UD Rasela Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Peserta didik membuat kelompok kecil, terdiri dari 2 atau 3 orang per 
kelompok. 

2. Setiap peserta didik mengikuti langkah-langkah yang dijabarkan dalam 
KB3 ini melalui kerjasama kelompok. 

3. Tugas 1, Membuat backup file 

4. Tugas 2,  Me-restore file backup 
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e. Tes Formatif 

 

1. Tes Pengetahuan. 

Pilih jawaban yang paling tepat dengan memberi tanda silang pada huruf a, b, 

c, d atau e dari setiap item soal pilihan ganda di bawah ini: 

1. Langkah untuk membuat backup file: 
a. File > Backup > Klik opsi backup > Ketik nama file > Save 
b. Backup > Klik opsi backup > Ketik nama file > Save 
c. Backup > File > Klik opsi backup > Ketik nama file > Save 
d. File > Klik opsi backup > Backup > Ketik nama file > Save 
e. File > Backup > Ketik nama file > Save 

2. Backup file merupakan ZIP file artinya: 
a. Mempunyai size yang sama dengan file aslinya 
b. Mempunyai size yang lebih besar dengan file aslinya 
c. Mempunyai size yang lebih kecil dengan file aslinya 
d. Mempunyai fungsi yang tidak sama dengan file aslinya 
e. Tidak ada perbedaan dengan file aslinya 

3. Alasan perlunya pembuatan backup file: 
a. Kelengkapan data 
b. Kekurangan data 
c. Kelebihan data 
d. Keamanan data  
e. Kelemahan data 

4. Langkah untuk me-restore backup fle: 
a. File > Backup > Pilih Bacup file > Open > Ketik nama file > Save 
b. File > Pilih Bakcup file > Restore > Open > Ketik nama file > Save 
c. File > Restore > Open > Ketik nama file > Save 
d. File > Restore > Pilih Backup file > Save > Ketik nama file > Open 
e. File > Restore > Pilih Backup file > Open > Ketik nama file > Save 

5. Dalam restore file, alasan dianjurkannya memberikan nama file yang lain 
dari nama file aslinya:  
a. Agar tidak terjadi file kembar 
b. Agar nama file lebih bervariasi 
c. Agar tidak terjadi tumpang-tindih (replace) file aslinya. 
d. Agar tidak terjadi gabungan file 
e. Agar tidak terjadi dua file yang berbeda nama tetapi isinya sama. 
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6. Perbandingan backup file dan file aslinya dari segi size file: 
a. File asli = file backup  
b. File backup > File asli 
c. File asli < file backup 
d. File backup < file asli 
e. File  asli =< file backup. 

7. Mengapa diperlukan backup file?  
a. Untuk menjaga keamanan komputer 
b. Untuk menjaga keamanan software 
c. Untuk menjaga keamanan data 
d. Untuk menjaga keamanan brainware 
e. Untuk menjaga keamanan proses pengolahan. 

8. Alasan perlunya pembuatan backup file karena seringkali .... 
a. Data terserang virus 
b. Kerusakan komputer  
c. Kerusakan software  
d. Kerusakan harddisk 
e. Kehilangan folder. 

9. Untuk menjaga keamanan file backup maka ... 
a. File backup disimpan di folder yang sama dengan aslinya. 
b. File backup disimpan di floopy disk 
c. File backup disimpan di eksternal hard disk 
d. File backup disimpan di folder yang berbeda 
e. File backup disimpan di komputer.  

10. Restore file adalah proses... 
a. Penyimpanan backup file 
b. Pembersihan backup file 
c. Penghapusan backup file 
d. Pembukaan backup file 
e. Penghancuran backup file 

 
2. Tes Keterampilan. 

Berdasarkan Kasus 3.2. UD Riola Media Mandiri yang ada pada ‘Lembar 
Kerja Peserta Didik’, kerjakan  tugas-tugas berikut ini ! 

1. Tes ini dikerjakan secara individu, tidak dibenarkan dikerjakan oleh 
peserta didik secara berkelompok. 

2. Pada akhir waktu tes diminta setiap peserta didik menyerahkan hasil 
pekerjaannya dalam bentuk file. 

3. Tugas 1, Membuat backup file 

4. Tugas 2,  Me-restore file backup 
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f. Kunci Jawaban Tes Formatif 

 
1. Kunci Tes Pengetahuan 

 

2. Kunci Tes Keterampilan 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Soal No. Jawaban  Soal No. Jawaban 

1 a  6 d 

2 c  7 c 

3 d  8 a 

4 e  9 c 

5 c  10 d 
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g. Lembar Kerja Peserta Didik 

Lembar kerja ini berisi kasus-kasus yang harus diselesaikan oleh peserta 

didik di komputer melalui program MYOB versi 18. 

 

 

Kasus 10.1 : Kasus UD Rasela Media Mandiri. 
 
Sebagai Teknisi Akuntansi anda diminta untuk: 
 

1. Tugas 1, Membuat backup file 

2. Tugas 2,  Me-restore file backup 

 
 

Kasus 10.2 : Kasus UD Riola Media Mandiri. 
 

Sebagai Teknisi Akuntansi anda diminta untuk: 
 

1. Tugas 1, Membuat backup file 

2. Tugas 2,  Me-restore file backup 
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A. Attitude Skills 

Evaluasi terhadap sikap (Attitude Skill) 
 
1. Teknik : Observasi 
2. Bentuk instrumen : lembar observasi 
3. Aspek-aspek : Motivasi Internal, Kejujuran, Disiplin, 

Tanggung jawab, Santun, Responsif, 
Proaktif. 

4. Instrumen :  
 

LEMBAR OBSERVASI 
 

Mata Pelajaran : Komputer Akuntansi 
Kelas/ Semester : XI /1 
Materi Pokok  : Membuat file data bisnis. 
Tanggal   : …………….. 

No. Nama Peserta Didik 

Aspek penilaian 

M
o

ti
v
a
s
i 
In

te
rn

a
l 

K
e
ju

ju
ra

n
 

D
is

ip
li
n

 

T
a
n

g
g

u
n

g
ja

w
a
b

 

S
a
n

tu
n

 

R
e
s
p

o
n

s
if

 

P
ro

a
k
ti

f 

K
e
p

e
d

u
li
a
n

 

N
il

a
i 
R

e
ra

ta
 

          

1           

2           

3           

4           

5           

6           

7           

8           

9           

Dst           

 
Petunjuk pensekoran: 

 
Skor 4 = selalu, apabila selalu melakukan sesuai pernyataan 
Skor 3 = sering, apabila sering melakukan sesuai pernyataan 

dan  Skor kadang-kadang tidak melakukan 
Skor 2 = kadang-kadang, apabila kadang-kadang melakukan 

dan  sering tidak melakukan 
Skor 1 = tidak pernah, apabila tidak pernah melakukan 

Bab III 

Evaluasi 
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B. Kognitif Skills 

Evaluasi terhadap kemampuan kognitif. 

1. Teknik  : Tes; 
2. Bentuk instrumen : Uraian. 
3. Kisi-kisi  

 

No. Indikator Nomor soal 

1. Menyiapkan data awal 1 
2. Membuat daftar akun 2 
3. Membuat Buku Pembantu 3 
4. Meng-entry saldo awal 4 
5. Mencatat Transaksi Penjualan 5 
6. Mencatat Transaksi Pembelian 6 
7. Mencatat Transaksi Kas-Bank 7 
8. Mencatat entri penyesuaian 8 
9. Menampilkan laporan keuangan 9 
10. Membuat backup file 10 

 
 

4. Soal-soal :  
 

Soal 1. 

Sebutkan minimal 3 (tiga) keuntungan yang bisa diperoleh dengan 
adanya komputerisasi data akuntansi menggunakan MYOB 
Accounting? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 
Soal 2. 

Data apa saja yang perlu diisi dalam menentukan periode akuntansi 
pada  pembuatan data akuntansi baru pada MYOB Accounting? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  
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Soal 3. 

Tentukan nomor kategori akun-akun berikut pada MYOB 
Accounting? 

KATEGORI AKUN NOMOR 

Expense ………… 
Cost of Sales ………… 
Liability ………… 
Asset ………… 
Other Income ………… 
Equity ………… 
Income ………… 
Other Expense ………… 

 
Soal 4. 

Jenis pajak yang mana yang identik dengan PPN (Pajak 
Pertambahan Nilai) pada MYOB Accounting? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

Soal 5. 

Dalam proses pencatatan saldo awal akun pada MYOB Accounting, 
terjadi kondisi dimana Amount left to be allocated menunjukkan 
angka (minus) – Rp. 550.000 atau (Rp.550.000,-) ? Apa artinya 
kondisi ini: 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

Soal 6. 

Jelaskan fungsi modul Banking > Spend Money  pada MYOB 
Accounting? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  



 
Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
242 

Soal 7. 

Jelaskan fungsi modul Banking > Receive Money  pada MYOB 
Accounting? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

Soal 8. 

Jelaskan modul yang digunakan untuk mencatat jurnal penyesuaian 
pada MYOB Accounting dan data apa sajakah yang harus 
dipersiapkan? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

Soal 9. 

Jelaskan menu yang digunakan untuk menampilkan laporan laba-
rugi pada MYOB Accounting dan data apa sajakah yang harus dientri 
? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

Soal 10. 

Jelaskan mengapa perlu dibuat backup file dalam komputerisasi 
akuntansi ? 

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  

 ................................................................................................................  
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C. Psikomotorik Skills 

Evaluasi terhadap kemampuan kognitif. 

1. Teknik  : Tes Praktek 
2. Bentuk instrumen : Studi Kasus. 
3. Kisi-kisi  :  

 

No. Indikator Nomor soal 

1. Menyiapkan data awal 1 
2. Membuat daftar akun 2 
3. Membuat Buku Pembantu 3 
4. Meng-entry saldo awal 4 
5. Mencatat Transaksi Penjualan 5 
6. Mencatat Transaksi Pembelian 6 
7. Mencatat Transaksi Kas-Bank 7 
8. Mencatat entri penyesuaian 8 
9. Menampilkan laporan keuangan 9 
10. Membuat backup file 10 

 

4. Soal-soal : 
 

KASUS PERUSAHAAN DAGANG 
UD. Virgo Media Digital (VMD) 

Identitas Perusahaan dan Usaha pokok 

Nama perusahaan :  UD Virgo Media Digital 
Alamat   :  Jl. Pamulang Raya 170, Pamulang, Tang-Sel. 
No Telepon/Faximile :  021 7434352 
Alamat email  :  ud.vmd@yahoo.com 
Bank   :  BCA KCP Pamulang 
No Rekening  :  048 213 457896 

Sebagai Computer Dealer, perusahaan tsb. menjual beberapa macam barang 
antara lain: Computer, Printer, Modem, Software dan Other Hardwares 
(Perangkat keras lainnya). Pada awal Januari 2013 pemilik perusahaan Tn. 
Suyoko ingin menerapkan sistem komputerisasi yang memproses data 
akuntansi untuk perusahaannya secara otomatis.  Anda diminta menjadi 
Teknisi Akuntansi yang membantu Tn. Suyoko. 

 

Kebijakan Komputerisasi Akuntansi 

1. Menggunakan sistem berpasangan dangan dasar akrual basis. 

2. Menggunakan sistem mata uang rupiah & pencatatan tanggal Indonesia. 

3. Menggunakan Special Journal dan General Journal. 

 

mailto:ud.vmd@yahoo.com
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4. Pada tahap setup untuk periode akuntansi dinyatakan sebagai berikut: 

 Tahun akuntansi berjalan (Current Financial year) : 2013,  

 Bulan akhir tahun akuntansi (Last month of the year) : December,  

 Bulan perpindahan (Conversion Month): January, dan  

 Jumlah bulan dalam periode akuntansi (Accounting Period): Twelve. 

5. Pada tahap pembuatan daftar akun (Build your accounts list): 

 Memanfaatkan daftar akun yang telah disediakan oleh MYOB:  

 (I would like to start with one of lists provided by MYOB) 

 Klasifikasi industri (Industri Classification): Retail dan  

 Jenis bisnis (Type of Business): Computer Dealer. 

6. Pada tahap pembuatan dan penyimpanan file data bisnis yang baru:  

 Company file name: UD-VMD1 (Nama Anda) dan  

 Folder penyimpanan file: Document atau My Document 

Kode Pajak 

7. GST (Good Services Tax) . 

8. N-T (Non Reportable Tax). 

 GST selanjutnya akan diedit menjadi PPN (Pajak Pertambahan Nilai). 

 GST Collected diedit menjadi PPN Collected. 

 GST Paid diedit menjadi PPN Paid. 

Daftar Saldo Barang Dagangan Per awal Januari 2013 

No Kode Nama Barang Kelompok Jml 

Unit 

Cost/Unit Harga Jual/ 

Unit 

1 COM-001 HP Pro book 4421s Computer 10 9.000.000,- 14.850.000,- 

2 COM-002 HP Pro book 5530 Computer 6 11.000.000,- 17.600.000,- 

3 PRN-001 Canon Lj-215 Printer 20 650.000,- 990.000,- 

4 PRN-002 Canon Bj-555 Printer 20 345.000,- 660.000,- 

5 MOD-001 3M USB Modem 56 Modem 20 250.000,- 440.000,- 

6 MOD-002 SAT USB Modem 36 Modem 25  275.000,- 550.000,- 

7 SOF-001 Window 7 Profs Software 10 800.000,- 1.320.000,- 

8 SOF-002 Ms Office 10 Software 25 1.800.000,- 2.200.000,- 

9 DMS-001 Mini Speaker 421 Other 
Hardwares 

30 100.000,- 220.000,- 

10 DMS-002 Mini Speaker 103 Other 
Hardwares 

40 80.000,- 165.000,- 

  

Catatan Penilaian Persediaan Barang. 

 Sistem pencatatannya menggunakan sistem Perpetual. 

 Metode yang dipergunakan adalah metode rata-rata bergerak. 
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Pembelian dan Penjaualan Barang Dagangan 

 Setiap pembelian dan penjualan barang dagangan akan diperhitungkan 

PPN 10%. 

 Setiap retur pembelian dan retur penjualan barang dagangan akan 

diperhitiungkan pengurangan atas nilai Utang/Piutang Dagang dan PPN 

Masukan/Keluaran. 

 Harga-harga yang tertulis di dalam faktur pembelian dan penjualan sudah 

termasuk PPN 10% (tax Inclusive). 

 Setiap potongan yang diperoleh dari pembelian atau potongan yang 

diberikan atas penjualan tidak mengurangi PPN Masukan/Keluaran tetapi 

mengurangi nilai Utang Dagang atau nilai Piutang Dagang. 

 
Daftar Saldo Utang Dagang 

Per awal Januari 2013 

Kode Nama & Alamat Supplier Keterangan Faktur Jumlah (Rp.) 

S-001 PT Crown Electindo  

Jl. Gajah Mada 177 Jakarta  

Telp 0214430011 

Faktur Pembelian No. CE-
12 tanggal 20-12-2012 

Termin 5/10, n/30 

Denda Late payemnt 2%/bl. 

110.000.000,- 

 Jumlah Total 110.000.000,- 
 

Daftar Saldo Piutang Dagang 

Per awal Januari 2013 

Kode Nama & Alamat Customer Keterangan Faktur Jumlah (Rp.) 

C-001 Toko Ramanda Computer 

Jl. Setia Budi 23, Pamulang  

Telp 0217431271 

Faktur Penjualan No. FP-
003 tanggal 27-12-2012 

Termin 3/10, n/30 

Denda Late payemnt 2%/bl. 

209.000.000,- 

C-002 Toko Global Computer 

Jl. Cendana 11, Ciputat 

Telp 0217431270 

Faktur Penjualan No. FP-
005 tanggal 28-12-2012 

Termin 3/10, n/30 

Denda Late payemnt 2%/bl. 

66.000.000,- 

 Jumlah Total 275.000.000,- 
 

Preferences 

Pemilik perusahaan meminta bahwa sistem komputerisasi yang baru bisa:  

 Meng-edit/men-delete transaksi yang telah dicatat di komputer. 

 Menampakkan nomor dan nama akun pada dipilih. 

 Mencatat sebagai Cash In Bank ketika perusahaan menerima uang karena 

uang tersebut akan disetor juga pada hari yang sama. 
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Modifikasi Daftar Akun 

Hapus (DELETE) akun-akun berikut ini: 

1-1130  Cash Drawer 2-1355  WET Payable 

1-1150  Provision Account 2-1360  Import Duty Payable 

1-1160  Investment Account 2-1370 Voluntry Withholding Payable 

1-1950  Withholding Credits 2-1380  ABN Withholdings Payable 

1-1960  Voluntary Withholding Credits 2-1390  Luxury Car Tax Payable 

1-1970  ABN Withholding Credits 2-1400  Payroll Liabilities 

1-2200  Leasehold Improvements 2-1420  PAYG Withholding Payable 

1-2210  Improvements at Cost 4-9000  Fuel Tax Credits 

1-2220  Improvements Amortisation 6-1050  Accounting Fees 

2-1120  Diners Club 6-1100  Legal Fees 

2-1130  MasterCard 6-5105  Fringe Benefits Tax 

2-1140  Visa 6-5120  Superannuation 

2-1350  Duel Tax Credits Accrued 6-5140  Workers' Compensation 

 

Ubah (EDIT) akun-akun berikut ini: 

1-1110  Cheque Account 1-1110  Cash in Bank 

1-1200  Trade Debtors 1-1200  Account Receivable 

2-1200  Trade Creditors 2-1200  Account Payable 

2-1300  GST Liabilities 2-1300  PPN Liabilities 

2-1310  GST Collected 2-1310  PPN Collected 

2-1330  GST Paid 2-1330  PPN Paid 

3-1000  Owner's/Shareholder's Equity 3-1000  Suyoko Equity 

3-1100  Owner/Sharehldr Capital 3-1100  Suyoko Capital 

3-1200  Owner/Sharehldr Drawings 3-1200  Suyoko Drawings 

4-1100  Hardware 4-1100  Hardware Sales 

4-1200  Software 4-1200  Software Sales 

5-1100  Hardware - Purchase 5-1100  Hardware Cost of Sales 

5-1200  Software - Purchase 5-1200  Software Cost of Sales 
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Akun Baru (NEW). 

Nomor Nama Akun Kategori 

1-1550 Inventory – Supplies Other Current Assets 

2-1700 Income Tax Payable Other Current liability 

6-6100 Income Tax Expense 

 
UD Virgo Media Digital 

Neraca Saldo Per 31 Desember 2012 
 

No.                      

Akun 
Nama Akun Debit Kredit 

1-1110 Cash In Bank 210.000.000    

1-1140 Petty Cash 5.000.000    

1-1200 Account Receivable 275.000.000    

1-1310 Computers 156.000.000    

1-1320 Printers 136.900.000    

1-1330 Modems 11.875.000    

1-1340 Other Hardwares 6.200.000    

1-1350 Softwares 53.000.000    

1-1550 Inventory-Store Supplies 4.300.000    

1-2110 Store Equip at Cost 100.000.000    

1-2120 Store Equip Accum Dep   10.000.000  

1-2310 Demo Equip at Cost 20.000.000    

1-2320 Demo Equip Accum Dep   2.000.000  

1-2410 Office Equip at Cost 60.000.000    

1-2420 Office Equip Accum Dep   12.000.000  

1-2510 Furniture Equip at Cost 80.000.000    

1-2520 Furniture Equip Accum 
Dep 

  16.000.000  

2-1200 Account Payable   110.000.000  

2-1700 Income Tax Payable   8.275.000  

2-2100 Bank Loan   300.000.000  

3-1100 Suyoko Capital   660.000.000  

  1.118.275.000  1.118.275.000  
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Transaksi Keuangan dalam Bulan Januari 2013 

Catatan:  

 Diasumsikan jumlah-jumlah sudah termasuk PPN 10% (Tax inclusive),  

kecuali disebutkan secara khusus. 

 Kas yang diterima akan dicatat sebagai Cash In Bank karena akan disetor 

ke Bank pada hari yang sama. 

 Metode pencatatan Petty Cash adalah Fluctuation System. 
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Tugas anda:  

Sebagai Teknisi Akuntansi anda diminta untuk memproses data akuntansi 
bulan Januari 2013 dengan program MYOB dan menyusun Laporan Keuangan: 

1. Bank Rekosiliasi (Bank Rekonciliation) per 31 Januari 2013. 

2. Neraca (Standard Balance Sheet) per akhir Januari 2013. 

3. Laporan Laba-Rugi (Profit and Loss - Accrual) bulan Januari 2013. 

4. Laporan Arus Kas untuk bulan Januari 2013. 
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D. Produk/Benda Kerja Sesuai Kriteria Standar 

Kriteria Laporan keuangan yang dihasilkan hendaknya meliputi: 

1. Laporan Laba-Rugi (Accrual) untuk periode 2013 yang disusun secara 

rinci dengan format multi steps. 

2. Laporan Neraca (Standard) per 31 Januari 2013 yang disusun secara 

rinci dengan format staffel. 

3. Laporan Arus kas untuk periode 1/1/2013 s.d. 31/1/2013 yang disusun 

dengan metode tidak langsung.  

 

E. Batasan waktu yang telah ditetapkan 

1. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan kognitif 

yaitu 2 x Jam Pelajaran @ 45 menit.  

2. Waktu yang tersedia untuk pelaksanaan evaluasi kemampuan 

psikomotor yaitu 4 x Jam Pelajaran @ 45 menit. 

 

F. Kunci Jawaban 

1. Jawaban soal untuk kemampuan kognitif: 
 
Jawaban Soal 1 

 Proses kerja cepat. 

 Pencegahan kesalahan 

 Posting jurnal ke buku besar/buku pembantu secara otomatis. 

 Volume kerja lebih besar 

 Pencetakan laporan bisa berkali-kali. 
 

Jawaban Soal 2 

 Current financial year (tahun periode akuntansi). 

 Last month of financial year (bulan terakhir dari tahun periode). 

 Conversion month (Bulan konversi) 

 Number of accounting period (Jumlah periode akuntansi) 
 

Jawaban Soal 3 

 Expense  : 6 

 Cost of Sales  : 5 

 Liability  : 2 

 Asset   : 1 

 Other Income  : 8 

 Equity   : 3 

 Income   : 4 

 Other Expense : 9 
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Jawaban Soal 4 

Jenis pajak yang identik dengan PPN pada MYOB Accounting: 

 GST (Goods and Services Tax) atau 

 VAT (Value Added Tax) 
 

Jawaban Soal 5 
Amount left to be allocated: - Rp. 550.000,- atau (Rp. 550.000) artinya bahwa 
jumlah debet  lebih kecil Rp. 550.000,- dari jumlah kredit atau jumlah kredit 
lebih besar Rp. 550.000,- dari jumlah debet.. 

 
Jawaban Soal 6 
Modul Banking > Spend Money memberikan fasilitas untuk mencatat transaksi 
pembayaran uang tunai melalui akun-akun Cash in Bank/ Petty Cash/ 
Bankcard yang tidak ada kaitannya dengan pembelian barang dagangan. 

 
Jawaban Soal 7 
Modul Banking > Receive Money memberikan fasilitas untuk mencatat 
transaksi penerimaan uang tunai melalui akun-akun Cash in Bank/ Cash on 
Hand yang tidak ada kaitannya dengan penjualan barang dagangan. 

 
Jawaban Soal 8 
Modul yang digunakan untuk mencatat jurnal penyesuaian adalah Account > 
Record Journal Entry.  

Data yang perlu dipersiapkan adalah nomor dan nama akun-akun yang didebet 
beserta jumlahnya dan nomor dan nama akun-akun di kredit beserta jumlanya.  

 
Jawaban Soal 9 
Menu yang digunakan untuk menampilkan laporan Lab-rugi adalah Report > 
Index to Report > Tab Account > Profit and Loss [Accrual] atau menggunakan 
menu alternatif Report > Account > Profit and Loss [Accrual]. 

Data yang perlu dientri adalah periode akuntansi dari tanggal awal s.d. tanggal 
akhir. 

 
Jawaban Soal 10 
Backup file dalam komputer akuntansi perlu dibuat untuk menjaga keutuhan 
dan integritas data, apabila terjadi kerusakan pada file asli yang ada di 
komputer karena akibat terkena virus atau sebab lainnya. 
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2. Jawaban soal untuk kemampuan psikomotor 

a. Laporan Laba-Rugi: 
 

 
 

 

January 
2013 
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b. Laporan Neraca 

 
 

  

January 
2013 
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c. Laporan Arus Kas 

 

 
 
 
 

  

 

 

 

 

January 
2013 



 
Komputer Akuntansi Jilid 2 

Direktorat Pembinaan SMK (2013) 
269 

Bab IV Penutup 
 
 
Setelah Laporan Keuangan pada akhir Januari diselesaikan dan sudah dibuat 
backup file, maka proses akuntansi berikutnya akan diteruskan ke bulan Februari. 
Tugas selajutnya adalah melaksanakan pencatatan transaksi bulan Februari. 
Untuk itu tidak diperlukan lagi mengentri saldo-saldo awal akun buku besar atau 
buku pembantu secara manual seperti yang dilakukan di awal bulan Januari. 
Program MYOB akan secara otomatis mengakumulasi jumlah saldo dengan 
jumlah penambahan/ pengurangan sebagai akibat dari transaksi bulan Pebruari. 
Laporan keuangan yang nantinya akan ditampilkan di akhir Pebruari adalah hasil 
akumulasi transaksi dalam dua bulan yaitu transaksi Januari dan Pebruari. 
Demikian seterusnya sampai dengan akhir bulan Desember 2013. 

Pada akhir bulan Desember 2013 (akhir periode akuntansi) Program MYOB 
menyediakan menu untuk menutup semua akun-akun nominal (akun Laba-rugi) 
dan akan memulai dengan akun-akun riil atau neraca awal Januari 2014. Menu ini 
adalah File > Start a New Year > Start a New Financial Year.  

  

Gambar 11-1  Start a New Financial Year 
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